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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and service
conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any instrument or
defective parts when returned prepaid to us and which our examination discloses to have been defective. The purchaser is
responsible for all transportation charges involving the shipment of materials for warranty repairs. Failure of any instrument
or product due to operator error, improper installation, unauthorized repair or alteration, failure of utilities, or environmental
contamination will not constitute a warranty claim. The materials of construction used in MICROMERITICS instruments and
other products were chosen after extensive testing and experience for their reliability and durability. However, these
materials cannot be totally guaranteed against wear and/or decomposition by chemical action (corrosion) as a result of
normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization to
return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are made by
persons other than its own authorized service personnel unless such work is authorized in writing by MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their respective
brand names or trade names. We, therefore, make no express or implied warranty as to such products. We shall use
our best efforts to obtain from the manufacturer, in accordance with his customary practice, the repair or replacement
of such of his products that may prove defective in workmanship or materials. Service charges made by such man-
ufacturer are the responsibility of the ultimate purchaser. This states our entire liability in respect to such products,
except as an authorized person of MICROMERITICS may otherwise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the discretion of
MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and stems,
seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such items which
perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of manufacturing
defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its products
other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including but not
limited to, the implied warranties of merchantability or fitness for use.

Warranty
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Contact Us

CONTACT US
Micromeritics Instrument Corporation

4356 CommunicationsDrive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696

www.Micromeritics.com

---------------

U.S. Inquiries

U.S. Sales Phone: 1-770-662-3636

USSales@Micromeritics.com

---------------

Quotes, Orders, and Customer Satisfaction

Customer Service Phone: 1-770-662-3636

Orders@Micromeritics.com

---------------

U.S. Instrument Service Department

U.S. Service Department Phone: 1-770-662-3666

Service.Helpdesk@Micromeritics.com

---------------

Micromeritics Scientific Services

Customer Support Portal

http://techsupport.micromeritics.com/portal
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ABOUT THIS MANUAL

The following iconsmay be found in this document:

NOTE - Notes contain important information pertinent to the subject matter.

CAUTION - Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING - Warnings contain information to help prevent actions that may cause per-
sonal injury.

KEYPAD FUNCTION- - The keypad icon indicates the section is applicable only when
using the keypad.

About thisManual

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 iii





Table of Contents

Warranty i

Contact Us ii

About this Manual iii

1 About the AccuPyc II 1 - 1
About the TEC Module 1 - 2

Asphalt Density Application 1 - 3

About the FoamPycModule 1 - 3

Instrument Components 1 - 5

Equipment Options 1 - 7

Configuration Options 1 - 8

Power Analyzer On andOff 1 - 9

Specifications for AccuPyc II 1 - 11

2 Data Entry with Keypad 2 - 1
About the Display 2 - 1

About the Keypad 2 - 2

Cancel an Analysis 2 - 5

Manual Mode 2 - 6

Transmit 2 - 7

Analysis Parameters 2 - 7

Review Data 2 - 10

View Data Results 2 - 12

Print a File 2 - 12

3 About the Software 3 - 1
Menu Structure 3 - 1

Common Fields and Buttons 3 - 2

Option Presentation 3 - 5

File Status, Description, Extension, and Location 3 - 7

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 v



Keyboard Shortcuts 3 - 8

Sample Default File 3 - 9

Analyzer Status 3 - 9

Show Instrument Log 3 - 9

Show Instrument Schematic 3 - 10

Show Status 3 - 11

Print, List, or Export Files 3 - 12

Open a File 3 - 14

Uninstall the Software 3 - 15

4 About Sample Files 4 - 1
Create Sample Files 4 - 1

Sample Cup 4 - 4

Material Parameters 4 - 5

5 About Parameter Files 5 - 1
Parameter Files Directory 5 - 1

Analysis Conditions 5 - 2

FoamPycApplication 5 - 4

Report Options 5 - 5

Collected Data 5 - 7

6 Perform an Analysis 6 - 1
Prepare and Load a Sample 6 - 1

Perform an Analysis using the Software 6 - 3

QuickStart Analysis 6 - 7

Sequence Analysis 6 - 8

Review Analysis 6 - 9

7 About Reports 7 - 1
Open and Close Reports 7 - 1

Start Reports 7 - 1

SPC Report 7 - 2

vi AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



Regression Report 7 - 3

Control Chart Report 7 - 5

Report Features and Shortcuts 7 - 8

Graph Features and Shortcuts 7 - 12

Graph and Sample Overlays 7 - 17

GenerateMultiple GraphOverlays 7 - 17

GenerateMultiple Sample Overlays 7 - 18

Report Examples 7 - 20

Combined Report 7 - 20

SummaryReport 7 - 21

Tabular Report 7 - 22

Graph Report 7 - 23

Overlay Report 7 - 24

Equilibration Report 7 - 25

Sample Log Report 7 - 26

8 Selected Reports 8 - 1
Combined Report 8 - 1

Density and Volume Table 8 - 1

Density vs Cycle Number Trend Plot 8 - 2

Density vs Time Trend Plot 8 - 3

Equilibration Report 8 - 4

OptionsReport 8 - 5

Pressure and Volume Table 8 - 5

Sample Log Report 8 - 6

SummaryReport 8 - 6

Tabular Report 8 - 7

Total Pore Volume vs Temperature 8 - 8

Volume vsCycle Number Trend Plot 8 - 8

9 Diagnostics using the Software 9 - 1

10 About Calibration 10 - 1

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 vii



Calibrate using the Software 10 - 1

Calibration Report 10 - 1

Calibrate Temperature Offset 10 - 2

Calibrate Zero Cell Volume 10 - 3

Calibrate Zero Pressure 10 - 4

Reset Pressure Calibration 10 - 5

Calibrate Volume Scale 10 - 6

Verify Operation 10 - 10

Load Calibration from File 10 - 11

Save Calibration to File 10 - 11

Calibrate using the Keypad 10 - 12

Calibrate Function 10 - 12

Calibration Data 10 - 12

Calibrate Volume 10 - 13

Reset Pressure Calibration 10 - 14

Review Calibration 10 - 15

Temperature 10 - 17

Zero the Pressure Transducer & Chamber Volume 10 - 17

Load Calibration Data from aUSB Stick 10 - 18

CopyCalibration Data to a USB Stick 10 - 18

11 Hardware 11 - 1
Add AnalysisModule to Control Module 11 - 1

Analytical Balance 11 - 3

Printer Setup 11 - 3

12 Maintenance and Troubleshooting 12 - 1
Chamber CapO-Ring 12 - 3

Check the Cell and Expansion Chambers for Leaks 12 - 5

Clean the Dust Filter 12 - 7

Clean the Pycnometer 12 - 8

Guidelines for Connecting Gases 12 - 9

Replace aGasCylinder 12 - 10

viii AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



Regulator Pressure 12 - 13

Recover From a Power Failure 12 - 15

Reset the Pycnometer 12 - 15

13 Parts and Accessories 13 - 1

A Calculations A - 1
Analysis A - 1

Asphalt Density A - 3

Calibration A - 4

FoamPycMethods A - 5

Geometric Volume and Active Area A - 7

Percent Porosity A - 7

Resin Volume A - 8

Run Precision A - 8

SPC Report Variables A - 9

Specific Gravity A - 10

Total Pore Volume A - 10

Total Solids Concentration A - 11

B Error Messages for the 1340 AccuPyc B - 1
Error Messages for the 1340 AccuPyc KeypadOnly B - 18

C Multigas Option C - 1

D MultiVolume Insert Option D - 1

E RS-232 Pin Assignment E - 1

F Sample Volume Equation Derivation F - 1

G TEC Module G - 1

H Temperature Controlled AccuPyc H - 1

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 ix



Attach a Circulating Bath H - 1

Add AnalysisModules to a Temperature ControlledModule H - 2

I Transmitted Data I - 1

J Installation Instructions J - 1
Handling SystemComponents J - 1

GasRequirements J - 2

Pycnometer Set up J - 2

Pycnometer Configuration J - 2

Set the TEC Temperature J - 5

Temperature ControlledModule Hardware Setup J - 5

Connect Keyboard J - 5

GasConnection J - 6

Connect the Analyzer to the Computer J - 8

Configure the Pycnometer using the Keypad J - 9

Analytical Balance J - 17

Connect an Ethernet Switch J - 18

BrightnessControl J - 18

Software Installation J - 19

Start the Application J - 22

Specify Unit Selections J - 23

Reinstall or Modify the Software J - 23

Install Analyzer Software Upgrade using aMedia Device J - 24

Uninstall the Software J - 25

Index Index - 1

x AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



1 ABOUT THE ACCUPYC II

The AccuPyc II is an easy to use, fully automatic gas displacement pycnometer. It determines
density and volume bymeasuring the pressure change of heliumwithin calibrated volumes. It also
reports the chamber temperature at the end of the requested cycles. The AccuPyc II can be
operated using the analysis program installed on an attached computer, or if no computer is attached
to the pycnometer, the keypad can be used to start and run analyses. If using the keypad, the
analyzer may be operated in English, French, German, Italian, or Spanish. The application is
available in English only.

The AccuPyc II consists of a control module and an analysismodule. When ordering a single unit,
the control module is built into the same unit as the analysismodule for convenience. The analysis
modules are also available in a standalone configuration, allowingmultiple analysismodules to be
attached to a single controlling unit. A maximumof five analysismodules can be installed to one
controller (six total). Eachmodule has its own gas connection. The pycnometer can be controlled by
either:

l a 32-bit Windows interface. The operational status of the pycnometer can be continuallymon-
itored in the application. If theWindows interface is used, the keypad is disabled.

l the keypad if not running the 32-bit Windows interface. A separate keyboard and printer
can be attached to the pycnometer using USB ports.

1 About the AccuPyc II
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1 About the AccuPyc II

ABOUT THE TEC MODULE

See TEC Module on page G - 1

Densitymeasurements at specific temperatures are required for certain applications. The AccuPyc II
Thermo Electric Cooling (TEC) Modulemaintains an accurate temperature control during analysis
using the principle of Peltier cooling.

TEC Modules, also known as Peltier coolers, are solid-state heat pumps that utilize the Peltier effect
to move heat. By passing a current through the TEC Module, heat is transferred from one side of the
module to the other, typically producing a heat differential of approximately 40° C.

The transferred heat is then removed from the system through the combination of a heat sink and
fan, cooling the system tomaintain a set temperature for accurate analysis.

TEC systems feature:

• fast dynamic response
• long-life
• nomoving parts
• no use of refrigerants or circulated liquids/antifreeze

1 - 2 AccuPyc II SeriesOperator Manual
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ASPHALT DENSITY APPLICATION

The AccuPyc II TEC Module canmeasure asphalt density using disposable cups to limit cross-
contamination of samples.

This solution can be closely correlated (< 0.15% difference) to results obtained with ASTMTest
Method D70-09. The AccuPyc asphalt densitymeasurement is completedmuch faster than the
ASTMmethod while virtually eliminating operator error. The Peltier thermoelectric cooling control
(15 to 36 °C) provides stability for handling of samples.

Performing an asphalt densitymeasurement requires the AccuPyc II Asphalt application and
disposable sample cups.

ABOUT THE FOAMPYC MODULE

A FoamPyc option for measuring open and closed cell foammaterials is available for both standard
and temperature controlled pycnometers. This unit can be ordered initially with the FoamPyc
application installed, or can be upgraded from the standard AccuPycwith a software enhancement
via USB media. Configuration options are:

l 100 cm3 nominal cell volume (recommended)
l 10 cm3 nominal cell volume

The FoamPyc option performs analyses onmaterials such as polystyrene, urethane, and rubber
foams using five different methods:

l Method A. Measures the closed cell fraction and corrects for the cells damaged while cutting the
sample to the necessary size and shape. This is accomplished by using either the average cell dia-
meter or the cell chord length (as defined in ASTMmethod D-3576) and themeasurements of the
sample to determine the volume of the cut cells. This volume is deducted from the total volume of
the open cellsmeasured by the pycnometer.

l Method B. Corrects for the cut cells by using two separatemeasurements. For the 2ndmeas-
urement, the sample is recut to double the amount of cut surface. The observed difference in cut
open cell volume is applied as a correction to the initial measured volume. Thismethod offers the
distinct advantage that no assumptions are needed about the relative amounts of open and
closed cells.

l Method C. Does not correct for cut cells. It is used for materials with predominantly open cells
where good accuracy can be achieved without correction. The accuracy level deteriorates as the
percentage of closed cells increases.

l Method D. Is a compressibility test. The fill pressure is increased incrementally over the sample
with each repeat of the P1,P21 ) cycle. The apparent variation of themeasured sample volume

1 ) Where P1 is the initial pressure to which the sample is charged, and P2 the final pressure after
expansion.

Asphalt Density Application
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1 About the AccuPyc II

with the average pressure is determined. This test is an approximate indication. It is not intended
to be an exact measure of the volume compressibility.

l Method E. Is a cell fracture test; a perfectly rigid foam is assumed. First, a P1,P2 cycle is per-
formed at the lower of two specified P1 pressures, and the results stored. A second cycle is per-
formed at a higher specified value of P1, then a third cycle identical to the first cycle is performed.
The difference between the volume of the sample on the first measurement and on the third meas-
urement is reported as the volume of fractured cells. It is assumed that cells fracture by exposure
to the highest pressure (2nd cycle) so that when the third measurement ismade, themeasured
sample volume has decreased from the first cycle by the amount of the closed cell volumewhich
was fractured.

The 100 cm3 AccuPyc II has been designed and tested to follow the procedure in ASTMMethod D
6226 for FoamPyc analyses. The 10 cm3 and 350 cm3 units can be used for some types of foam
materials; however, analyses on these AccuPycswill not conform to the ASTMmethod. The 1 cm3

AccuPyc II cannot be used to perform FoamPyc analyses.

The FoamPyc software also provides the capability to perform analyses in theStandardmode of
operation. This is especially convenient for users who have upgraded to the FoamPycmethod from
the standardmethod. For example, a 100 cm3 AccuPyc on which FoamPyc analyses are performed
and a 1 cm3 analysismodule attached on which standard analyses are performed.

1 - 4 AccuPyc II SeriesOperator Manual
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INSTRUMENT COMPONENTS

FRONT

The sample chamber, located on the top panel, is where the sample container is placed for analysis,
or the standard for calibration.

The sample chamber should remain capped except when inserting or removing a sample. When left
uncapped, water vapor adsorbs on the inner surface of the chamber or the chamber temperature
becomes unstable; either condition can affect analysis results. If water vapor accumulates in the
chamber, the pycnometer must be purged.

The standalone control module, often used for the Glove Box pycnometer, does not contain a
sample chamber.

Component Description

Active indicator A blue LED which illuminateswhen an operation is in progress. It is included
on all analysismodules. It is not included on standalone control modules.

Display window DisplaysRemote Operationwhen theWindows application is being used.
The AccuPyc can be operated in the keypadmodewhen theWindows applic-
ation is closed.

Keypad Not used with AccuPyc software application.

Power indicator A green LED which illuminateswhen the analyzer is powered on.

Instrument Components
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1 About the AccuPyc II

REAR

Component Description

Analysis module
connector

Used to connect up to five analysismodules to the initial control / analysismod-
ule. Eachmodule contains analysismodule input and output connectors.

Brightness con-
trol

Used to adjust the brightness of the display. SeeBrightness Control on
page J - 18.

Dust filter (not
shown)

(For 2000 cm3 units and high pressure units only.) Traps sample dust to pro-
tect internal valves.

Ethernet port Provides for setting up for e-mailing reports, sending data to a web browser,
or interfacing with the AccuPycWindows application.

Gas inlet port Use to connect the analysis gas; helium is recommended. If multiple analysis
modules are attached, eachmodule contains a gas inlet port. Multiple gases
can be attached using theMultigas option. SeeMultigas Option on page C
- 1.

ON/OFF switch For powering the analyzer on and off.

Power connector For connecting the power source to the instrument.

RS-232 port Used to transmit data only when using the keypad function. Also used to con-
nect to the analytical balance.

USB connectors Use for connecting a keyboard, printer, or balance to the instrument.

1 - 6 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



EQUIPMENT OPTIONS

SeeParts and Accessories on page 13 - 1

HIGH PRESSURE CORE PYCNOMETER
Gas pycnometry is recognized as one of themost reliable techniques for obtaining skeletal volume
and density. The fully automatic AccuPycHigh Pressure pycnometer provides high speed, high
precision volumemeasurements and density determinations on intact or crushed shale core
samples.

The high pressure pycnometer:

l Operates at a pressure of up to 500 psi to provide a better diffusion of the gas into the rock.
l Has a stainless steel sample chamber with a volume of 100 cm3.
l Has a sample chamber that can accommodate a 48mm (1.85 in.) diameter core of up to 60mm
(2.40 in.) in length.

LARGE VOLUME CORE PYCNOMETER
The AccuPyc Large Volume pycnometer sample chamber addresses the specific needs of
operations that require pore volume knowledge of intact drilling cores. This instrument eliminates the
need to break core samples into smaller pieces prior to analysis.

The large volume pycnometer:

l Has a large sample chamber with a volume of approximately 2000 cm3.
l Has a sample chamber that can accommodate a 95mm (3.74 in.) diameter core of up to 278mm
(10.9 in.) in length.

MULTIVOLUME INSERTS
TheMultiVolume option is used to analyze smaller sized samples. Options are:

l 1 cm3 nominal cell volume; contains a 0.1 cm3 cup
l 10 cm3 nominal cell volume; contains 1 cm3 and a 3.5 cm3 cups
l 100 cm3 nominal cell volume; contains 10 cm3 and 35 cm3 cups
l 2000 cm3 nominal cell volume, contains 650 cm3 and 1300 cm3 cups

Each kit includes inserts, reference standards, and sample cups.

Equipment Options
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1 About the AccuPyc II

MULTIGAS OPTION.
TheMultigasOption allows connection of up to four gases to one analyzer. SeeMultigas Option
on page C - 1.

CONFIGURATION OPTIONS

For best fit with a sample, the AccuPyc II is available in multiple configurations.

All sample chamber volumes are nominal unless otherwise specified.

l 1 cm3 sample chamber
l 10 cm3 sample chamber
l 100 cm3 sample chamber
l 350 cm3 sample chamber
l 2000 cm3 sample chamber
l 100 cm3 High Pressure sample chamber

Best fit means the sample nearly fills the sample chamber and, therefore, optimizes the precision of
the results.

GLOVE BOX
Provides for analysis of samples in which a controlled environment is required.

Options Description

Configuration l 1 cm3 sample chamber
l 10 cm3 sample chamber
l 100 cm3 sample chamber
l 350 cm3 sample chamber
l 2000 cm3 sample chamber
l 100 cm3 High Pressure sample chamber

This unit consists of two separatemodules. The controller is placed outside the glove box, while the
analysismodule is placed inside the glove box. Up to six analysismodulesmay be placed in the glove
box, all controlled by one external control module.

1 - 8 AccuPyc II SeriesOperator Manual
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TEMPERATURE CONTROLLED MODULE

Provides for the attachment of an external circulating bath.

Options Description

Configuration l 10 cm3 sample chamber
l 100 cm3 sample chamber

The temperature controlled unit is specifically designed for temperature sensitivematerials. This unit
is ideally suited for laboratories in which ambient temperature varies during normal work hours, or in
which subambient cooling is required.

POWER ANALYZER ON AND OFF

It is important that a constant temperature bemaintained inside the unit because a
change in temperature could alter analysis results. We recommend that the pycnometer
remain powered on at all times tomaintain thermal stability.

Do not power off the analyzer while initialization is in progress. Doing somay damage
the instrument.

When the analyzer is powered on, after a few seconds, the system vents automatically and the
green indicator light on the front panel illuminates. Allow approximately 30minutes for the analyzer
to warm before performing analyses. For analyses that require very precise results, allow the
analyzer to warm aminimumof two hours. If running the analyzer with a computer:

Power ON the equipment in the following order:

If running the analyzer with a computer:

1. Computer
2. Monitor
3. Printer
4. Analyzer

If running the analyzer without a computer:

1. Analyzer

Power Analyzer On andOff
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1 About the AccuPyc II

Power OFF the equipment in the following order:

If running the analyzer with a computer:

1. Analyzer. Allow any analyses in progress to complete prior to powering off.
2. Exit the analysis program. Failure to do so could result in loss of data.
3. Computer
4. Monitor
5. Printer

If running the analyzer without a computer:

1. Allow any analyses in progress to complete prior to powering off the analyzer.
2. Printer
3. Analyzer
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SPECIFICATIONS FOR ACCUPYC II 

Characteristic Specification

Analysis

Precision Reproducibility typically to within 0.01% of the nominal full scale cell
chamber volume. Reproducibility guaranteed to within 0.02% of the
nominal full scale volume on clean, dry, thermally equilibrated samples
using helium in the 15 °C to 35 °C range (15°C to 50 °C for
temperature controlledmodels).

High Pressure Units.Reproducibility typically within 0.05% of the
nominal full-scale chamber volume. Reproducibility guaranteed to
within 0.1%.

Accuracy Accurate to within 0.03% of reading, plus 0.03% of sample capacity.

High Pressure Units.Accurate to within 0.1% of reading, plus 0.1%
of sample capacity

Electrical

Voltage 90 to 264 VAC

Power 30 VA

Frequency 50 to 60 Hz

Environment

Non-temperature
Controlled

Operating Environment Temperature. Stable between 15 C° and
35 °C (59 °F to 96 °F)

Operating Humidity Range. 20 to 80% relative, non-condensing
Temperature
Controlled With
Circulator

Stable between 15 °C and 35 °C (59 °F to 96 °F)

Operating Environment Temperature. Stability is dependent upon
specifications of the installed circulator. Recommended range: 15 °C
to 50 °C (59 °F to 122 °F)

Operating Humidity Range 20 to 80% relative, non-condensing
Temperature
Controlled With TEC

Controlled temperature range. 15 °C to 36 °C, ±0.1 °C, in an
operating range of 10 °C to 30 °C with a 20% to 40% humidity level

Gases

Research grade helium or nitrogen is recommended. If unavailable, use heliumwith a dew point of
-67 °C (-88 °F) or lower. Carbon dioxide, dry air, or argon can also be used for different applic-
ations. A multigas option is available for connection of multiple gases.

Specifications for AccuPyc II 
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1 About the AccuPyc II

Characteristic Specification

Physical

Analysis Module
(1, 10, 100 cm3)

Height. 17.9 cm (7.0 in.)
Width.                 22.2 cm (8.7 in.)
Depth.                 36.2 cm (14.3 in.)
Weight.               7.9 kg (17.4 lbs) Standard unit
Weight 8.2 kg (18.1 lbs) High Pressure unit.

Analysis Module
(350 cm3)

Height. 25.9 cm (10.2 in.)
Width.                 22.2 cm (8.7 in.)
Depth.                36.2 cm (14.3 in.)
Weight.              10.5 kg (23.2 lbs)

Analysis Module
(2000 cm3)

Height. 43 cm (17 in.)
Width.                 27 cm (10.6 in.)
Depth.                36.2 cm (14.3 in.)
Weight.              26 kg (57 lbs)

Control Module Height. 17.9 cm (7.0 in.)
Width.                 27.3 cm (10.7 in.)
Depth.                36.2 cm (14.3 in.)
Weight.              3.6 kg (8.0 lbs)

Control Analysis Mod-
ule

Height. 17.9 cm (7.0 in.)
Width.                 27.3 cm (10.7 in.)
Depth.                36.2 cm (14.3 in.)
Weight.               9.3 kg (20.5 lbs)

TEC Module Height. 27.3 cm (10.7 in.)
Width.                 28.7 cm (11.3 in.)
Depth.                36.1 cm (14.2 in.)
Weight.              13.8 kg (30.5 lbs.)

Printers

Requirements l must be USB 2.00 (or newer)
l must have a printer language supported by one of the printer drivers
l cannot be host based

Supported printers Canon Bubble Jet
Postscript

Epson ESCP
Epson ESCP Raster
Epson ESCP2

HP PCL 3
HP PL 6XL

1 - 12 AccuPyc II SeriesOperator Manual
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Characteristic Specification

Sample Chamber

1 cm3 chamber ID:              1.15 cm (0.45 in.)
Depth:      1.1 cm (0.44 in)

10 cm3 chamber ID:              1.8 cm (0.71 in.)
Depth:      3.93 cm (1.55 in)

100 cm3 chamber ID:              4.62 cm (1.82 in.)
Depth:      6.17 cm (2.43 in)

350 cm3 chamber ID:              5.84 cm (2.3 in.)
Depth:      13.94 cm (5.49 in)

2000 cm3 chamber ID:              9.7 cm (3.8 in.)
Depth:      26 cm (10.2 in)

Computer Requirements

l Operating System.Windows 7 Professional or higher operating system is recommended for
the best user experience, however WindowsXP can be used.

l Desktop Installation Required. The application should not be installed on a network drive
with shared access. Multiple users cannot operate the application at the same time.

l 10 Base T Ethernet Port. If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet based unit is connected to the same computer, an Eth-
ernet switch will also be required.

l Read/Write Permissions. All users of the application will need Read /Write permission to all
directories and subdirectories where the application is installed.

l Drives.CD-ROMdrive and thumb drive.

In keeping with a policy of ongoing product improvement, specifications are subject to change
without notice.

Specifications for AccuPyc II 
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2 DATA ENTRY WITH KEYPAD
Data can be entered into the system using either a:

l Keypad (or a keyboard). Used if a computer with the analyzer software installed is not con-
nected to the analyzer. In this case, any section of thismanual referring to software can be omit-
ted. All instructions specific to the keypad are designated with the icon specified in the section
About this Manual on page iii. Also seeConfigure the Pycnometer using the Keypad on
page J - 9.

l Computer. Used if the computer with analysis software is installed and connected to the analysis
module. In this case, this section of thismanual can be skipped.

ABOUT THE DISPLAY
The display provides information about the analyzer and the current operation. During operations,
different types of information are shown in lines two, three, and four. Line one always displays the
unit and serial number. If theAlt key is pressed, the 3 in 10 cm3 will change to a + (plus sign). This is
an example of the display when the analyzer is in an idle state, or theReload prompt.

Line Description

First Displays the unit number, serial number, and nominal cell volume of
the selected unit. Up to five analysismodulesmay be attached; though
the initial module, containing the keypad and display, will control all
units.

Second At theReload prompt, manual control, or an automatic operation, this
line contains three characters, separated with dashes. The first
character represents the Fill valve, the second represents theExpand
valve, and the third represents theVent valve.

Valve states: X = Closed, O = Open

During user interface, this line shows the command currently in use.
Third Displays status of the current operation, orReloadwhen in an idle

state. When theReload prompt is displayed, this linemay also contain
an asterisk (*), indicating there is amessage in the queue. During cer-
tain functions (such asSetup), this line contains a prompt for additional
information.

2 Data Entry with Keypad
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2 Data Entry with Keypad

Line Description

Fourth At theReload prompt, shows the current pressure and temperature
alternately, where:

l P = Pressure
l T = Temperature

This line is also used to choose options, enter information, or provide
information about the current operation.

ABOUT THE KEYPAD

A keyboard can be connected to the USB port on the rear panel of the AccuPyc II. Com-
mands can be entered from either the keypad or the keyboard.

Most keys on the keypad perform one primary and one alternate function. The primary function of
any key is indicated by the number or command on the face of the key. The alternate function is
indicated by the command above the key. The top right corner of the display screen will show a +
(plus sign) when theAlt key is pressed and the alternate functionmode is entered. SeeAbout the
Display on the previous page.

To select the:

l Primary function.Press only the key. Primary functions are labeled on the key face. For
example; press 4 to enter the number 4.

l Alternate function.PressAlt, then press the key. Alternate functions have blue labels above
the key. For example; pressAlt + 4 to start an analysis. If theAlt key is pressed accidentally,
pressing it a second time will cancel its function.

The alternate functions for keys 7 (FILL), 8 (EXPAND), and 9 (VENT) are executed differently.
PressAlt + 1 first to enter Manual mode then press the alternate key. For example: pressAlt + 1 +
7 to manually control the Fill valve. PressAlt + CLEAR to exit Manual mode.

Functions can be entered from the keyboard.
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Keypad
Function

Key Sequences Description
Keypad Keyboard

Decimal (.) . . Enter a decimal point, a dash for sample or
instrument ID, a slash for date, or a colon for
time

Number keys ( 0
through 9 )

0 - 9 0 - 9 Enters the numbers 0 through 9

Calibrate Alt + .
(decimal)

Ctrl + O Calibrates the pycnometer.

Zero Alt + 0 Ctrl + Z Zeroes the pressure transducer.

Manual Alt + 1 Ctrl + Y Providesmanual control to open and close
valves.

l Fill (Key 7)
l Expand (Key 8)
l Vent (Key 9)

The state of the valve is shown on the second
line of the display, where X=Closed and
O=Open.

Alt + CLEAR exitsmanual mode.
Set Up Alt + 2 Ctrl + U Display or edit:

l Analysis parameters
l Report options
l Calibration data
l Data transmission parameters
l Unit types
l Operating language
l Date and time

Keypad and Keyboard Functions

About the Keypad
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2 Data Entry with Keypad

Keypad
Function

Key Sequences Description
Keypad Keyboard

Transmit Alt + 3 Ctrl + T Transmits analysis or calibration data. Trans-
mits a partial report if an automatic operation is
in progress.

Analyze Alt + 4 Ctrl + A Performs an analysis.

Review Alt + 5 Ctrl + R Review completed analysis or calibration data.

Print Alt + 6 Ctrl + P Prints an analysis or calibration report. If an
automatic operation is in progress, prints a par-
tial report.

Unit Alt +
CHOICE +
(unit num-
ber)

N/A Selects unit (whenmultiple analysismodules
are attached).

Escape Alt + CLEAR Esc Discards all data entered in the current mode
and returns to displaymode. Cancels an auto-
matic operation in progress. Exitsmanual
mode.

CHOICE CHOICE Ctrl + N Display the next message when in display
mode.
Display the next multiple choice itemwhen in
commandmode.

CLEAR CLEAR Ctrl + X Clear amessage when in displaymode.
Clear an entry when in commandmode.

ENTER ENTER Enter or Ctrl +
M

Complete an entry or begin an action.

SAVE SAVE Ctrl + W Save the information and return to display
mode.

Keypad and Keyboard Functions (continued)
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CANCEL AN ANALYSIS

To cancel an analysis, pressAlt + CLEAR.

PressENTER within five seconds to cancel the operation. A notification that the automatic operation
has been canceled will be displayed.

When canceling an operation, messages are displayed indicating that termination is in progress. The
termination process, which vents the system, takes about 30 seconds and returns to theReload
prompt.

To view the data that have been collected, pressCHOICE.

The following prompt is displayed if no cycles have been completed.

Cancel an Analysis
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2 Data Entry with Keypad

MANUAL MODE

PressAlt + 1 to enter manual mode, allowingmanual control of the Bypass, Fill, Expansion, and
Vent valves.

The Bypass valve is only available on the 2000 cm3 units and the High Pressure Core
Pycnometer units.

Display Text Description

Manual WhenManual is shown, manually open and close the Fill, Expansion,
and Vent valves by pressing:

l 5 - Opens and closes theBypass valve
l 7 - Opens and closes the Fill valve
l 8 - Opens and closes theExpansion valve
l 9 - Opens and closes theVent valve

The three characters in the second line of the display show the state of
the valves (Fill, Expansion, Vent). X = Closed.O = Open.

PressSAVE to exit Manual mode and return to displaymode.

Prolonged opening of all three valves at one timemay cause excessive loss of helium.
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TRANSMIT

The AccuPycRS-232 interface transmits report data to a computer using the standard ASCII file
format. Reportsmay be transmitted in a single column format or a spreadsheet format. See
Transmitted Data on page I - 1.

PressAlt + 3 to transmit report data.

PressAlt + CLEAR to cancel report data transmission.

ANALYSIS PARAMETERS

This option enables specific analysis and calibration parameters. Although theSetup Type is shown
asAnalysis Parameters, these same prompts are used to specify calibration parameters. The
pycnometer is shipped with default values; however, these settingsmay bemodified tomeet
laboratory requirements.

After each selection, pressEnter to display the next prompt. If data results are to be e-mailed
automatically after analysis, specify e-mail parameters inSetup Reports on page J - 14.

Enter appropriate analysis and report parameters for the current analysis. The chosen or specified
parameters inSet Up determine what prompts and information are displayed for the analysis.

Display Text Description

Setup Type?
Analysis Parameters

PressENTER to acceptAnalysis Parameters.

Number of Purges: Key in the number of purges to be performed. Purging cleans the
sample cell and expansion chambers before an analysis begins. The
greater the number of purges, the cleaner the sample will be when
analyzed.

The range is 0 to 999. For calibration, 10 is sufficient.
Purges fill pressure Key in the fill pressure. For most applications, the default of 19.500

psig is adequate. Typically, the greater the fill pressure, the easier it is
to measure the volume precisely. However, a lower pressuremay be
required for some samples.

The range in psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

High Pressure sample chamber:

The range in psig is 0 to 500.
The range in kPag is 0 to 3450.

Transmit
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2 Data Entry with Keypad

Display Text Description

Number of Cycles Key in the number of cycles to be performed. A cycle is a series of
functionswhich equal to a single volumemeasurement.

The range is 1 to 999. For calibration, 10 is sufficient.
Cycle fill pressure Key in the fill pressure. For most applications, the default of 19.500

psig is adequate.

The range in psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

High Pressure sample chamber:

The range in psig is 0 to 500.
The range in kPag is 0 to 3450.

P1, P2 end by?
[selection]

Choose themanner in which to end the pressuremeasurement.
PressCHOICE to make a selection.

The available options areEquilibrate and Fixed interval.
Equilibration Rate: (Does
not display for Fixed
Intervals)

SelectEquilibrate at theP1, P2 end by? prompt. Pressure
measurement will end when the entered rate is obtained. Key in the
equilibration rate.

A high rate will produce faster results, but resultsmay not be as
precise as desired. The lowest ratesmay cause errors when some
materials (such as those with appreciable vapor pressures or
organics) are analyzed.

The default setting is 0.0050 psig/min.
The range in psig/min is 0.0001 to 9.0000.
The range in kPag/min is 0.0007 to 62.0500.

High Pressure sample chamber:

The range in psig is 0.001 to 99minimum (the default is 0.05)
Interval Time: (Does not
display for Equilibrate)

Select the Fixed interval at theP1, P2 end by? prompt. Pressure
measurement endswhen the specified time is reached. Key in the
interval time.

The range is 10 to 99999 seconds.
Use Run Precision? Allows early termination of the analysis when certain criteria aremet.

l Yes. The analysis terminates after five consecutive cycles are
within the specified tolerance. Always request a large number (50
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Display Text Description

to 99) of runs. The number of runs is determined through theNum-
ber of Cycles option. With a small number of runs, the analysis
stopswhen the selected number is reached, even if the specified
tolerance has not beenmet.

l No.Run Precision is not used.

Percent Full Scale: This prompt only displays if Yes is selected forRun Precision and
more than five cycles have been requested.

Enter the run precision volume tolerance which is expressed as a
percentage of nominal cell volume (sample capacity).

The range is 0.01% to 50.00%.

Analysis Parameters
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2 Data Entry with Keypad

REVIEW DATA

TheReview function allows review of and editing of the results of the last operation – analysis or
calibration – along with its entered parameters. It is important to review and print the report before
starting another operation. Data are no longer available for review on the display when another
operation is started; however, data results are saved in the control module and can be reviewed
using a web browser.

Review Data with a Web Browser

Data results for the last five analyses are saved in the control module for each attached unit. These
results can be viewed by accessing a web browser. To use this feature, connect to a network.

1. PressAlt + 2 to accessSetup. Then pressCHOICE untilCommunications is displayed.
2. PressENTER to display a prompt showing that the IP Addressmode isDHCP.

The displaymay show Specify, depending on how the IP addresswas assigned.

3. PressENTER to view the assigned address on the display. If the addresswas specified, the
display shows IP Address? and the entered address. This line is editable since it is specified
and not assigned automatically. An assigned address cannot be edited.

4. Make a note of the IP address.
5. PressAlt + CLEAR to return to theReload prompt.
6. Access the web browser and type in the IP address.
7. PressEnter to display the serial number(s) of the attached unit(s).

8. Click on the serial number of the unit containing the data to review. A window displaying the
data files for the last five analyses, and for the zero (slope) and volume offset files is displayed.

2 - 10 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



The files are in .HTML format and are assigned the name used as theSample ID. If sample
identifications are not used,Untitled is assigned and appended for each file.

9. Click the file to view the data results. The progress of a current operation can bemonitored by
reloading the page.

10. Use the File > Print option to print a copy of the results.

Review Data
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2 Data Entry with Keypad

VIEW DATA RESULTS

PressAlt + 5 to view data results.

Reports are generated after analysis and calibration, and remain available for viewing or printing
until another automatic operation (other than zero) is performed.When an automatic operation is
performed, data from the previous operation are no longer available for viewing on the display.

A display report is always generated regardless of the specified destination and contains:

l Analysis. The average density (or volume) and the deviation from themean.
l Calibration. Average cell (or expansion volume) and the deviation from themean.

PRINT A FILE

PressAlt + 6 to print a report of the last operation; analysis or calibration. IfAlt + 6 is pressed during
an automatic operation, a partial report is printed.

Reports are generated after analysis and calibration, and remain available for viewing or printing
until another automatic operation (other than zero pressure) is performed. Previously generated
reports are deleted whenever a new automatic operation begins.

For each attached analysismodule, the data for up to five analyses are stored in the control module.
These data sets can be viewed using a web browser when connected to a network.

An asterisk next to a cycle number indicates that it has not been included in calculations.

l Analysis.Volume, density, deviation for each cycle, an average of all cycles, the date and time
the analysis was started and completed, and the temperature of the cell chamber.

l Calibration.Cell and expansion volumes and deviations for each cycle, an average of all cycles,
and the date and time the calibration started and completed.
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3 ABOUT THE SOFTWARE

The AccuPyc II Pycnometer’s unique run precision reports data from five consecutive runs that are
within a user-specified tolerance. This feature allows early termination of analyses, thereby
decreasing the number of runs needed for accurate results.

Analysis provides themeasurement of sample volume, fromwhich density can be derived
automatically if the samplemass is entered. The unit comes preprogrammedwith default conditions
and ready to perform analyses. It can be reprogrammed tomeet specific needs. Analyses can be
modified by entering the number of purges and purge fill pressure, number of cycles and cycle fill
pressure, equilibration rate, and run precision. Modifying these parameters allow control of the
primary portions of the analysis; purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypadmode. For example;
if the computer is inoperative for some reason, analyses can be performed using the keypad.

If running the FoamPycmodule, an option to select a Standardmethod is available so that analyses
on other types of samplematerials can be performed.

See Installation Instructions on page J - 1 for hardware installation, software installation, and
software upgrade instructions.

MENU STRUCTURE
All program functions use standardWindowsmenu functionality. The title bar contains aUnit
Number. If multiple units (analyzers) are installed, ensure the appropriate unit is selected before
continuing.

Option Description

File Use tomanage files used by the application— such as sample files, ana-
lysis conditions files, report options files, etc.

Unit [n] Use to perform analyses, calibrations, and other analyzer operations.Unit
[n] displays on themenu bar for each analyzer attached to the computer.

Reports Use to run reports and view the results.

Options Use to edit the default method, specify system configuration, specify units,
and change presentation options.

Window Use tomanage open windows and display a list of open windows. A check-
mark appears to the left of the active window.

Help Provides access to the operator manual and information about the ana-
lyzer.

Main Menu Bar Options

3 About the Software
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3 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located inmultiple windows throughout the analyzer
application and have the same description or function. Fields and button descriptions not listed in this
table are found in tables in their respective sections.

Field or Button Description

Add Log Entry Use to enter information to appear in the sample log report that cannot
be recorded automatically through the application. Click the button
again to enter multiple log entries.

Autoscale When enabled on report parameters windows, allows the x- and y-
axes to be scaled automatically.Autoscalemeans that the x- and y-
rangeswill be set so that all the data is shown. If Autoscale is not selec-
ted, the entered range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code Enter bar code reader information if a bar code reader is connected to
the computer’s USB port. If a bar code reader is not used, this alpha-
numeric field can be used to enter additional information about the
sample, such as a sample lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Close Closes the active window.

Close All Closes all active windows. If changesweremade and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments about the sample or analysis. Comments display in
the report header.

Delete Whenworking with report parameters,Delete removes the selected
report. Deleted reports will have to be regenerated if deleted in error.

Destination Select the report destination.

Preview.Previews the predefined report on the screen.

Print.Sends the report to the default printer.

Copies.Select the number of copies to print. This field is only enabled
whenPrint is selected.

File.Select the destination directory. Enter a new file name in the File

Common Fields and Buttons Table
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Field or Button Description
name field, or accept the default. Select to save the file as a report
system (.REP), a spreadsheet (.XLS), a portable document format
(.PDF), or an ASCII text (.TXT) file format.

Edit Whenworking with report parameters, highlight the item in theSelec-
ted Reports list box and clickEdit to modify the report details.

Exit If a file is open with unsaved changes, a prompt displays providing the
option to save the changes and exit or to exit the application without
saving the changes.

Export Exports data in a sample file as a .REP, .TXT or .XLS file. When saved
to a file, the data can be imported into other applications.

File name Select a file from either theName column or from the library.

From / To Whenworking with report parameters windows, enter the From and
To range for x- and/or y-axes.

List Provides the option to create a list of sample or report options file
information, for example, file name, date / time the file was created or
last edited, file identification and file status.

Name column A list of files in the selected directory or library.

Next Click tomove to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double click the file name in the
Name column to open the file.

Prev Click tomove to the previouswindow.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer or file).

Remove Click to remove an item from the list.

Replace Click to select another file where the valueswill replace the current
file’s values.

Replace All Click to select another .SMP file where the valueswill replace all val-
ues for the active sample file. The original file will remain unchanged.

Common Fields and Buttons Table (continued)

Common Fields and Buttons
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3 About the Software

Field or Button Description

Report Click to display a window to specify report output options.

Start Date.Displays a calendar to select the start date for the report.

Preview.Previews the predefined report on the screen.

Print.Sends the report to the default printer.

Copies.Select the number of copies to print. This field is only enabled
whenPrint is selected.

File.Select the destination directory. Enter a new file name in the File
name field, or accept the default. Select to save the file as a report
system (.REP), a spreadsheet (.XLS), a portable document format
(.PDF), or an ASCII text (.TXT) file format.

Save Saves changes to the active window.

Save As Saves a file in the active window under a different file name.

Start Starts the report, test, analysis, or operation.

Table buttons Use tomodify the table contents.

Insert. Inserts one row above the selected row.

Delete.Deletes the selected row.

Clear.Clears all table entries and displays only one default value.

Append. Inserts one row at the end of the table.
View Instrument Log For use by a Service Technician. Operators should useUnit [n] >

Show Instrument Log.
View Operation. Use to display the current mode of operation.

Instrument Log. Use to display recent analyses, calibrations, errors
or messages.

Instrument Schematic. Use to display a schematic of the analyzer
system.

Common Fields and Buttons Table (continued)
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OPTION PRESENTATION
Options > Option Presentation
Use to change the way sample files and parameter files display:Advanced, Basic, orRestricted.
Each display option shows sample information and options differently.

Presentation Display Description

Advanced Displays all parts of sample information and parameter files. Navigate
to parameter windows by selecting the tabs across the top of the win-
dow.

Basic Displays sample information in a single window. This display option is
used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window similar to theBasic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same passwordmust be entered to
change to theBasic or Advanced display option. This display type is
typically used in laboratories where analysis conditionsmust remain
constant— such as the pharmaceutical industry. TheAdvanced option
is not available at the bottom of the window when using theRestricted
display option.

Option Presentation Display Table

If the AccuPyc II TEC application is installed, additional fields for inserting values for the sample cup
can be displayed. Go toOptions > Option Presentation > Show Cup Properties to enable
these fields.

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

The following examples show the same sample file inAdvanced andBasic display.Basic and
Restricted displayswill look the same.

Option Presentation
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3 About the Software

A sample file must be created for each analysis. The file can be created prior to or at the
time of analysis. The sample file identifies the sample, guides the analysis, and specifies
report options.
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FILE STATUS, DESCRIPTION, EXTENSION, AND LOCATION
In the File Selectorwindow, theMicDescription column and theMic Status column display file
description and file status. The File Selector incorporates standardWindows features for resizing
windows, reordering and repositioning columns, and right clicking an entry to display amenu of
standardWindows functions.

File Status Description

Analyzing Sample files that are currently being used for analysis.

Complete Sample files used in an analysis that has been completed.

No Analysis Sample files which have not been used to perform an analysis.

File Status and Description Table

File Type File Name
Extension

Default Location

Analysis conditions .ANC ParamDirectory

Report options .RPO ParamDirectory

Sample cup .CUP ParamDirectory

Sample information .SMP ParamDirectory

The following file types are available when printing or exporting reports:

Spreadsheet .XLS

Unicode .TXT

File Type, Extension, and Location Table

File Status, Description, Extension, and Location
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3 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate somemenu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of themenu item.

Certain menus or functions can also be accessed using theAlt key plus the underlined letter in the
menu command. For example, to access the Filemenu, pressAlt + F, then press the underlined
letter on the submenu. For example,Alt + F opens the Filemenu, then pressO to access the File
Selector for opening files.

If the underscore does not display beneath the letter on themenu or window, press the
Alt key on the keyboard.

Field or Button Description

F1 Opens the online help operator manual.

F2 Opens the File Selectorwindow.

F3 Opens the File Selectorwindow listing analysis conditions files.

F5 Opens the File Selectorwindow listing report options files.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Start a report.

F9 Close all open reports.

Alt + F4 Exit the program.

Shift + F2 List sample files.

Shift + F3 List analysis conditions files.

Shift + F5 List report options files.

Keyboard Shortcut Table
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SAMPLE DEFAULT FILE
Options > Sample Defaults
A Sample Default determines the default sample identification format and sequence number. A
Sample Default is a template of specifications that go into a newly created sample file. It allows for
the definition of complete sets of parameters for each type of sample commonly analyzed, so that
only a single selection is required for each new sample file created.

WhenSample Default files are created and saved, use theReplace All button when on a sample
file to replace values in the open file with values from theSample Default file. Sample defaults can be
created and saved for sample files (.SMP), analysis conditions files (.ANC), and report options files
(.RPO).

ANALYZER STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages.

Field Description

Analysis /
Calibration /
Message [selection]

Select the logs to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Instrument Log Fields and Buttons Table

Sample Default File
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3 About the Software

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window, manual
control must be enabled (Unit [n] > Enable Manual Control).

Icon or Symbol Description
Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve with manual control enabled.

Closed Valve. White indicates a closed valve with manual control not enabled
Sample Chamber.

Expansion Chamber.

Pressure and temperature readings.Displays for either the expansion
chamber or the sample chamber, depending on the unit configuration.

Gas flow direction.

Analyzer Schematic Icon Table
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Instrument Schematic Shortcut Menus

Eachmanually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover themouse pointer over
the component and right click.

Schematic Shortcut Icon Available Options:

Valve options Close.Closes the selected valve.

Open.Opens the selected valve.

Schematic Shortcuts Table

SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port. If multiple units are attached to the computer, go toUnit
[n] > Show Status for the indicated unit.

Field or Button Description

Cycles The current cycle and the number of cycles requested. For example, 2
(current) of 10 (requested).

Density Last computed density and standard deviation, if applicable.

Elapsed Time The elapsed time of the current step.

Equilibration Themeasured equilibration rate and the limit.

Operation The operation, task, and the step in progress.

Pressure The pressure in the sample chamber.

Sample The name of the sample file being analyzed.

Temperature The temperature of the sample chamber.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Sow Status Fields and Buttons Table

Show Status
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3 About the Software

PRINT, LIST, OR EXPORT FILES
File > Print > [File Type]
File > List > [File Type]
File > Export > [File Type]

Field or Button Description

Date Range Click to filter by a date range.

Directories:
c:\...\data

Displays directories where files are found.

Export Type (Export fea-
ture only)

Cycle Data. Exports as five columns containing the elapsed time, P1
(fill pressure), P2 (expansion pressure), Volume, and Temperature.

P[n] Equil Data. Exports as one column of equilibration data.
File name Enter the name of a new sample file.

File Type (Export feature
only)

Select either .XLS or .TXT.

Files Displays the files that fit the search criteria.

File Print, List or Export Fields and Buttons Table
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Field or Button Description

Status To filter by file status, select a status from the drop-down list.

All. Displays all files

Analyzing. Sample files that are currently being used for analysis.

Complete. Sample files used in an analysis that has been completed.

No Analysis. Sample files which have not been used to perform an
analysis.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

File Print, List or Export Fields and Buttons Table (continued)

Print, List, or Export Files
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3 About the Software

OPEN A FILE
File > Open > [File Type]

Whenworking with an existing file, it is recommended that a copy of the file be used
rather than the original.

Fields and buttonswill vary depending on the file type selected.

Field or Button Description

Date Range Click to filter by a date range.

Directories:
c:\...\data

Displays directories where files are found.

File name Enter the name of a new sample file.

Files Displays the files that fit the search criteria.
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Field or Button Description

Status To filter by file status, select a status from the drop-down list.

l All. Displays all files
l Analyzing. Sample files that are currently being used for analysis.
l Complete. Sample files used in an analysis that has been completed.
l No Analysis. Sample files which have not been used to perform an ana-
lysis.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed.
Parameter files, sample files, reports, calibration files, and data files are not removed.

1. Insert theSetupmedia into themedia drive.
2. Select theUninstall option.
3. Follow the prompts.

Uninstall the Software
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4 ABOUT SAMPLE FILES
Sample files include the information required by the analyzer to perform analyses and collect data. A
sample file identifies the sample, guides the analysis, and specifies report options andmay be
displayed in either Advanced, Basic, orRestricted presentation displaymode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either prior to or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

The analysis software contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

Specify or change the default option presentation by selectingOptions > Option
Presentation, or selectBasic or Advanced from the drop-down list at the bottom of the
window.

CREATE SAMPLE FILES
Options > Option Presentation > [Advanced / Basic / Restricted]

File > New Sample > [.SMP File]

File > Open > [.SMP File]

4 About Sample Files
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4 About Sample Files

Each analysismust be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone. SeeAbout Parameter
Files on page 5 - 1.

The values specified in the parameter portions of the default sample file are saved as the defaults for
new sample files. To navigate from one set of parameters to another, select the parameter tab
across the top of the window.

TheBasic andRestricted formats use predefined parameter files to create a sample file.

When using theBasic option presentation, switch toAdvanced to edit parameter file
values.When using theRestricted option presentation, parameter files cannot be
edited.

Field or Button Description

Cup mass * [text box] Enter the cupmass.

Geometry ** [button] Enter material properties when using the FoamPycMethod.

User Computed.Select to enter the geometric volume and when
usingMethod A, theActive Area. Active Area is the total geometric
surface area of the sample - excluding any sides that contain a skin.

Compute. Select the shape of the sample and enter the dimensions.

Number of Pieces. The number of piecesmaking up the sample.
Material Properties
[button]

SeeMaterial Parameters on page 4 - 5.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Sample
Defaults.

Sample [text box] Enter a sample description.

Sample File Fields and Buttons Table
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Field or Button Description

Sample cup *
[drop-down box]

Select a sample cup file from the drop down list or clickEdit to create
and save a new file for sample cup properties. SeeSample Cup on
the next page.

Sample mass
[text box]

Enter the samplemass.

Submitter [text box] Enter submitter identification information. This text boxmay have been
renamed or may not display if modified inOptions > Sample
Defaults.

User Parameters
[group box]

These fields are primarily used for the SPC (Statistical ProcessCon-
trol) reporting to specify sample characteristics or itsmanufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
SummaryReport. This optionmay not display (or may have a different
field label) if modified in the through Options > Sample Defaults.

* Option displays only in the Asphalt application.
** Option displays only in the FoamPyc application.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Sample File Fields and Buttons Table (continued)

Create Sample Files
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4 About Sample Files

SAMPLE CUP
Options > Option Presentation > Show Cup Properties

File > Open > [.CUP File]
(or click theSample Information tab when in Advanced option presentation)

Use to set the sample cupmass and density.

Field or Button Description

Density [text box] Enter the density of the sample cup.

Mass [text box] Enter the sample cupmass.

Sample Cup [text box] Enter a description of the sample cup.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Sample Cup Properties Fields and Buttons Table
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MATERIAL PARAMETERS
File > Open > [.SMP File]

Material parameters are used to report porosity or total solids concentration when using the
Standard analysismethod.

Field or Button Description

Bulk Density / Envelope Dens-
ity [selection]

Calculated from a volume that includes pores.

Liquid Density [text box] Density of the liquid.

Solids Density [text box] Density of the solid sample.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Material Parameters Fields and Buttons Table

Material Parameters
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5 ABOUT PARAMETER FILES
Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, anAnalysis Conditions file containing the recurring conditions
can be created.When the sample file is created, theAnalysis Conditions file can be selected for the
analysis conditions. Once it becomes part of the new sample file, the new file can be edited as
needed without affecting the originalAnalysis Conditions file.

The following file types can exist as part of the sample file aswell as individual parameter files:

File Type File Extension

Analysis Conditions .ANC file extension

Material Parameters .MTP file extension

Report Options .RPO file extension

Sample Cup .CUP file extension

PARAMETER FILES DIRECTORY
Options > Parameter Files Directory
Use to select the location for the predefined parameter files displayed in the drop-down lists when
using the Basic or Restricted option presentation. This configuration option is not available if using
the Restricted option presentation.

The system default directory is the recommended location for saving report options files.
The default directory is ..\param, if accessed from the top-level installation directory.

5 About Parameter Files
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5 About Parameter Files

ANALYSIS CONDITIONS
File > Open > [.ANC File]
(or click theAnalysis Conditions tab when inAdvanced presentation option)

Analysis conditions specify the data used to guide an analysis.

Field or Button Description

Analysis Conditions
[text box]

Displays the description of the file. If this is a new file, the description
specified in sample defaults is displayed.

Analysis gas [text box] The gas to be used for analysis gas (helium is recommended).

Analysis method
[selection]

See FoamPyc Application on page 5 - 4.

Cycle fill pressure
[text box]

Enter the fill pressure for the cycles. Typically, the default of 19.500
psig is appropriate for most samples.

End equilibration by:
[group box]

Rate. Equilibration endswhen the rate of pressure change drops
below the entered amount.

Time. Equilibration endswhen the specified time interval is attained.
Number of cycles
[text box]

The number of cycles to be performed. A cycle is a series of func-
tionswhich equals to a single volumemeasurement.

Number of purges
[text box]

The number of purges to be performed. A higher number of purges
will mean a cleaner sample.

Analysis Conditions Fields and Buttons Table
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Field or Button Description

Percent full scale
[text box]

Enabled whenUse run precision is selected. Enter the run precision
volume tolerance which is expressed as a percent of nominal cell
volume (sample capacity).

Purge fill pressure
[text box]

The purge fill pressure (in psig or kPa). For FoamPyc analyses, the
typical pressure is 3.5 psig. For analyses on standard samples, the
measured volume ismore precise if a greater fill pressure is used.
The default of 19.500 is appropriate for most standard analyses.
Somematerials, such as organic polymers, may require a lower
pressure in order to limit permeability into the samplematrix.

The default is 500 psig for the High Pressure sample chamber.
Record P1 equilibration
data [check box]
Record P2 equilibration
data [check box]

Record first. Enter the number of cycles to be recorded at the
beginning of the analysis.

Record last. Enter the number of points to be recorded at the end
of equilibration.

Use run precision
[check box]

Select to use run precision. This feature provides early termination
of the analysis when certain criteria aremet. The analysis ter-
minates after five consecutive cycles are within the specified tol-
erance. Typically, a large number (50 to 99) of cycles is requested. If
a small number of runs is selected, the analysis stopswhen the
entered number is reached even though the specified tolerance has
not beenmet. If fewer than five cycles are requested, this feature is
disabled.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Analysis Conditions Fields and Buttons Table (continued)

Analysis Conditions
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5 About Parameter Files

FOAMPYC APPLICATION
File > Open > [.ANC File]

Selection Required Action

Standard SelectRecord equilibration data then enter the criteria (if recording equilibration
data).

A, B, or C Enter the Resin density.

D Enter the initial and final pressure, and the pressure increment.
Enter Resin density.

E Enter the Low pressure and the Fracture pressure.
Enter Resin density.

Analysis Methods
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REPORT OPTIONS

File > Open > [.RPO File]
(or click theReport Options tab when in Advanced presentation display)

SeeSelected Reports on page 8 - 1

If using the FoamPyc application, reports for all FoamPycMethods are fixed
and cannot be created or selected fromwithin the application.

Report options specify the types of reports to be generated from an analysis and allow for
customization of reports such as axis scale, axis range, and column headings.

Report Options files can be customized to accommodate standard analysis requirements. Reports
can be generated automatically after each analysis or at any time during or after an analysis. A report
generated during an analysis only includes data collected up to the time of the report.

Report Options filesmay be defined to include overlay options. This system allows the overlay of up
to 8 plots of different samples onto a plot of the same type or overlay one plot type onto a different
plot type from the same analysis.

Field or Button Description

Overlays [button] Click to open theGraphOverlay Sampleswindow. ClickBrowse to
select sample files to overlay into a plot.

Report Options Fields and Buttons Table

Report Options
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5 About Parameter Files

Field or Button Description

Report Options
[text box]

Displays the description of the file. If this is a new file, the description
specified in sample defaults is displayed.

Selected Reports
[selection]

Select the report names to include in the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Report Options Fields and Buttons Table (continued)
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COLLECTED DATA
TheCollected Data tab displays after an analysis has been completed.

Field or Button Description

Cell Volume [text box] Nominal cell volume for the unit or for the selected insert.

Chamber Insert
[selection]

Select the chamber insert size, if applicable. Optionswill vary depend-
ing on the type of unit being used.
Values in theVolume column are recalculated automatically if the
Chamber Insert selection is changed.

Expansion Volume
[text box]

Expansion volume for the current unit or for the selected insert.

Pressure Table
Columns

Displays information collected during analysis:

l Elapsed Time
l P1 Pressure (fill)
l P2 Pressure (expansion)
l Volume
l Temperature

Collected Data Fields and Buttons Table

Collected Data
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5 About Parameter Files

Field or Button Description

l Exclude. Click the cell for each cycle to exclude in the average cal-
culations. An x in the cell indicates the cycle will be excluded.
Excluded parameters aremarked with an asterisk (*) in the gen-
erated report.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Collected Data Fields and Buttons Table (continued)
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6 PERFORM AN ANALYSIS
An analysis can be performed from either the computer application or directly from the keypad on the
analyzer.

SeeHandling System Components on page J - 1

PREPARE AND LOAD A SAMPLE

FOAMPYC METHODS

FoamPycMethods are intended to conform to the procedures detailed in ASTMTest MethodsD-
6226 and D-3576. Prepare samples according to themethods outlined in these procedures. Once
the sample is prepared and placed into the sample chamber, seePerform an Analysis above.

STANDARD METHOD

Samplesmust be properly prepared to obtain accurate results. Samplesmust be free of moisture in
order to obtain true samplemass and to avoid the distorting effect of water vapor on the volume
measurement. The following procedures are recommended; however, modificationsmay be
necessary for somematerials:

l Heat-sensitivematerialsmay have to be dried by long-time exposure to silica gel, freeze drying,
etc.

l Materials having a low melting point may be dried using the purge process. In this case, do not
weigh the sample and cup until after the purge and analysis have been completed.

Avoid exposure of the dried sample to atmosphericmoisture during each step of the preparation
process. Thismeansweighing as rapidly as possible and installing in the instrument without
unnecessary delay.

Keep the cap on the cell chamber except when actually inserting or removing a sample.
If the chamber remains uncapped, water vapor will adsorb on the inner surface of the
chamber and temperature instability will occur; either condition can affect analysis res-
ults.

1. Weigh the empty sample cup.
2. Place as large a quantity of sample as is possible in the cup (cup should be two-thirds full).

Pack powders and fluffymaterials (if permissible) to obtain maximum sample weight in the
cup.

3. Place the sample cup with sample in a drying oven. The amount of time the samplemust be
heated depends on thematerial and the temperature it will tolerate; thismay have to be estab-
lished by other tests.

6 Perform an Analysis
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6 Perform an Analysis

4. Remove the sample cup from the oven and transfer it to a desiccator provided with active
desiccant. Allow it to cool until near room temperature. Minimize air exposure of the sample.

5. Use this equation to determine the samplemass. (If volume only is to bemeasured, skip this
step.)

Masssample = Masssample+cup –Masscup

6. Remove the cell chamber cap, place the sample cup (with sample) into the cell chamber, then
replace the cap.

It is best not to lay the cap downwhile loading the sample. Immediately replace the cap when
the sample is loaded. This will prevent particles from accumulating on the greased surface
(seeHandling System Components on page J - 1 for guidelines on handling system
components).

7. If using a temperature-controlled AccuPyc, perform the following steps before proceeding,
seePerform an Analysis on the previous page.

a. Power on the bath circulator and specify the temperature for analysis. (Refer to theman-
ufacturer manual for instructions on operating the bath circulator.)

b. Allow the temperature to stabilize to the set temperature. Observe the temperature
reading on instrument schematic.

8. If using a TEC module, ensure the temperature reading has stabilized at the specified point.
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PERFORM AN ANALYSIS USING THE SOFTWARE

Unit [n] > Sample Analysis
After the sample has been properly prepared and loaded into the sample chamber, start the
analysis.

1. Select the sample file to run and clickOK. To select a different sample file, clickBrowse and
locate the correct file. If sample file parameters exist in another file, rather than re-enter them
again, clickReplace to locate and replace parameters in the current file with those of the selec-
ted file.

2. Edit or enter information for the analysis.
3. ClickReport after analysis to generate reports automatically when the analysis is complete.

On theReport Settingswindow, select the report destination. ClickOK to return to the pre-
viouswindow.

4. ClickExport after Analysis analysis to have data exported automatically after the analysis.
Or, if exporting equilibration or cycle data, data can be exported after the analysis using the
File > Export.

5. Ensure the correctChamber Insert is selected.
6. ClickStart to start the analysis. A window displays data as they are collected. A short delay is

encountered before the port status at the bottom of the window changes from the Idle state.
7. If running a FoamPyc analysis, a message displays indicating the sample should be cut.

a. Remove the sample chamber cap, then remove the cap before performing the next
step.

b. Cut the sample and return it to the cup.

Perform an Analysis using the Software
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6 Perform an Analysis

c. Remove the cap, place the cup back into the sample chamber. Replace the cap.
d. ClickOK to complete the second analysis.
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PERFORM AN ANALYSIS USING THE KEYPAD
Prerequisites:

l specify analysis and report parameters
l prepare and load sample

The prompts that display for an analysis depend on the options selected inSetup >Analysis
Parameters andReport Options; therefore, the analysismay not display all of the prompts
referenced in this procedure.

1. PressAlt + 4 to display theSample ID prompt. Enter an appropriate identification. Press .
(decimal) to insert a dash.

2. PressENTER to display theDescription prompt.

Most users display this prompt only when a keyboard is attached to the pycnometer.

3. PressENTER to display theSampleMass prompt. At theAnls DisplayMode prompt in the
Setup > Report Options chooseDensity. Enter the samplemass.

4. If an analytical balance is connected to themodule, press the appropriate button on the bal-
ance to transfer the samplemasswhile this prompt is displayed.

5. PressENTER to display theChamber Insert prompt if using an insert. PressCHOICE until
the appropriate insert is displayed, then pressENTER.

6. PressENTER to begin the analysis. Operational statusmessages display during analysis.
7. When the analysis has finished, the pycnometer beeps three times and the display returns to

theReload prompt.

Do not remove the cell chamber cap when the pycnometer is pressurized. The sample
may be discharged from the chamber.

8. Ensure the pressure reads approximately 0 (zero), then remove the cell chamber cap and
remove the sample from the chamber.

9. Replace the cell chamber cap or load another sample.

Display Text Description

Analyze Sample ID: Enter sample identification for the current analysis. Sample ID can be
up to 20 numbers and dashes. Press . (decimal) to insert a dash.

Analyze
Description Line 1:

Enter the description for the current sample. A prompt for Line 2 of the
description is displayed.

Perform an Analysis using the Software
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6 Perform an Analysis

Display Text Description

Analyze Sample Mass: Enter a value for the samplemass. Displays only whenDensity is
selected for Analysis displaymode. It does not display if Volume is
selected.

The range is 000.0000 to 10000.0000 g.

The range for the 2000 cm3 AccuPyc is 000.0000 to 25000.0000 g.

This field will also accept input from a connected analytical balance.
While this prompt is displayed, press the appropriate button on the
analytical balance to transfer themass (refer to themanufacturer’s
manual for the appropriate command).

Analyze Chamber
insert?

Select the insert to be used.

l None, 0.1 cm3 (for 1 cm3 unit)
l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

PressCHOICE until the appropriate insert is displayed orNone if an
insert is not being used.

Analyze Cup Mass? Enter themass of the sample cup.

Analyze
[ENTER] to start
[ESCAPE] to cancel

ENTER. Starts the analysis. The analysis begins and operational
statusmessages are continually displayed during analysis

ESCAPE. Cancels the analysis.

For keypad and/or keyboard functions or commands not listed in this table,
see About the Keypad on page 2 - 2.
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QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis
Use to analyze a series of samples of the same type and same analysis conditions. Sample files will
be created using default values.

Field or Button Description

Analysis Conditions Select theAnalysis Conditions file to be used for analysis. SeeAna-
lysis Conditions on page 5 - 2.

Chamber Insert Select the chamber insert size to be used in this analysis.

Export after analysis Exports reports automatically to the specified destination and in the
selected format when the analysis is complete.

Material Parameters Click to verify or change thematerial properties to be used for analysis.
SeeMaterial Parameters on page 4 - 5.

Report after analysis Generates reports automatically to the specified destination when the
analysis is complete.

Report Options Select theReport Options file to be used for analysis. SeeReport
Options on page 5 - 5.

Sample Displays the sample description specified in theSample Defaults.

Sample Cup Select the sample cup properties file to be used for analysis. See
Sample Cup on page 4 - 4.

Sample Mass Enter the samplemass.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

QuickStart Analysis Fields and Buttons Table

QuickStart Analysis
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6 Perform an Analysis

SEQUENCE ANALYSIS
Unit [n] > Sequence Analysis
Use to analyze the same sample using up to eight different sample files.

Field or Button Description

Chamber Insert Select the chamber insert to be used for analysis.

Clear Removes all entries from theSample Files list box.

Export After Analysis Exports reports automatically to the specified destination and in the
selected format when the analysis is complete.

Insert Click to browse and select a file to be added to the sequence analysis.
The selected file displays in theSample Files list box.

Pause between ana-
lyses

When usingmultiple sample files and this option is selected, the sys-
temwill return to the sample selection window after each analysis.
When the previous analysis completes, clickStart to run the next ana-
lysis. As each analysis is run, the sample file is removed from the
Samples Files list box.

Remove Select a file in theSamples Files list box then clickRemove to delete
the file from the list.

Replace Select a file in theSamples Files list box then clickReplace to sub-
stitute a sample file for the selected one.

Sequence Analysis Fields and Buttons Table
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Field or Button Description

Report After Analysis Generates reports automatically to the specified destination when the
analysis is complete.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Sequence Analysis Fields and Buttons Table (continued)

REVIEW ANALYSIS

Keypad Function

TheReview function allows review of the results of the last analysis operation. PressAlt + 5 to
review or edit analysis results. The analysis information can also be edited through the prompts. The
prompts that display during the analysis review depend on the options selected inSetup > Analysis
Parameters andReport Options.

1. PressAlt + 5 to display theSample ID prompt containing the sample identification.
2. PressENTER to display theDescription prompt containing an additional description. This

prompt typically is not used unless a keyboard is connected to the analyzer.
3. PressENTER to display theSampleMass prompt containing the sample’smass.
4. PressENTER. TheStart prompt containing the start date and time of the analysis is dis-

played.
5. PressENTER. TheEnd prompt containing the ending date and time of the analysis is dis-

played.
6. PressENTER. The first of the prompts containing data is displayed. The [n] displayed in the

example prompts represents the cycle number.
7. Continue pressingENTER to view data. PressCHOICE to exclude data from report cal-

culations. An asterisk will display indicating that it will be excluded. PressCHOICE again to
remove the asterisk.

8. PressSAVE to return to theReload prompt.
9. PressAlt + 6 to print report results.

Display Text Description

Sample ID:
(sample identification)

Identification entered for the analysis.

Sample Mass:
(mass)

Samplemass for the analysis (ifDensitywas chosen asAnalysis
displaymode).

Temperature:
(sample chamber temp)

Sample chamber temperature.

Review Analysis
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6 Perform an Analysis

Display Text Description

Start:
(time) (date)

Time and date the analysis began.

Time: HH:MM:SS

Date: DD/MM/YY
End:
(time) (date)

Time and date the analysis completed.

Time: HH:MM:SS

Date: DD/MM/YY
Dn[n] = (density)
Dv[n] = (deviation)

or

V[n] = (volume)
Dv[n] = (deviation)

Density or Volume (depending on the selectionmade for Analysis
displaymode).

[n]: cycle number.

PressCHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk indicates that it has been excluded.
PressCHOICE again to remove the asterisk. Each timeCHOICE is
pressed to exclude (or include) the value, a new deviation is calculated
and displayed.

PressSAVE to return to theReload prompt. PressSAVE to
automatically recalculate the collected data and update data reduction
messages in the queue.

For keypad and/or keyboard functions or commands not listed in this table,
see About the Keypad on page 2 - 2.
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7 ABOUT REPORTS
Review this section for information on theReportsmenu options aswell as customizing and running
reports.

Reports can be generated for data:

l collected on a sample that has completed analysis
l collected on a sample currently being analyzed

OPEN AND CLOSE REPORTS
Reports > Open Report. > [.REP File]

Reports > Close Reports

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
eitherComplete or Analyzing.

7 About Reports
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7 About Reports

SPC REPORT
Reports > SPC Report Options
Use to generate reports with variousSPC (Statistical ProcessControl) options. All selected
variablesmust be computed for each sample file used in an SPC report; therefore, it is more efficient
to select only the necessary variables.

The selected items display as graph variable selections in Reports > Regression Report and
graph selections inReports > Control Chart. If additional report options are required, clickMore.
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REGRESSION REPORT
Reports > Regression Report
Use to generate a Statistical ProcessControl (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

Field or Button Description

Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in the
sample files.

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application.

When this option is selected, thismessage displays:

Regression Report Fields and Buttons Table

Regression Report
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7 About Reports

Field or Button Description
Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] Click to save selected report options as default report settings.

Show graphic
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X- and Y-Axis Variable
[drop-down box]

Use to designate the x- and y-axes variables. The variables in the
drop-down lists are those selected in theReports > SPC Report
Optionswindow. Use these options to plot the regression of up to
three y-axis variables against the x-axis variable.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Regression Report Fields and Buttons Table (continued)
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CONTROL CHART REPORT
Reports > Control Chart
Generates a Statistical ProcessControl (SPC) control chart report which plots the changes in a
statistic.

Field or Button Description

Graph [n] [button] Defines the y-axis of each graph.

Statistic. Displays the SPC variables selected on theReports >
SPC Report Optionswindow. The selected variable will be plotted
against time. This selection also becomes the y-axis label.

Autoscale.Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To fields.

Center Line.Displays placement options for the center line in the
graph. ChooseEntered to specify placement of the line.

Limit Lines group box. Displays limiting lines options. Lines can be
placed at somemultiple of the standard deviation or at specified
positions (Entered). WhenEntered is selected, enter theHigh limit and
Low limit fields with appropriate values.

Control Chart Fields and Buttons Table

Control Chart Report
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7 About Reports

Field or Button Description

Recalculate archived
SPC results [check box]

Use to have archived SPC values recalculated ensuring any changes
made to the SPC Report Options are included in the new report. This
option lengthens the time required to generate the report.

If this recalculation option is enabled and sample files from
an earlier application version are selected, it is recom-
mended that copies of the archived sample files be used
rather than the original. Selecting this option will make
some archived sample files unreadable by the original
application.

When this option is selected, thismessage displays:

Saving the recalculated SPC data may render some files
unreadable by the original application. Saving the SPC
data speeds up future SPC reports.

IfDo not show me thismessage again is selected, themes-
sage cannot be redisplayed without Micromeritics assist-
ance.

The first time this option is used, the time it takes to generate the report
is lengthened. The second time the report is generated, if using the
same sample files used in the initial calculation, it is recommended that
this option not be selected since the data was recalculated previously.
If a sample file is added or removed from the report after the initial
recalculation, this option should be selected again to ensure the data
from the newly added or removed sample file is recalculated.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Show graphic
[check box]

Use to show a graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Show report title
[check box]

Select and enter a report title to appear on the report header.

Tabular report
[check box]

Generates a tabular report of the included samples. A tabular report
contains the numeric values contributed by each sample.

X Axis Order by Select the order in which x-axis statistics are placed. Sort by: 

Control Chart Fields and Buttons Table (continued)
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Field or Button Description

[group box]
Time. Time the files were analyzed.

File name. Alphanumeric order.

Date. Date the files were analyzed.

Minutes.Minutes elapsed from the first file placed on the list, which is
the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Control Chart Fields and Buttons Table (continued)

Control Chart Report
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7 About Reports

REPORT FEATURES AND SHORTCUTS
Reports can be customized andmanipulated using the toolbar, shortcut menus, the zoom feature, or
axis cross-hairs.

l After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
l The report zoom feature provides the viewing of fine graph details and the ability to shift the axes.
l All reports contain a header displaying file statistics.

If configured, the report header can also contain a graphic and/or a title.

l Tabular and graphical reports contain sample and analyzer statistics such as analysis date / time,
analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information as tabular and graphical reports with the
exception of notes.
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REPORT HEADER SHORTCUTS
Display header shortcuts by right clicking in the report header.

If configured, the report header can also contain a graphic and a title.

l Tabular and graphical reports contain sample and instrument statistics— such as analysis date,
analysis time, analysis conditions, etc.

l The headers contain notes of sample file changes occurring after analysis.
l Summary report headers contain the same information in tabular and graphical reports with the
exception of notes.

Field or Button Description

Copy header as text Use to copy the report header as text. Text is copied to the clipboard
and then can be pasted into other documents.

Edit Use to edit the report title and/or graphic in the report header.

Report header Shortcut Field and Button Table

Report Features and Shortcuts
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7 About Reports

REPORT TOOLBAR
TheReportwindow has a toolbar on the right portion of the window and selectable tabs at the top of
the report header. To view a specific report, either select the tab or the report in theReports list box,
then clickShow.

Field or Button Description

Default Style [button] Specify default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in theReports list box. Deleted reports will
have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in theReports list box.

Print [button] Displays thePrintwindow for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hidden
using theHide button.

Show [button] Displays the selected or hidden report in theReports list box.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Report Toolbar Fields and Buttons Table
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TABULAR REPORT FEATURES AND SHORTCUTS
Display tabular report shortcuts by right clicking in the body of the tabular report. Column shortcuts
require right clicking on the column to bemodified.

Field or Button Description

Align column Select to change the column alignment to either left, right, or centered.

Copy table as text Use to copy the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.

Edit title Use to edit the report title and/or title font attributes. ClickFont to
modify font attributes.

Move column Right click the column to bemoved. SelectMove column on the short-
cut menu and select Left orRight for themove.

Rename column Right click the column to be renamed. SelectRename column on the
shortcut menu and enter the new column name.

Resize column Right click the column to be resized. SelectResize column on the short-
cut menu and enter the new columnwidth in inches.

Show column Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font Right click in the report data. Select Table data font on the shortcut
menu.

Table header font Right click in the report data. Select Table header font on the shortcut
menu.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Tabular Reports Shortcut Options and Descriptions Table

Report Features and Shortcuts

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 7 - 11



7 About Reports

GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right clicking in the body of the graph report.

Field or Button Description

Autoscale Returns the report to full view after using the zoom feature.

Copy as Metafile Copies the report data as ametafile (.WMF) .

Copy as Text Copies the report data to the clipboard. It can then be pasted into other
software programs as tab-delimited columns or copied as an overlay
onto another graph.

Edit axis Use to edit the selected axis properties.

Autoscale minimum / maximum. Tomanually specifyminimum /
maximumautoscale, deselect the option and enter the new amount in
the text box.

Graph Shortcuts Options and Description Table
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Field or Button Description
Grid lines.Use to change how to displaymajor / minor grid lines.

Invert scale. Use to invert the scale.

Linear / Logarithmic.Select the option to scale the graph as linear or
logarithmic.

Scale font. Use tomodify the font for the scale label. DeselectUse
default font to enable font options.

Title.Use to edit the selected axis label.

Title font.Use tomodify the font for the selected axis label. Deselect
Use default font . Select new font attributes for report data. Enable
Use default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Color.Click to change the curve color.

l Curve group box.Use to change the interpolation, point style and
pen style for the selected curve. These options are disabled ifUse
default fill style is selected in theHistogram group box.

l Histogram group box.Enabled only ifHistogram is selected in
theStyle drop-down list. Use to specify the type of fill, fill color and
label position for the selected curve.

Label.Select where the graph point labels will display (left, right,
center, etc.) on the SPC report.

Style.Use to select another style for the collected data curve.

Title. Use to change the title of the selected curve.

Use default thickness.Uses the default curve thickness. Deselect to

Graph Shortcuts Options and Description Table (continued)

Graph Features and Shortcuts
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7 About Reports

Field or Button Description
enter a new thickness number in the Thickness text box.

Edit legend Use to change the legend location and font. ClickFont to modify font
attributes. Deselect Use default font . Select new font attributes for
report data. EnableUse default font to reset default fonts.

Edit title Use to change the graph title and font. ClickFont to font attributes.
Deselect Use default font . Select new font attributes for report data.
EnableUse default font to reset default fonts.

Hide curve Hides selected curve.

Redraw Sets the axis boundaries to the original view. This option also removes
cross-hairs.

Show curve Displays a list of all curves. Select the curve to display.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Graph Shortcuts Options and Description Table (continued)
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AXIS CROSS-HAIR
Left click on the graph to view the cross-hair coordinates.

Graph Features and Shortcuts
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7 About Reports

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. Thismenu option is not available if usingRestricted
option presentation.

Field or Button Description

Grid Line Styles
[selection]

Select if themajor and/or minor grid lines should appear as solid or dot-
ted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the logarithmic
and linear scales. Deselect this option to remove the grid lines.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Graph Grid Lines Fields and Buttons Table

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A boxwill display in the area to be enlarged.
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GRAPH AND SAMPLE OVERLAYS

Use the graph overlay functions to comparemultiple graph options. Graphical lines are differentiated
by the use of varying colored symbols outlined on a legend. Overlaysmay be generated in two ways:

l Multiple Graph Overlays.Overlay two different types of graphs from one sample.
l Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when usingAdvanced option presentation. Go toOptions
> Option Presentation > Advanced.

GENERATE MULTIPLE GRAPH OVERLAYS

1. Go toOptions > Option Presentation and ensure there is a checkmark to the left of
Advanced.

2. Go to File > Open > Sample Information and open the sample file.
3. On theReport Options tab, in theSelected Reports list box, highlight the graph to be used for

multiple overlays, then clickEdit.

4. Click the down arrow to the right of theOverlay field and select a graph. This selection will over-
lay the graph selected in theY-axis field.

Graph and Sample Overlays
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7 About Reports

5. ClickOK then clickSave.
6. Go toReports > Start Report. Select the report destination in theSettings group box. Select

the overlay file name in the Files list box, then clickOK.
7. In the pop-upSelected Reports list box, reports can be added or removed by double clicking

the entry. Selected reports as indicated by a checkmark to the left. ClickOK.
8. Reports display in a tabbed format. Click each tab to view each report.

GENERATE MULTIPLE SAMPLE OVERLAYS

Use a copy of a file rather than the original file when performing a sample overlay.

1. Go toOptions > Option Presentation and ensure there is a checkmark to the left of
Advanced.

2. Go to File > Open > Sample Information and open the sample file.
3. On theReport Options tab, in theSelected Reports list box, select the reports to be used by

double clicking the report name. This places a checkmark to the left of each selected report.
4. Highlight the graph to be used for multiple overlays, then clickEdit.

5. On the overlay window, click the down arrow to the right of theOverlay field and select the
Overlay SamplesSelect other options as needed, then ClickOK.

6. In theReport Options tab, clickOverlays.
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7. Om theGraphOverlayswindow, clickBrowse to locate and select which graphs are to be
overlaid. ClickOK.

8. Go toReports > Start Report. Select the report destination in theSettings group box. Select
the overlay file name in the Files list box, then clickOK.

9. In the pop-upSelected Reports list box, reports can be added or removed by double clicking
the entry. Selected reports as indicated by a checkmark to the left. ClickOK.

10. Reports display in a tabbed format. Click each tab to view each report.

GenerateMultiple Sample Overlays
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7 About Reports

REPORT EXAMPLES

COMBINED REPORT
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SUMMARY REPORT

SummaryReport
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7 About Reports

TABULAR REPORT
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GRAPH REPORT

Graph Report
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7 About Reports

OVERLAY REPORT
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EQUILIBRATION REPORT

Equilibration Report
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7 About Reports

SAMPLE LOG REPORT
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8 SELECTED REPORTS

COMBINED REPORT

TheCombined Reports option creates a single report from all selected reports. TheCombined
Report contains no breaks between reports and no headings. Highlight the report, then clickEdit to
edit report details.

DENSITY AND VOLUME TABLE

Field or Button Description

Columns 1 though 7
[drop-down box]

Select a variable for each column.

Name [text box] Enter the name of the report.

Summary Data
[group box]

Select the average, standard deviation, and coefficient of variation
(C.V.) for report parameters.

Density and Volume Fields and Buttons Table

8 Selected Reports
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8 Selected Reports

Field or Button Description

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Density and Volume Fields and Buttons Table (continued)

DENSITY VS CYCLE NUMBER TREND PLOT

There are four types of graphical reports available. Report titles are based on the parameters
selected for the X-axis and Y-axis.

Field or Button Description

Autoscale x-axis
Autoscale y-axis
[check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically.Autoscalemeans that the x- and
y- rangeswill be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Overlay [drop-down box] Select overlay plot options.

l A second Y-axis can be selected to overlay with the variable in the
Y-Axis field, or

l SelectOverlay Samples to overlay data of the type selected in the
Y-Axis field with the same type of data contained in other sample
files. To select other sample files, go to theReport Options tab and
click theOverlays button.

Density vs Cycle Number Trend Plot Fields and Buttons Table
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Field or Button Description

Plot curve
Plot points
[check box]

Select to display how data are plotted.

Show +/-
[check box]

Select to place two horizontal lines on the graph. The top line will be
placed at a point relative to the average and standard deviation of the
data. The bottom line will be placed at the point entered in the adjacent
field.

Show Average
[check box]

Select to show the average of all cycles. A horizontal line is placed at
the average point for the cycles.

Show Min
Show Max
[check box]

Select to show the average of all cycles. Horizontal lines are placed at
the entered limits.

Show Reference
[check box]

Select to show a horizontal line placed at a reference point specified in
the adjacent field.

X-Axis [check box] Variables available for the X-axis.

Y-Axis [check box] Variables available for the Y-axis.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Density vs Cycle Number Trend Plot Fields and Buttons Table (continued)

DENSITY VS TIME TREND PLOT

TheDensity vs Cycle Number Trend Plot and theVolume vsCycle Number are identical unless
otherwise noted. SeeDensity vs Cycle Number Trend Plot on the previous page.

Density vs Time Trend Plot
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8 Selected Reports

EQUILIBRATION REPORT

This report is available only if theRecord equilibration data option was selected on theAnalysis
Conditions tab.

Field or Button Description

Autoscale x-axis
Autoscale y-axis
[check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically.Autoscalemeans that the x- and
y- rangeswill be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

From cycle [text box] Enter the beginning report cycle.

Report every
[text box]

Enter which cycle to report.

Overlay cycles
[check box]

Select to overlay the number of cycles entered in theReport total of
field.

Overlay samples
[check box]

Select to overlay the last cycle in the current file with the last cycle con-
tained in other files. ClickOverlays on theReport Options tab to select
the other sample files.

Plot curve
Plot points
[check box]

Select to display how data are plotted.

Report quantity
[drop-down box]

Select a variable to be reported.

Report total of [text box] Enter the number of cycles for this report. Enter up to 8 cycles.

Report every
[text box]

Enter time between cycles. Up to 60 seconds can be entered.

Equilibration Report Fields and Buttons Table
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Field or Button Description

Show plot [check box] Generates a plot (graph) for theReport quantity field selection.

Show table [check box] Generates a tabular report for theReport quantity field selection.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Equilibration Report Fields and Buttons Table (continued)

OPTIONS REPORT
TheOptions report provides information on the sample, itsmaterial properties, and analysis
conditions. This report cannot be edited.

PRESSURE AND VOLUME TABLE

ThePressure and Volume Table and theDensity and Volume Table are identical unless otherwise
noted. SeeDensity and Volume Table on page 8 - 1.

OptionsReport
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8 Selected Reports

SAMPLE LOG REPORT
The Sample Log report displays:

l Automatic operations
l Information entered usingAdd Log Entry on theSample Information tab
l Warnings and/or errors which occurred during analysis

TheSample Log Report cannot be edited.

SUMMARY REPORT

TheSummaryReport provides a condensed listing of data results. Select the type of information to
include in the report. If Pass/Fail is selected, theMin andMax fields are enabled. Enter theminimum
andmaximum values for the pass / fail.
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TABULAR REPORT

Field or Button Description

Columns 1 through 7
[drop-down box]

Select a variable to appear in each column.

Selections applicable only to the Asphalt configuration:

l Volume (60 °F)
l Density (60 °F)
l Specific Gravity (60 °F)
l Volume (60 °F) Deviation
l Density (60 °F) Deviation
l Specific Gravity (60 °F) Deviation

Name [text box] Enter a name for the report.

Summary Data
[group box]

Select options for reporting the average, standard deviation, and coef-
ficient of variation (C.V.).

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Tabular Report Fields and Buttons Table

Tabular Report
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8 Selected Reports

TOTAL PORE VOLUME VS TEMPERATURE

The Total Pore Volume vs Temperature and theDensity vs Cycle Number Trend Plot are identical
unless otherwise noted. SeeDensity vs Cycle Number Trend Plot on page 8 - 2.

VOLUME VS CYCLE NUMBER TREND PLOT

TheVolume vsCycle Number and theDensity vs Cycle Number Trend Plot are identical unless
otherwise noted. SeeDensity vs Cycle Number Trend Plot on page 8 - 2.
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9 DIAGNOSTICS USING THE SOFTWARE

Unit [n] > Diagnostics
Performs a leak test for the analysismodule.

Field or Button Description

File name [text box] Shows a status bar of steps complete once the test begins.

Next [button] Starts the next test.

Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Sequence Sequence number assigned to the test.

Test [drop-down box] Select the appropriate test from the drop-down list.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Diagnostic Test Fields and Buttons Table

9 Diagnostics using the Software
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10 ABOUT CALIBRATION
The pycnometer volume should be calibrated every time it is restarted. Cell volume and expansion
volume in the set up parameters are updated automatically upon calibration. Run an analysis with an
empty cup to see how close the average volume is to 0. It should be ±0.05% of full scale. If it is not
within ±0.05% of full scale, calibration is required.

If calibrating using the keypad, seeCalibrate using the Keypad on page 10 - 12.

CALIBRATE USING THE SOFTWARE

CALIBRATION REPORT

Unit [n] > Calibration > Calibration Report

1. Select the type of chamber insert used.
2. Select the report destination.
3. ClickOK to generate the report.

10 About Calibration
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10 About Calibration

CALIBRATE TEMPERATURE OFFSET

Unit [n] > Calibration > Temperature
Opens theCalibrate Temperature Offset box.

Calibrates the temperature offset. Use an external reference device to determine the sample cell
temperature. Enter the value in the field, then clickDone.

A Calibration report is not generated for the temperature offset. The entry is recorded in the
Instrument Log. To view the log, go toUnit [n] > Show Instrument Log.

1. Enter the current sample cell temperature.
2. ClickDone. Temperature reading will be adjusted to the entered temperature.
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CALIBRATE ZERO CELL VOLUME

Unit [n] > Calibration > Zero Cell Volume
Use to calibrate the cell volume offset.

Field or Button Description

Analysis Conditions Specify conditions for the calibration.

ClickReplace to replace the valueswith those from an existing
Analysis Conditions file. SeeAnalysis Conditions on page 5 - 2.

Cell Volume Current cell volume (without an insert) or the volume of the selected
insert.

Expansion Volume Current expansion volume, and the date and time of calibration.

Insert
1 cm3 unit

l None
l 0.1 cm3

IfNone is selected, place an empty sample cup in the chamber.

Calibrate Zero Cell Volume
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10 About Calibration

Field or Button Description

Insert
10 cm3 unit

l None
l 3.5 cm3

IfNone is selected, place an empty sample cup in the chamber.
Insert
1.0 cm3and 100 cm3

unit

l None
l 35 cm3

l 10 cm3

IfNone is selected, place an empty sample cup in the chamber.
Insert
350 cm3 and 2000 cm3

units

l None
l Large
l Small

IfNone is selected, place an empty sample cup in the chamber.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

CALIBRATE ZERO PRESSURE

Unit [n] > Calibration > Zero Pressure
This option zeros the pressure transducer reading.

ClickStart to calibrate the pressure offset.
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RESET PRESSURE CALIBRATION

Unit [n] > Calibration > Reset Pressure Calibration
This procedure resets the pressure calibration to the factory default settings.

This option can be used when the pressure appears not to be reported correctly by the analyzer. For
example: a zero, negative, or unreasonably high reading is being consistently reported. Resetting to
nominal may restore normal pressure readings but a proper calibration should be performed.

A popup warning indicates that when this option is used, the previous pressure calibration is lost and
the nominal calibration is used.

Temperature and volume calibrations are not affected by a reset of the pressure cal-
ibration.

ClickOK. The nominal calibrationsmay be sufficient. However, it is recommended to contact your
Micromeritics Service Representative and schedule a proper pressure calibration as soon as
possible since data accuracymay be compromised.

Reset Pressure Calibration
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10 About Calibration

CALIBRATE VOLUME SCALE

Unit [n] > Calibration > Calibrate Volume
Calibrates the cell volume offset and expansion volume.

Although the instrument is calibrated prior to shipment, the pycnometer should be recalibrated to
laboratory atmospheric and environmental conditions.

1. On the pressure regulator, turn the pressure control knob clockwise to set the regulator pres-
sure at 21.500 psig (low pressure gauge). For a High Pressure sample chamber con-
figuration, set regulator pressure 20 psi above cycle and fill pressure.

2. Remove the chamber cap and place an empty cup into the sample chamber, then replace the
cap. If an insert is being used, place the insert sample cup into the chamber.

Wear latex or nitrile, powder-free gloves to prevent transfer of oil from handswhen
handling sample cups, calibration standards, and inserts. SeeHandling System
Components on page J - 1.

3. Go toUnit [n] > Calibration > Calibrate Volume.
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4. Enter the volume of the calibration standard (located on the outside of the calibration stand-
ards case shipped with the instrument) in theVolume of Calibration Standard field.

The value recorded on the case for a 10 cm3 pycnometer is the sum of the two standards, and
on a 350 cm3 pycnometer, the sum of the three standards.

5. Select theMeasured option.
6. ClickAnalysis Conditions to specify calibration parameters. ClickReplace and select the

file calstd.anc. The values in the current file will be replaced with those contained in the selec-
ted file. ClickOK, then clickOK again to return to theCalibrate Volume Scalewindow.

7. ClickStart to begin the first phase of the calibration (volume offset). Statusmessages display
until this phase is complete. When the phase has finished, a prompt display indicates to insert
the calibration standard.

8. Remove the sample chamber cap, then remove the sample cup from the chamber. Place the
cap back onto the chamber while placing the standard into the cup.

9. Tilt the sample cup and allow the standard to roll gently into the cup to prevent denting of the
cup.

Calibrate Volume Scale
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10 About Calibration

l one standard is shipped with the 1-, 100-, and 2000 cm3 pycnometers
l two are shipped with the 10 cm3 pycnometer
l three are shipped with the 350 cm3 pycnometer

10. Remove the sample chamber cap, place the sample cup back into the chamber, and replace
the cap. Turn the cap clockwise to tighten.

11. Allow the standards to reach thermal equilibriumwith the pycnometer.

l Wait 10minutes for 1- and 10 cm3 pycnometer
l Wait 15minutes for the 100 cm3 pycnometer
l Wait 20minutes for the 350 cm3 pycnometer
l 30minutes for the 2000 cm3 pycnometer

12. ClickContinue to complete the second phase of the calibration (volume scale). Statusmes-
sages display until the calibration is complete.

13. ClickDone to accept the new values, then clickOK.
14. Do not remove the standard from the sample chamber until the operation is verified. See

Verify Operation on page 10 - 10.

Field or Button Description

Analysis Conditions Specify conditions for the calibration.

Calibrate Volume Scale Fields and Buttons Table
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Field or Button Description
ClickReplace to replace the valueswith those from an existing
Analysis Conditions file.

Cell Volume
[group box]

Displays the current cell volume (without an insert), or the volume of
the selected insert.

Continue [button] Place the standard into the sample cup and clickContinue to com-
plete the volume scale calibration.

Expansion Volume
[group box]

Displays the current expansion volume, and the date and time of cal-
ibration.

Insert [group box] l 1 cm3 unit None, 0.1 cm3

l 10 cm3 unit None, 3.5 cm3

l 1.0 cm3100 cm3 unit None, 35 cm3, 10 cm3

l 350 cm3 and 2000 cm3 units None, Large, Small

IfNone is selected, pace an empty sample cup in the chamber.
Previous / Entered /
Measured
[check box]

Select themethod for calibrating the cell and expansion volumes.

Previous. Uses the current values.

Entered. Enables the fields for the cell and expansion volumes.

Measured. Measure the cell and expansion volumes using a
reference standard.

Start [button] Begins the first segment of the volume offset calibration. Statusmes-
sages are shown as the calibration proceeds.When the volume offset
calibration is complete, a prompt displays indicating to insert the stand-
ard.

Volume of Calibration
Standard [text box]

The volume of the standard used for the previous calibration.

For fields and buttons not listed in this table, see Common Fields and But-
tons on page 3 - 2.

Calibrate Volume Scale Fields and Buttons Table (continued)

Calibrate Volume Scale
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10 About Calibration

VERIFY OPERATION

Verify operation of the pycnometer by performing an analysis on the calibration standard to ensure
that the pycnometer is operating properly.

1. Go toUnit [n] > Sample Analysis.
2. ClickOK, thenYes to create a new sample file.
3. ClickReplace and select the refanly.smp file. The values in the current file will be replaced

with those contained in refanly.smp. ClickOK.

4. ClickReport After Analysis. Select theReport after analysis option, then clickOK.

5. ClickStart to begin the analysis.
6. Compare the value displayed for the average volume to the value recorded on the calibration

standards case. These two values should agree plus or minus the tolerance obtained using
the following calculation:
Tolerance = (chamber volume * 0.0003) + (Value recorded on Standards case * 0.0003)
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Example: calculate the tolerance for a 10 cm3 pycnometer with a value of 6.372242
recorded on the case as :
Tolerance = (10 * 0.0003) + (6.372242 * 0.0003) = 0.003 + 0.0019116726 = 0.005

If the values do not agree, a leakmay be indicated. Check the system for leaks. Then repeat
steps 1 through 6. If the values continue to disagree, contact your Micromeritics service
representative. SeeDiagnostics using the Software on page 9 - 1.

7. Remove the standards and place them back into the case.

LOAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved usingUnit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration file,
a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten each
time a new one is created.

Changing the calibrationmay affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded usingUnit
[n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be changed.
The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 is the analyzer serial number
2013-04-25 is the date the calibration file was saved
.CAL is the file name extension

Load Calibration from File

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 10 - 11



10 About Calibration

CALIBRATE USING THE KEYPAD

CALIBRATE FUNCTION

This command performs a full volume slope and offset calibration. PressALT + . (decimal) to
access theCalibrate function.

Display Text Description

Calibration Type?
Volume

PressCHOICE until the option is displayed, then pressENTER.

l Volume
l Temperature
l Pressure
l Copy to an external device
l Load from an external device
l Reset Pressure Calibration

CALIBRATION DATA

Display Text Description

Setup Type?
Calibration Data

PressCHOICE untilCalibration Data is displayed, then pressENTER.

Calibration Data
Chamber Insert?

SelectYes at theRequest insert prompt inReport Options. Press
CHOICE until the appropriate insert is displayed, then pressENTER.

l None, 0.1 cm3 (for 1 cm3 unit)
l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Calibration Data
Cell Volume:

Displays the cell volume determined during calibration Cell volumes
can also be entered at this prompt. PressENTER.

The range is 0.01 to 999.0000 cm3.
Calibration Data
Expansion Volume:

Displays the expansion volume determined during calibration. Press
ENTER.

The range is 0.5 to 999.0000 cm3.
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CALIBRATE VOLUME

Place an empty cup into the sample chamber forCal1 (volume offset). If using an insert, place the
insert and its appropriate sample cup into the sample chamber.

Display Text Description

Calibration Type?
Volume

PressENTER to acceptVolume (default) and display the next prompt.

Calibrate Volume
Chamber insert?

Press CHOICE until the appropriate insert is displayed, then press
ENTER. Yesmust be selected for theRequest Insert prompt in
Report Options for this prompt to display.

l None, 0.1 cm3 (for 1 cm3 unit)
l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Calibrate Volume
Volume of Cal Std:

Enter the volume of the calibration standard to be used in the
calibration (located on the outside of the calibration standards case).
Some pycnometers require and are shipped with multiple standards.
In this instance, the value recorded on the case is the sum for all
standards and is the one that should be entered at the prompt. Press
ENTER.

The range is 0.1 to 999.0000 cm3.
Calibrate Volume
[ENTER

Press ENTER to begin the calibration orAlt + CLEAR to cancel. The
volume offset is calibrated first (Cal1). When the first calibration is com-
plete, the pycnometer beeps three times and the next prompt is dis-
played.

Insert Cal Std
[ENTER] to start

Place the calibration standard in the cup in the sample cell chamber
and replace the chamber cap. PressENTER to calibrate the
temperature offset (Cal2). Calibration continues and operational
statusmessages are continually displayed. After the operation is
complete, the pycnometer returns to theReload prompt.

For best results, sample volume should be approximately equal to the
volume of the calibration standard. Therefore, if calibrating the 10 cm3

pycnometer for use with smaller sample volumes, use only one
standard. If using one standard, enter half of the value at theVolume of
cal std prompt. PressAlt + CLEAR to cancel the operation.

Calibrate Volume
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10 About Calibration

RESET PRESSURE CALIBRATION

Contact aMicromeritics service representative and schedule a proper pressure cal-
ibration since data accuracymay be compromised.

This option can be used when the pressure is suspected of not being reported correctly by the
analyzer. For example: a zero, negative, or unreasonably high reading is being consistently
reported. Resetting to nominal may restore normal pressure readings but a proper calibration should
be performed.

Display Text Description

Calibration Type?
Reset Pressure Cal

PressCHOICE until the desired option is displayed, then press
ENTER.

Reset Pressure cal?
[Yes / No]

Resets the pressure calibration to nominal values. Temperature and
volume calibrations are not affected. Nominal valuesmay be sufficient.
Schedule a proper pressure calibration as soon as possible, then
pressCHOICE.

SelectYes to reset the calibration to nominal values. PressENTER.

SelectNo to contact your service representative to schedule a proper
pressure calibration. PressENTER.
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REVIEW CALIBRATION

TheReview function reviews the results of the last calibration operation.

The sample cell volume and the expansion cell volume are used for calculating the sample volume.
The cell volume and expansion volume are updated automatically when the pycnometer is
calibrated.

The prompts that display during a review of calibration data depend on the options specified inSetup
> Analysis Parameters andReport Options.

1. PressAlt + 5 to display theChamber Insert prompt fromwhich the insert can be selected (if
used).

2. PressENTER to display the volume of the calibration standard. This volume can be edited
from this prompt.

3. PressENTER to display theWhich Chamber prompt.
4. PressCHOICE to select whether to view the results for the sample chamber or the expansion

chamber.
5. PressENTER to display a prompt showing the starting time and date.
6. PressENTER to display a prompt showing the ending time and date.
7. PressENTER to display the first of the prompts containing data. The [n] in this example rep-

resents the cycle number.

8. Continue pressingENTER to view all of the data. PressCHOICE to exclude data from report
calculations. An asterisk will display indicating that it will be excluded.

9. PressSAVE to return to theReload prompt
10. PressAlt + 6 to print report results.

Display Text Description

Chamber insert?
(insert)

Displays the insert selected for the calibration orNone if an insert was
not used. If the selection is incorrect, pressCHOICE until the correct
one is shown, then pressENTER.

l None, 0.1 cm3 (for 1 cm3 unit)
l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Review Calibration
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10 About Calibration

Display Text Description

Volume of Cal Std:
(volume)

Displays the volume of the calibration standard that was used for the
calibration. PressENTER.

Which Chamber?
(chamber type)

Select to view calibration data for the sample cell chamber or the
expansion chamber. PressCHOICE until the chamber is displayed,
then pressENTER.

The chamber type options areCell volume andExpansion volume.
Start:
(time) (date)

Displays the time and date the calibration began. PressENTER.

Time: HH:MM:SS
Date: DD/MM/YY

End:
(time) (date)

Displays the time and date the calibration completed. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

Cell[n] = (volume)
Dv[n] = (deviations)

or

Exp[n] = (volume)
Dv[n] = (deviations)

Displays theVolume, depending on the chamber type selected (Cell
volume or Expansion volume).

[n] represents the cycle number.

PressCHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk next to the density indicates it has
been excluded. PressCHOICE again to remove the asterisk and have
it included.

Each timeCHOICE is pressed to exclude or include the value. A new
deviation is calculated and displayed.

Press ENTER to view the values for the next cycle.

PressSAVE to return to theReload prompt. PressSAVE to
automatically recalculate collected data and add all data reduction
messages back into the queue.
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TEMPERATURE

This operation typically is performed by aMicromeritics service representative.

PressAlt + ., then pressCHOICE until Temperature is displayed.

Display Text Description

Calibrate Temperature
Temperature:

Enter the temperature obtained from a reference temperature sensor.
PressENTER to automatically return to theReload prompt. PressALT
+ CLEAR to cancel the operation.

ZERO THE PRESSURE TRANSDUCER & CHAMBER VOLUME

The pressure transducer zeroes automatically before each cycle in an analysis or calibration;
therefore, it is not necessary to zero the unit for these operations. Typically, this function is not
required unlessmanually performing analyses for an extended period of time.

PressAlt + 0 to access the Zero function.

Display Text Description

Zero Type?
Pressure

Allows zeroing of the pressure transducer or the volume offset. Press
CHOICE until the option is displayed, then pressENTER. If choosing
Pressure, the next prompt is not displayed. Choices arePressure and
Volume. Ensure the sample chamber is empty if selectingVolume.

Zero Volume?
Chamber insert?
None

Does not display for
Pressure

DisplayswhenVolume is selected. SelectYes at theRequest insert
prompt inReport Options. PressCHOICE until the appropriate insert is
displayed, then pressENTER.

l None, 0.1 cm3 (for 1 cm3 unit)
l None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
l None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
l None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Zero Volume
[ENTER] to start
[ESCAPE] to cancel

or

Zero Pressure
[ENTER] to start
[ESCAPE] to cancel

PressENTER to begin the zero operation or Alt + CLEAR to cancel
the operation.

If zeroing theVolume, the purges and cycles specified in the current
analysis parameters are used to calculate the volume offset.

After the operation is complete, the pycnometer returns to theReload
prompt.

Temperature
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10 About Calibration

LOAD CALIBRATION DATA FROM A USB STICK

Display Text Description

Calibration Type?
Load from USB Stick

PressCHOICE until the option is displayed. PressENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. PressENTER.

Local cal for SN: Key in the serial number. PressENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USB stick. The system automatically returns to the
Reload prompt. This prompt appears immediately after theCalibration
for SN prompt.

COPY CALIBRATION DATA TO A USB STICK

Display Text Description

Calibration Type?
Copy to USB Stick

PressCHOICE until the option is displayed. PressENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of the
unit. Wait a few seconds, then pressENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USB stick. The theReload prompt displays. This prompt
appears immediately after theCalibration for SN prompt.
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11 HARDWARE

ADD ANALYSIS MODULE TO CONTROL MODULE

Additional analysismodules provide the ability to increase productivity and/or provide ameans for
analyzing different size samples concurrently. Multiple analysismodules can be connected to an
integrated controller / analysismodule.

If connecting to a temperature controlled unit, seeAdd Analysis Modules to a Temperature
Controlled Module on page H - 2.

Component Description

A Separate power cord for external power supply. Connect cable to wall outlet.

B External power supply

C Hardwired 8-pin mini-DIN power cable for external power supply.

D 8 pinmini DIN cable.

E Power adapter DIN port.

F Power adapter.

G Module Connection - 8-pin mini-DIN OUT port to connect next analysismodule.

H Module Connection - 8-pin mini-DIN IN port to connect the control module or pre-
viously connected analysismodule (not shown).

I Hardwired power mini-DIN cable for power adapter.

Diagram Components

11 Hardware
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11 Hardware

Exit the application before powering off the analyzer.

If installing an external TEC module, it is suggested that the TEC system be installed
first, to allow time for temperature to stabilize at the desired temperature, while the
AccuPyc is being installed. The TEC module has a separate power cord and external
power supply.

1. Power OFF the control module.
2. Connect one external power supply cable to the back of the new unit and another external

power supply cable to each power adapter.
3. Connect a power cable to each external power supply.
4. Attach one end of the DIN cable (provided in themodule accessories kit) to the connector

labeledModule Connection on the back of the new unit.
5. Attach the other end of the DIN cable to the separate power adapter.
6. Attach the hardwired power adapter cable to the lower connector labeledModule Connection

on the back of the analysismodule.
7. Plug the external power supply cables into electrical wall outlets.
8. Power ON the control module. If running the application software, start the application.
9. Verify the unit is recognized:

l If running the application software,Unit
[n]menus are added to themenu bar
for each analysismodule connected.

l If using the keypad for analysis, press
Alt + CHOICE + 2 to access the addi-
tional analysismodule.Unit [n] appears
in the upper left corner of the display.

10. Calibrate the pycnometer. SeeCalibrate using the Keypad on page 10 - 12 orCalibrate
using the Software on page 10 - 1.
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ANALYTICAL BALANCE
The analytical balance tested byMicromeritics is Scientec®model #ZSA120.

An analytical balance can be connected to a serial port on the computer and used to transfer the
sample’smass via a third-party software directly to the AccuPyc II application. Refer to the balance
manufacturer’s operator’smanual for transmission instructions.

1. Connect the analytical balance to the RS-232 port on the rear panel of the analyzer.
2. Go toOptions > Configure Balance to connect and set up an RS-232 balance to the ana-

lyzer.

Field or Button Description

Enable / Disable Select to enable or disable the attached balance.

Serial Parameter Used to set the baud rate, parity, data bits, and stop bits. This field
should not requiremodification from the default values.

Serial Port Select which serial port is used to connect the balance to the analyzer.

Configure Balance Fields and Buttons Table

PRINTER SETUP
If using the Keypad only, seePrinter Setup on page J - 10. This step is not required if using the
software.

Analytical Balance
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12 MAINTENANCE AND TROUBLESHOOTING
The instrument has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time.When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided:

Power indicator did not illuminate when analyzer was powered ON.

Cause A: Power or DIN cables not fully inserted.

Action A: Verify cable connections and connect any loose cable ends into proper outlets.

Cause B: No power at outlet.

Action B: Test the outlet. If there is no power, contact electrician.

Cause C: Plug prongs bent so that contact not made at outlet.

Action C: Unplug the power cable and re-plug into outlet. If indicator does not illuminate,
have electrician adjust prongs or replace outlet or plug.

Cause D: Power cord damaged.

Action D: Have electrician check cord using test meter. Replace if defective.

Cause E: Loose internal connection, broken wire, or failure of internal power supply.

Action E: Contact aMicromeritics Service Representative for repair or replacement
information.

Specified pressure not reached or maintained.

Cause A: Chamber cap not properly closed.

Action A: Close chamber cap by turning fully clockwise.

Cause B: Chamber cap contains dust or debris or the O-ring is not properly greased.

Action B: Using a lint free tissue, clean the chamber cap and the rim of the cell chamber.
Lightly grease the chamber capO-ring. SeeChamber Cap O-Ring on page
12 - 3.

Cause C: The chamber capO-ring is not properly seated.

Action C: Check the chamber cap. Ensure that the O-ring is properly seated and that it
contains no scratches or cuts.

Cause D: The chamber capO-ring is cut or scratched.

Action D: Replace theO-ring in the chamber cap. SeeChamber Cap O-Ring on page
12 - 3.

Cause E: Gas leaks in the cell chamber or expansion chamber.

Action E: Check the pycnometer for leaks. See Check the Cell and Expansion Cham-

12Maintenance and Troubleshooting
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12Maintenance and Troubleshooting

bers for Leaks on page 12 - 5 .
Cause F: The helium tank is low on gas or empty. Tank pressure should be at least 200

psi above regulator pressure.

Action F: Check tank. Minimum recommended pressure is 200 psig above regulator pres-
sure. SeeRegulator Pressure on page 12 - 13.

CauseG: The shutoff valve on the gas cylinder is closed.

Action G: Ensure that the valve is open.

Cause H: The Zero offset (of pressure transducer) is too low.

Action H: Check offset by opening chamber cap. If pressure is negative (displayed on
instrument schematic), run a new zero offset. See Zero the Pressure Trans-
ducer & Chamber Volume on page 10 - 17.

Cause I: Dust filter on 2000 cm3 unit is clogged or leaking to atmosphere.

Action I: Clean the dust filter. SeeClean the Dust Filter on page 12 - 7.

Helium drained from tank.

Cause A: Leaks in the gas line connection.

Action A: Pressurize the system. Close, then open the gas cylinder shutoff valve. If the
needle on the pressure gauge falls abruptly, a leak in the gas line connections
may be indicated. Check all gas line connections.

Cause B: Pycnometer was left in Manual mode with all the valves open or the fill valve
open and chamber cap off.

Action B: Close all valves, then attach a new tank of helium.

Unit will not equilibrate, or results are not reproducible.

Cause A: Sample outgassing.

Action A: Prior to analysis, removemoisture and contaminants from the sample. SeePre-
pare and Load a Sample on page 6 - 1.

Cause B: Dust filter on 2000 cm3 unit is clogged or leaking to atmosphere.

Action B: Clean the dust filter. SeeClean the Dust Filter on page 12 - 7.
Cause C: Defective capO-ring.

Action C: Check capO-ring for defects. Regrease or replace theO-ring, if necessary.

Cause D: Debris on valves.

Action D: Withmanual mode enabled and with the cap installed, open all valves. With
helium flowing through the pycnometer, open and close the expansion valve
repeatedly for approximately oneminute. This will remove sample con-
tamination, whichmay cause a leak, from the valve seat. Repeat the process for
the vent valve with the inlet and expansion valves open.
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CHAMBER CAP O-RING
The cell chamber cap contains anO-ring that requires routinemaintenance. The chamber capO-
ring should be greased at the beginning of each period of use.

Fine fibers and particles between theO-ring and its sealing surfaces can cause leaks, as can
scratches or cuts in the O-ring or in themetal surfaces.

GREASE THE CHAMBER CAP O-RING
1. Turn the chamber cap counter-clockwise and lift it from the chamber.
2. Place the chamber cap on a clean surface with the O-ring side exposed.
3. Use a small drop of Dow Corning high vacuum grease (or equivalent).
4. Distribute the grease evenly and completely around theO-ring groove.

5. Replace the chamber cap.
6. If recalibrating the pycnometer, allow the pycnometer to warm up for 30minutes before cal-

ibrating.

REPLACE THE CHAMBER CAP O-RING
1. Use a pointed tool and carefully remove theO-ring from its groove in the cap. A small niche is

provided at the groove for placement of the tool.

Chamber CapO-Ring
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12Maintenance and Troubleshooting

Do not to scratch themetal surface of the chamber cap. Scratches could result in an
imperfect seal.

2. Clean the groove in the chamber cap using a small brush or lint-free tissuemoistened with iso-
propyl alcohol.

3. Allow the chamber cap to dry thoroughly.
4. Use a small drop of Dow Corning high vacuum grease (or equivalent).
5. Grasp theO-ring with the two greased fingers. Distribute the grease evenly and completely

around theO-ring.

Apply the grease sparingly. Toomuch greasemay alter cell volumewhile too little
grease results in an imperfect seal and leaks.

6. Place theO-ring back into the groove on the cap and, with the greased index finger, gently
press it back into position.

7. Ensure the O-ring groove is properly greased. SeeGrease the Chamber Cap O-Ring on
the previous page.

8. Replace the chamber cap.
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CHECK THE CELL AND EXPANSION CHAMBERS FOR LEAKS
This procedure should be performed in a temperature-stable environment after the pycnometer has
been allowed to warm for at least two hours. Before performing this procedure, check the chamber
cap to ensure that it is not the source of leaks. It should be free from particles, the O-ring should be
properly seated, and should not contain excessive grease.

CHECK FOR LEAKS USING THE SOFTWARE

Before performing this procedure, check the chamber cap to ensure that it is not the
source of leaks. It should be free from particles, the O-ring should be properly seated,
and it should not contain excessive grease.

Unit [n] > Diagnostics
SeeDiagnostics using the Software on page 9 - 1

CHECK FOR LEAKS USING THE KEYPAD

Before performing this procedure, check the chamber cap to ensure that it is not the
source of leaks. It should be free from particles, the O-ring should be properly seated,
and it should not contain excessive grease.

Check the cell and expansion chambers for leaks.

1. Allow the pycnometer to equilibrate thermally in a roomwith a stable temperature.
2. PressAlt + 1 to enter Manual mode.
3. If the systemwas previously open, manually purge the system before proceeding:

a. Press 8 to open theExpansion valve and 9 to close theVent valve; X - O - X.
b. Press 7 to open the Fill valve. Once the sample chamber fills to the appropriate pres-

sure, press 7 to close the Fill valve.
c. Press 9 to open theVent valve;X - O - O.

Check the Cell and Expansion Chambers for Leaks
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12Maintenance and Troubleshooting

d. Repeat this procedure two or three times.
e. Press 8 to close theExpansion valve;X - X - O.

4. Press 7 to open the Fill valve;O - X - O.
5. Fill the sample chamber to 19.5 psig.
6. Press 7 to close the Fill valve;X - X - O.
7. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pres-

sure should not decreasemore than 0.007 psig (0.048 kPag) or increasemore than 0.02 psig
(0.14 kPag) in a twominute span.

l If the pressure does not decreasemore than 0.007 psig (0.048 kPag) or increasemore
than 0.02 psig (0.14 kPag) in a twominute span, proceed to step 8.

l If the pressure decreasesmore than 0.007 psig (0.048 kPag) or increasesmore than 0.02
psig (0.14 kPag) in a twominute span, temperature instability or a leakmay be indicated.
Vent the system, then repeat steps 4 through 7 several times to verify that a leak is indic-
ated. If a leak is indicated, call a Micromeritics Service Representative.

8. Press 9 to close theVent valve, 8 to open theExpansion valve, and 7 to open the Fill valve;
O - O - X.

9. Fill the chambers to 19.5 psig.
10. Press 7 to close the Fill valve; X - O - X.
11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the pres-

sure should not decreasemore than 0.007 psig (0.048 kPag) or increasemore than 0.02 psig
(0.14 kPag) in a twominute span.

If the pressure decreasesmore than 0.007 psig (0.048 kPag) or increasesmore than 0.02
psig (0.14 kPag) in a twominute span, temperature instability or a leakmay be indicated. Vent
the system, then repeat steps 8 through 11 several times to verify that a leak is indicated. If a
leak is indicated, call a Micromeritics Service Representative.
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CLEAN THE DUST FILTER

Applicable only to 2000 cm3 units and 100 cm3 high pressure units.

Dust from the samplemay be carried into the instrument plumbing. A dust filter protects the valves,
minimizing valve leaks.

1. PressAlt+1 to enter Manual mode.
2. Close the Fill valve. Open theExpansion andVent valves to ensure that the system is not

under pressure.
3. At the lower rear of the instrument, remove the two screwswhich hold the dust filter cover and

remove the cover plate.
4. Remove the spring and the filter. Remove the small O-ring inside the filter port.
5. Clean all parts with alcohol. The filter may require sonication to dislodge dust. It should be

replaced if it becomes severely clogged.
6. Inspect the O-rings before re-assembly. A very thin coating of vacuum greasemay be used.
7. Re-assemble.
8. Check for leaks:

a. Fill the systemwith gas.
b. OpenExpansion valve.
c. Check for leaks by applying a leak detecting liquid around the dust filter cover.

Clean the Dust Filter
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12Maintenance and Troubleshooting

CLEAN THE PYCNOMETER
The exterior casing of the pycnometer may be cleaned using a clean cloth, dampened with isopropyl
alcohol (IPA), amild detergent solution, or a 3% hydrogen peroxide solution.

Do not immerse the pycnometer or the power cord in any liquids. Doing so could result
in electrical shock to personnel or damage to the unit.

Do not allow liquid to penetrate the casing of the pycnometer. Doing so could result in
damage to the unit.
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GUIDELINES FOR CONNECTING GASES

l Place gas cylinders within 6 feet (2m) of the gas inlets of the instrument. Using gas line extenders
on gas cylinders located in remote areasmay degrade gas quality and reduce pressure. Gas lines
are typically five to six feet long. Place the cylinders close enough to allow for proper connection at
the analyzer inlet.

l Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
l Always use the gas lines provided with the analyzer. It is very important that proper gas lines are
used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible linesmay appear to be appropriate, such as those
with a herringbone covering, but the linemay be coated internally with a polymer.

l Long gas lines, such as those used with gas cylinders placed in remote areas, must be evacuated
for an extended period of time to remove ambient gases.When possible, avoid placing gas cyl-
inders in remote locations. It is always better to have gas cylinders located near the analyzer.

l Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or entangling
gas lines. This will help avoid confusion whenmaintenance is required.

l Label the gas line at the analyzer inlet for proper identification andmaintenance.
l Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 200 psi (1500 kPa) on the high pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

l Ensure the gas cylinder is closed before connecting to the analyzer.

Guidelines for Connecting Gases
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12Maintenance and Troubleshooting

REPLACE A GAS CYLINDER

These instructions apply to working with inert gases only. Whenworking with hazardous
gases, follow the safety procedures established by your lab.

A power failure can result in dangerous pressures in the sample chamber. When using
toxic or flammable gases, additional venting of the cabinet may be required.
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DISCONNECT THE DEPLETED GAS CYLINDER
1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-

wise.
2. Disconnect the gas line from the regulator. Gaswill be vented from the line. It is not necessary

to disconnect the gas line from the analyzer inlet if the cylinder will be replaced immediately
with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counter-clockwise. Gaswill be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap andmove

the cylinder to an appropriate location.

Replace aGasCylinder
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12Maintenance and Troubleshooting

CONNECT A GAS CYLINDER

Analyzer Series Gauge should indicate

3Flex 15 psig (103 kPag)

AccuPyc 15 psig (103 kPag)

ASAP 15 psig (103 kPag)

AutoChem 5 psig (35 kPag)

AutoPore 45 - 50 psig (310 - 345 kPag)

Galaxy 15 psig (103 kPag)

DegasUnit - The internal regulator is pre-set at 5 psig, which
provides a steady gas flow of approximately 10sccm to each gas
delivery tube.

Gemini 19.5 psig (134.4 kPag)

TriStar 15 psig (103 kPag)

Regulator Pressure Settings

Move the replacement cylinder close to the analyzer and tether it into place. It is not necessary to
disconnect the gas line from the regulator or the analyzer.

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder. Place the protective cap in a secure location. It will be needed to recap the gas cyl-
inder when it is depleted and replaced.

2. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fittingmay cause a leak.

3. Check for leaks at the high-pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high-pressure gauge for approximately oneminute:

l If the pressure is stable, proceed with the next step.
l If the pressure decreases, tighten the regulator connector nut until it becomes stable.
If the pressure does not remain stable, remove the regulator and clean all contacts at
the regulator connection, then reinstall the regulator.

4. Purge the lines and set the regulator pressure.
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a. If the gas line is not connected to the regulator and the instrument connect it now.
b. Fully open the gas bottle shut-off valve and the gas regulator shut-off valve.
c. Under manual control, open the fill, expand, and vent val
d. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure,

whichever is higher, is shown on the regulator display.
e. Allow gas to flow for 30 seconds.
f. Close the fill, expand, and vent valves.
g. Turn the regulator control knob clockwise to increase pressure by 2 psi (15 kPa).

REGULATOR PRESSURE

SET REGULATOR PRESSURE WITH THE SOFTWARE

Tank pressure should be at least 200 psi above regulator pressure. Pressures less than
200 psig indicate the tank is low on gas. Analyses are terminated automatically if gas is
depleted.

For a High Pressure sample chamber configuration, set regulator pressure 20 psi above
cycle and fill pressure.

Regulator Pressure
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12Maintenance and Troubleshooting

ThePurge fill andCycle fill pressures are specified inAnalysis Conditions. Set the regulator
pressure at the higher of the two, plus 2.0 psig. For example; if thePurge fill pressure is set to 19.500
psig (134.445 kPag) and theCycle fill pressure as 19.000 psig (131.000 kPag), set the regulator
pressure at 21.500 psig (148.237 kPag).

1. Go toUnit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the instrument schematic does not display, go toUnit [n] > Show Instrument
Schematic.

2. On the schematic, right click theExpansion andVent valves and selectOpen for both. Then
open the Fill valve.

3. Adjust the regulator pressure control knob until thePurge fill orCycle fill pressure, whichever
is higher, is shown on the regulator display. Tank pressure should be at least 200 psi above
regulator pressure.

4. On the schematic, close the Fill valve, then increase the regulator pressure by 2.0 psig (13.8
kPag).

5. Allow the pressure in the pycnometer to drop below 2.0 psig, then close theExpansion and
Vent valves.

SET REGULATOR PRESSURE WITH THE KEYPAD

Ensure the tank pressure for the gas regulator is at least 200 psig. Pressures less than
200 psig indicate the tank is low on gas. Analyses are terminated automatically if gas is
depleted.

ThePurge fill pressure and cycle fill pressure are specified usingSetup > Analysis Parameters. Set
the regulator pressure at the higher of the two (plus 2.0 psig). For example; if the purge filll pressure
is specified as 19.500 psig and the cycle fill pressure as 19.000 psig, then set the regulator pressure
at 21.500 psig.

1. PressAlt + 1 to enter Manual mode.
2. Press 8 (EXPAND) and 9 (VENT) to open the expansion and vent valves; the display will

show:
X - O - O

3. Press 7 (FILL) to open the fill valve; the display will show:O - O - O
4. Adjust the regulator pressure control knob until thePurge fill orCycle fill pressure, whichever

is higher, is shown on the regulator display.
5. Press 7 to close the Fill valve, then increase the regulator valve by 2.0 psig. The display will

show:X - O - O.
6. Allow the pressure in the pycnometer to drop below 2.0 psig, then press 8 and 9 to close the

Expansion andVent valves. The display will show:X - X - X
7. PressSAVE to return to theReload prompt.
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RECOVER FROM A POWER FAILURE
Setup parameters and collected data are recorded by the pycnometer in case of a power failure.
These settingswill be available when power is restored. If an automatic operation was in progress
when the power failure occurred, it will be canceled when the pycnometer restarts.

Even though the pycnometer saves data during a power failure, any operation should be
restarted to ensure complete results.

RESET THE PYCNOMETER

Keypad Function

There are two ways to reset the Pycnometer.

l Hold the . key on the keypad during power ON. This erases data and setup parameters except for
printer and network settings.

l Hold 5 on keypad during power ON. This resets setup parameters, as well as printers and net-
work settings.

Recover From a Power Failure
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13 PARTS AND ACCESSORIES
Order system components and accessories using one of the followingmethods:

l Call our Customer Service Department at 1-770-662-3636
l Email orders to Orders@Micromeritics.com
l Contact your local sales representative

Part Number Item and Description

Analyzer Equipment

134-00000-00 AccuPyc II, 10 cm3 capacity

134-00001-00 AccuPyc II, 1 cm3 capacity

134-00002-00 AccuPyc II, 100 cm3 capacity

134-00005-00 Control Module, no sample compartment

134-00010-00 AccuPyc II, flowing temperature control, 10 cm3 capacity

134-00020-00 AccuPyc II, flowing temperature control, 100 cm3 capacity

134-00030-00 AccuPyc II Glove Box, 10 cc capacity

134-00031-00 AccuPyc II Glove Box, 1 cc capacity

134-00032-00 AccuPyc II Glove Box, 100 cc capacity

134-00033-00 AccuPyc II Glove Box, 350 cc capacity

134-00034-00 AccuPyc II Glove Box, 2000 cc capacity

134-00035-00 AccuPyc II TEC, 10 cc, Glove Box

134-00036-00 AccuPyc II TEC, 100 cc, Glove Box

134-00037-00 AccuPyc II 1340 500 psi, 100 ccGlove Box

134-00040-00 Analysismodule, 10 cm3 capacity

134-00041-00 Analysismodule, 1 cm3 capacity

134-00042-00 Analysismodule, 100 cm3 capacity

134-00043-00 Analysismodule, 350 cm3 capacity

134-00044-00 Analysismodule, flowing temperature control, 10 cm3 capacity

134-00045-00 Analysismodule, flowing temperature control, 100 cm3 capacity

134-00046-00 Analysismodule, 2000 cm3 capacity

134-00047-00 Analysismodule 1340 TEC, 10 cm3

134-00048-00 Analysismodule 1340 TEC, 100 cm3

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

134-00049-00 AnalysisModule 1340 500 psi, 100 cc

134-00050-00 AccuPyc II TEC, 10 cm3

134-00051-00 AccuPyc II TEC, 100 cm3

Cables

003-60623-00 Cable, 2 ft; for connecting analysismodules

003-60623-01 Cable, 25 ft; for connecting Control module to Glove box unit

003-63801-00 Ethernet cable, cross-over

003-63821-00 Null ModemCable, for connecting Analytical Balance to Controller/DataMan-
agement Module

Calibration Kit

133-34900-00 Calibration Standard Kit, 10 cm3; contains two calibration standard and one
sample cup

134-34901-00 Calibration Standard Kit, 2000 cm3; contains one calibration standard and
one 2000 cm3 sample cup

133-34902-00 Calibration Standard Kit, 100 cm3; contains one calibration standard and one
100 cm3 sample cup

133-34903-00 Calibration Standard Kit, 350 cm3; contains 3 calibration standard and one
sample cup

Chamber Cap O-rings

004-25030-02 Chamber capO-ring, 100 cm3 (500 psi model only)

004-25032-00 Chamber capO-ring, 2000 cm3

004-25575-00 Chamber capO-ring, 10 cm3

004-25577-00 Chamber capO-ring, 100 cm3

004-25637-00 Chamber capO-ring, 1 cm3

004-25689-00 Chamber capO-ring, 350 cm3
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Part Number Item and Description

Dust Filter Components (for 2000 cm3 and 100 cm3 500 psi units only)

004-25006-00 O-ring, -006 70 DUROBUNA-N

004-25011-00 O-ring, -011 70 DUROBUNA-N

004-25312-00 Compression spring

004-27082-00 Filter, Line, 10Micron

Equipment (Optional)

011-00000-00 Scientec Analytical Balance, model ZSA120

133-33604-00 MultiVolume Kit for 100 cm3 pycnometer; includes 10 cm3 and 35 cm3 inserts
and appropriate sample cups

133-33605-00 MultiVolume Kit for 10 cm3 pycnometer; includes 1 cm3 and 3.5 cm3 inserts
and appropriate sample cups

134-33605-00 MultiVolume Kit for 2000 cm3 pycnometer; includes 650 cm3 and 1300 cm3,
cups, inserts, and reference standards

134-33006-00 MultiVolume Kit for 1 cm3 pycnometer; includes 0.1 cm3 insert / sample cup
combination

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

Filtered Cap Kits and Components

134-33011-00 Kit, 100 cc Filtered cap, 2 μm. Kit includes:

l 004-25030-00 (5 ea.) - O-ring, -030 70 DUROBUNA-N
l 133-25845-01 (1 ea.) - Sample cup, 100 cc, modified for paper filter cap

Internal diameter: 4.62 cm

Usable internal depth: 5.99 cm

l 134-25803-00 (1 ea.) - Filtered cap, 100 cc, 2 μm

134-33012-00 Kit, 10 cc Filtered cap, 0.5 μm. Kit includes:

l 004-25048-00 (5 ea.) - O-ring, BUNA-N, 14mm ID × 1mmwide
l 133-25805-03 (1 ea.) - Sample cup, 10 cc, modified for filter caps

Internal diameter: 1.83 cm

Usable internal depth: 3.83 cm

l 134-25817-00 (1 ea.) - Filtered cap, 10 cc, 0.5 μm
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Part Number Item and Description

134-33013-00 Kit, 10 cc Filtered cap, 10 μm. Kit includes:

l 004-25048-00 (5 ea.) - O-ring, BUNA-N, 14mm ID × 1mmwide
l 133-25805-03 (1 ea.) - Sample cup, 10 cc, modified for filter caps

Internal diameter: 1.83 cm

Usable internal depth: 3.83 cm

l 134-25839-00 (1 ea.) - Filtered cap, 10 cc, 10 μm

134-33014-00 Kit, 35 cc Filtered cap, 2 μm. Kit includes:

l 004-25609-02 (5 ea.) - O-ring, -022, 70 BUNA-N
l 134-25804-00 (1 ea.) - Filtered cap, 35 cc, 2 μm
l 134-25837-00 (1 ea.) - Filtered cap, 100 cc, 35 cc Insert Multvol.
l 135-25804-00 (1 ea.) - Sample cup, 35 cc

Internal diameter: 3.35 cm

Usable internal depth: 3.47 cm *

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

134-33015-00 Kit, 3.5 cc Filtered cap, 10 μm. Kit includes:

l 004-25878-01 (5 ea.) - O-ring, BUNA-N DURO70, 12mm ID × 1mm
wide

l 134-25820-00 (1 ea.) - Filtered cap, 3.5 cc
l 135-25805-00 (1 ea.) - Sample cup, 3.5 cc

Internal diameter: 1.69 cm

Usable internal depth: 1.75 cm *

REQUIRED: To be used in conjunction with the 10 cc
Multivolume Kit (Mic P/N 133-33605-00). Must be ordered
separately.
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Part Number Item and Description

134-33016-00 Kit, 1 cc Filtered cap, 0.5 μm. Kit includes:

l 004-25058-00 (5 ea.) - O-ring, BUNA-N, 7mm ID × 1mmwide
l 133-09601-00 (1 ea.) - Tool, 1 cc and 0.08 cc filtered caps, 0.1 cc cup
l 133-25855-00 (1 ea.) - Sample cup, 1 cc

Internal diameter: 1.14 cm

Usable internal depth: 1.12 cm **

l 134-25830-00 (1 ea.) - Filtered cap, 1 cc, 0.08 cc, 0.5 μm

REQUIRED: To be used in conjunction with the
0.08/1 cc Filter Cap Chamber Closure
Assembly (Mic P/N 134-34013-00 shown here).
Must be ordered separately.

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

134-33017-00 Kit, 1 cc Filtered cap, 10 μm. Kit includes:

l 004-25058-00 (5 ea.) - O-ring, BUNA-N, 7mm ID × 1mmwide
l 133-09601-00 (1 ea.) - Tool, 1 cc and 0.08 cc filtered caps, 0.1 cc cup
l 133-25855-00 (1 ea.) - Sample cup, 1 cc

Internal diameter: 1.14 cm

Usable internal depth: 1.12 cm **

l 134-25836-00 (1 ea.) - Filtered cap, 1 cc, 0.08 cc, 10 μm

REQUIRED: To be used in conjunction with the
0.08/1 cc Filter Cap Chamber Closure
Assembly (Mic P/N 134-34013-00 shown here).
Must be ordered separately.
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Part Number Item and Description

134-33018-00 Kit, 0.08 cc Filtered cap, 0.5 μm. Kit includes:

l 004-25058-00 (5 ea.) - O-ring, BUNA-N, 7mm ID × 1mmwide
l 133-09601-00 (1 ea.) - Tool, 1 cc and 0.08 cc filtered caps, 0.1 cc cup
l 134-25802-00 (1 ea.) - Filtered cap cup, 0.08 cc

Internal diameter: 0.50 cm

Usable internal depth: 0.39 cm

l 134-25830-00 (1 ea.) - Filtered cap, 1 cc, 0.08 cc, 0.5 μm

REQUIRED: To be used in conjunction with the
0.08/1 cc Filter Cap Chamber Closure
Assembly (Mic P/N 134-34013-00 shown here).
Must be ordered separately.

13 Parts and Accessories
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Part Number Item and Description

134-33019-00 Kit, 0.08 cc Filtered cap, 10 μm. Kit includes:

l 004-25058-00 (5 ea.) - O-ring, BUNA-N, 7mm ID × 1mmwide
l 133-09601-00 (1 ea.) - Tool, 1 cc and 0.08 cc filtered caps, 0.1 cc cup
l 134-25802-00 (1 ea.) - Filtered cap cup, 0.08 cc
l 134-25836-00 (1 ea.) - Filtered cap, 1 cc, 0.08 cc, 10 μm

REQUIRED: To be used in conjunction with the
0.08/1 cc Filter Cap Chamber Closure
Assembly (Mic P/N 134-34013-00 shown here).
Must be ordered separately.

Filtered Cup Assemblies (Optional)

133-25862-00 Filtered cup assembly, 10 cm3; used to constrain powdered samples

133-25863-00 Filtered cup assembly, 100 cm3; used to constrain powdered samples
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Part Number Item and Description

Filtered Cup Assembly Components (for 100 cm3 units only)

004-25299-00 O-ring, size -024 70 DUROBUNA-N

004-27055-00 Paper filter (100 pack)

133-25845-01 Sample cup, 100 cc, modified for paper filter cap

Internal diameter: 4.62 cm

Usable internal depth: 5.99 cm

133-25901-00 100 cc sample cup filtered cap

133-25902-00 Spring clip for 100 cc sample cup cap

Gas Accessories

004-25549-00 Reducer, 1/8 in. tube × 1/4 in. tube

004-62150-580 Gas regulator, 1500 psig, CGA 580 (500 psi pycnometer only)

004-62230-58 Gas regulator, 30 psig, CGA 580

134-33020-00 MultigasManifold; to connect multiple gases to the analysis unit

290-25846-00 Gas inlet line assembly

Keypad Template

134-42701-01 French template

134-42701-02 German template

134-42701-03 Spanish template

134-42701-04 Italian template

Operating Supplies

008-16045-00 High Vacuum grease, Dow Corning

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

Power Accessories

003-40054-00 AC/DC power supply, external

003-40058-00 AC/DC external power supply, for TEC module on TEC instruments

003-60101-00 Power cord, US, Canada, Japan

003-60101-05 Power cord, Schuko, for European countries

134-34007-00 Power Adapter

Sample Cups

133-25805-00 Sample cup, 10 cm3 capacity

Internal diameter: 1.83 cm

Usable internal depth: 3.94 cm *

133-25805-02 Sample cup, 10 cm3 capacity, stainless steel

Internal diameter: 1.83 cm

Usable internal depth: 3.88 cm *

133-25805-03 Sample cup, 10 cm3 capacity, modified for filter caps

Internal diameter: 1.83 cm

Usable internal depth: 3.83 cm

133-25845-00 Sample cup, 100 cm3 capacity

Internal diameter: 4.62 cm

Usable internal depth: 6.13 cm *

133-25845-01 Sample cup, 100 cm3 capacity, modified for paper filter cap

Internal diameter: 4.62 cm

Usable internal depth: 5.99 cm

133-25855-00 Sample cup, 1 cm3 capacity

Internal diameter: 1.14 cm

Usable internal depth: 1.12 cm **

133-25855-01 Sample cup, 0.1 cc capacity

Internal diameter: 0.52 cm

Usable internal depth: 0.62 cm **
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Part Number Item and Description

134-25600-00 Sample cup, disposable, 3.3 cm3 capacity (qty. 50)

Internal diameter: 1.65 cm

Usable internal depth: 1.59 cm

134-25802-00 Sample cup, .08 cc capacity for filter cap

Internal diameter: 0.50 cm

Usable internal depth: 0.39 cm

134-25845-00 Sample cup, 100 cm3 capacity, stainless steel (500 psi model only)

Internal diameter: 4.80 cm

Usable internal depth: 6.20 cm

134-25874-00 Sample cup, 2000 cm3 capacity (used with CorePyc)

Internal diameter: 9.51 cm

Usable internal depth: 27.87 cm ***

134-25875-00 Sample cup, 1300 cm3 capacity (used with CorePycMultiVolume kit)

Internal diameter: 9.51 cm

Usable internal depth: 19.11 cm ***

134-25876-00 Sample cup, 650 cm3 capacity (used with CorePycMultiVolume kit)

Internal diameter: 9.51 cm

Usable internal depth: 10.33 cm ***

134-33007-00 Disposable Sample Cup Kit, for AccuPyc II (10 cm3) includes chamber insert
for 3.3 cm3 (nominal) disposable aluminum cups, calibration sphere, plus 50
disposable cups.

135-25804-00 Sample cup, 35 cm3 capacity (used with 100 ccMultiVolume kit)

Internal diameter: 3.35 cm

Usable internal depth: 3.47 cm *

135-25805-00 Sample cup, 3.5 cm3 capacity (used with 10 ccMultiVolume kit)

Internal diameter: 1.69 cm

Usable internal depth: 1.75 cm *

13 Parts and Accessories
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13 Parts and Accessories

Part Number Item and Description

Software and Manuals

134-20802-00 AccuPyc II Software for Windows

134-20804-00 AccuPyc II Software for Windows (with FoamPyc)

134-20808-00 AccuPyc II Software for Windows (Asphalt)

134-33005-00 WindowsUpgrade for FoamPyc; includes software and operator manual

134-42800-00 AccuPyc II SeriesOperator Manual (includes keypad and software versions,
binder and dividers)

* Depth listed is for solid materials. There is a small hole near the top of the cup to allow gas to
flow. This feature reduces the useful depth for powders by approximately 2 to 3mm.

** Depth listed is for solid materials. There is a small hole near the top of the cup to allow gas to
flow. This feature reduces the useful depth for powders by approximately 1mm.

*** Depth listed is for solid materials. There is a lifting notch near the top of the cup. This feature
reduces the useful depth for powders by approximately 1.5 cm.
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A CALCULATIONS

l Calculations for the 1340 AccuPyc

http://www.micromeritics.com/Repository/Files/Calculations_Links_-_1340_Series.pdf

ANALYSIS
For derivation, see the Sample Volume Equation Derivation section of the AccuPyc II Series
Operator Manual.

10, 100, AND 350 CM3 UNITS

V = V −s c

V

− 1

x

P1

P2

ρ =
s

m

V

s

s

where

Vc = sample chamber volume
Vx = expansion chamber volume
Vs = sample volume
ms = samplemass
ρs = sample density
P1 = gauge pressure after fill
P2 = gauge pressure after expansion

1 CM3 AND 2000 CM3 UNITS

 






V = V − V − 1s c x

P

P

1

2

ρ =
s

m

V

s

s
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A Calculations

where

Vc = sample chamber volume
Vx = expansion chamber volume
Vs = sample volume
ms = samplemass
ρs = sample density
P1 = gauge pressure after fill
P2 = gauge pressure after expansion
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ASPHALT DENSITY
Sample volume at 60 °F is found bymultiplying themeasured volume by the asphalt volume
correction factor.

V(60) = α(T )Vmeasured

where

α(T )= 1.0211326242 − 3.548988118 × 10 T + 4.498813 × 10 T
4 −8 2

and T is the analysis temperature in degrees Fahrenheit.

Sample density at 60 °F is

p(60) = m / V (60 )

Specific gravity at 60 °F is calculated by dividing the adjusted sample density by the density of water
at 60 °F.

SG(60) = p(60) ÷ ρ (60)
20H

where

ρ = 0.990170 /g cm
20

3

H

Note that the density of water at the analysis temperature is not required for this calculation.

Asphalt Density
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A Calculations

CALIBRATION
Volume calibration uses the ultra-precisemethod of separate adjustments for the offset and scale
factor.

VOLUME OFFSET

V = V − Vc celprev sampempty

−Vsampempty is reported as the offset in volume calibration reports.

VOLUME SCALE









V = Vc celprev

V

V

calib

sampball









V = Vx expprev

V

V

calib

sampball











V

V

calib

sampball is reported as the scale factor in volume calibration reports.
where

Vc = sample chamber volume
Vcelprev = previously stored cell volume
V
sampempty

= averageVsamp from volume offset calibration analysis (no calibration ball)

Vcalib = calibration ball volume
Vsampball = averageVsamp from volume scale calibration analysis (with calibration ball)
Vx = expansion chamber volume
Vexpprev = previously stored expansion volume
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FOAMPYC METHODS

METHOD A: COMPUTED OPEN CELL FRACTION

= ×
GeomVol − V − VolCellsCutOpen

GeomVol
100OpenCellPct

s

ResinPlusClosedCellPct = 100 − OpenCellPct

If cell measure isChord Length,

×VolCellsCutOpen = ActiveArea
ChordLength

1.14

If cell measure isDiameter,

×VolCellsCutOpen = ActiveArea
CellDiam

1.4515

METHOD B: MEASURED OPEN CELL FRACTION
= V [1] − V [2 ]VolCellsCutOpen s s

= V [1] +ResinPlusClosedCellVol s VolCellsCutOpen

−OpenCellVol = GeomVol ResinPlusClosedCellVol

= × 100ResinPlusClosedCellPct
ResinPlusClosedCellVol

GeomVol

= × 100OpenCellPct
OpenCellVol

GeomVol

where

Vs[1] = Vs from the first analysis (before recutting)
Vs[2] = Vs from the second analysis (after recutting)
Vs[1] = Vs from the first analysis (before recutting)

FoamPycMethods
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A Calculations

METHOD C: UNCORRECTED OPEN CELL FRACTION
VOpenCellVol=GeomVol − s

= × 100OpenCellPct
OpenCellVol

GeomVol

METHOD D: COMPRESSIBILITY TEST
Quantities appended with [i] are for cycle i, where i goes from 1 up to the number of cycles.

 V [i ] =∆ P

V i − 1 − V [i]

P [i − 1] − P [i]1

s s

1 1

 V [i ] =∆ P

V i − 1 − V [i]

P [i − 1] − P [i]2

s s

2 2

= avg( V [i ])∆AvgVolChangeP1 P1 for all included i

= avg( V [i ])∆AvgVolChangeP2 P2 for all included i

× 100PctAvgVolChangeP1 =
AvgVolChangeP1

GeomVol

= × 100PctAvgVolChangeP2
AvgVolChangeP2

GeomVol

METHOD E: FRACTURE TEST
Vol = V [3 ] − V [1]∆ s s

× 100PctFracturedCells =
Vol

GeomVol

∆

where

Vs[1] = Vs for the first (prefracture) cycle
Vs[3] = Vs for the third (postfracture) cycle
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GEOMETRIC VOLUME AND ACTIVE AREA
Geometric volume of the sample is calculated based on the sample shape; for Method A, Active area
is also calculated.

CUBE

= ×GeomVol EdgeLength
3

NumPieces

= × ( − ) ×ActiveArea EdgeLength
2

6 NumSkins NumPieces

CYLINDER

GeomVol = π × × Height × NumPieces
Diam

4

2







ActiveArea = π × Diam × Height +

π

4
× Diam

2
× (2 − NumSkins ) × NumPieces

RECTANGLE
GeomVol = LongEdge × ShortEdge × RemainEdge × NumPieces

+ActiveArea = [(LongEdge × RemainEdge × (2 − NumLargeSkins ) ShortEdge × RemainEdge ×

(2 − NumSmallSkins ) + LongEdge × ShortEdge × (2 − NumRemainSkins )] × NumPieces

PERCENT POROSITY
percent porosity = (ρ − ρ) ÷ ρ

s s

Geometric Volume and Active Area
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A Calculations

RESIN VOLUME

ResinVol =
m

ResinDensity

s

ResinVolPct = × 100
ResinVol

GeomVol

where

ms = samplemass

RUN PRECISION
Run precision requires at least five runs. Run precision criterion ismet when the sample volumes
calculated for the four most recent previous runs fall within the specified error band for the current
run’s sample volume. The error band is a specified percentage of the nominal volume of the sample
chamber (1, 10, 100, 350 and/or 2000 cm3).

Vs[0] toVs[4] are the fivemost recent sample volumes,Vs[4] being themost recent.

= ×ErrBand PctFullScale
V

100

nominal

where

Vnom-
inal

= nominal sample cell volume

If (V [i ] − V [4 ] ≤ )s s ErrBand for i = 0 to 3, run precision is achieved.
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SPC REPORT VARIABLES

REGRESSION CHART VARIABLES
The line of best fit for the Regression Chart is calculated by the usual least squaresmethod. 1 ) If
there is only a single point or allN points have the same x-value, there can be no line of best fit in the
standard form.

χ =
χ

N

Σ
i

y =
y

N

Σ
i

( )( )
( )

Slope =
χ − χ y − y

χ − χ

Σ

Σ

i i

i
2

⋅Intercept = y − xSlope

The coefficient of correlation for this line is also calculated in the usual way. 2 )

( )
σ =χ

χ − χ

N

Σ
i

2

( )
σ =y

y − y

N

Σ
i

2

( )( )
(x, y ) =Cov

x − x y − y

N

Σ i i

Correlation Coeff =
(x, y )

σ σ

Cov

x y

1 ) BASIC Scientific Subroutines Vol II, by F.R. Ruckdeschel, Copyright 1981 BYTE
Publications/McGraw Hill, p. 16.
2 ) Mathematical Handbook for Scientists and Engineers, G.A. Korn and T.M. Korn, McGraw Hill,
Sec. 18.4. (1968)

SPC Report Variables
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A Calculations

CONTROL CHART VARIABLES

Mean =
y

N

Σ
i

( )
Standard Deviation =

y −

N − 1

Σ Mean
i

2

C. V.=
StdDev

Mean

⋅+ n σ = Mean + n Standard Deviation

⋅− n σ = Mean − n Standard Deviation

SPECIFIC GRAVITY

SG = ρ ÷ ρ
s w

where

ρw = water density at analysis temperature

TOTAL PORE VOLUME
Total pore volume is per gram of sample.

TotalPoreVol =
ρ − ρ

ρ × ρ

s bulk

s bulk

where

ρ
bulk = entered bulk density
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TOTAL SOLIDS CONCENTRATION

− × × 100WeightPctSolids = 1
ρ

ρ

ρ

ρ − ρ

liq

s

sol

sol liq

where

ρ
liq = entered liquid density

ρ
sol = entered solid density

ρ
s = sample density

Total Solids Concentration
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B ERROR MESSAGES FOR THE 1340 ACCUPYC
SeeError Messages for the 1340 AccuPyc Keypad Only on page B - 18

2201 Cannot execute report subsystem.
Cause: Start Report failed to execute the report subsystem (which is a separate process).

Action: Restart the computer. If the problem persists, reinstall the application (this will not
affect any of your sample files). Contact aMicromeritics service representative if this
error message continues.

2204 Communication attempt with [n] failed [n]. Please check application directory
for file.

Cause: A file necessary for reporting ismissing.

Action: Re-install the software.

2430 Error accessing file [n], error code = [n].
Cause A: Mediamay be damaged.

Action A: Clean themedia drive. If this does not eliminate the problem, attempt operation using
a backup copy of the file.

Cause B: Hard diskmay be damaged.

Action B: Contact your Micromeritics service representative.

Cause C: A software error occurred when the file was accessed.

Action C: Contact your Micromeritics service representative.

Cause D: The file name specified contains one or more invalid characters.

Action D: Enter a valid file name. Do not use characters such as * or ?. Refer to the operating
systemmanual.

2431 Error writing file [n], error code = [n].
Cause A: User logged onto a computer that does not haveWrite permissions.

Action A: Contact your IT department to change user permissions.

Cause B: Insufficient hard disk to perform the operation.

Action B: Copy files not used regularly to the hard disk external media. Delete them from the
hard disk, and then try the operation again.

B Error Messages for the 1340 AccuPyc
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B Error Messages for the 1340 AccuPyc

2432 Invalid response from MMI ‘FILE_READ’ request.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact aMicromeritics service representative if this error message continues.

2433 New entries have been found in this directory. Refresh the directory inform-
ation?

Cause: Several analyzer files (sample information, analysis conditions, adsorptive properties,
or report options) have been added to this directory by some function other than the
analyzer program.

Action: ClickYes to update the directory information with data from each new file. This oper-
ationmay take aminute. ClickNo to locate the file manually. This optionmay be feas-
ible if a large number of files have been copied into the directory and the file name is
known.

2434 File [n] — Subset [n] wrote wrong [n] of data, expected [n] bytes.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

2436 Path specification [n] is invalid.
Cause: An invalid path name and/or extension was entered.

Action: Type a valid path name (including the proper extension), then pressEnter.

2437 File name [n] does not exist.
Cause: The overlay file selected in the report option does not exist.

Action: Enter an existing file specification, or select a file name from the list box.

2439 Could not register file.
2440 Subset not found.
2441 Seek within file failed.
2442 Bad header in subset file.
2443 Subset owner denied access
2444 Not a valid file format.
2445 Subset wrote the wrong amount of data.
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2446 Error reading data.
2447 Error writing data.

Cause: An unexpected error occurred when trying to access a data file.

Action: Contact your Micromeritics service representative.

2449 This field does not contain a valid file specification.
Cause: An invalid file namewas entered.

Action: See the description of file naming conventions in aWindowsmanual, then re-enter
the name.

2450 Sample Defaults may not be edited while this operation is in progress. Do you
wish to save and close the Sample Defaults edit session?

Cause: An automatic analysis (an analysis in which sample files are created using the
defaults) was processing while editing the defaults.

Action: Finish the edit session of the defaults, close the window, then restart the automatic
analysis.

2452 The instrument is busy performing an operation of which this application is
unaware. Do you want to cancel?

Cause: The instrument is performing an operation which is not recognized by the application.

Action: ClickYes to have the application cancel the operation. ClickNo to allow the oper-
ation to continue.

2452 Attempt to write MICATTR.DIR in read only mode. [n]
2453 Attempt to append MICATTR.DIR in read only mode. [n]

Cause: TheRead-Only attribute is turned on in the application’sMICATTR.DIR file (this file
exists in each folder containing sample or parameter files).

Action: UseWindowsExplorer to access the folder containing theMICATTR.DIR file, then
disable theRead-Only option.

2454 Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455 Too many selections for an export-to-file operation. Only the first (number)
selections will be processed. Please reselect the remainder

B Error Messages for the 1340 AccuPyc

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 B - 3



B Error Messages for the 1340 AccuPyc

Cause: Toomany files were selected for this operation.

Action: Select only the number of files specified in themessage.

2456 Insufficient file handles available. Application cannot continue.
Cause: More than 50 files are open at the same time.

Action: Refer to an operating systemmanual then set the limit for open files to 50 or greater.
Alternatively, close any unused open files.

2457 Results cannot be displayed. More than [n] windows are currently displaying or
printing results.

Cause: Toomanywindows are open in the application.

Action: Close some of the open windows.

2458 An instrument is performing a critical operation. Wait a few moments before exit-
ing the application.

Cause: An attempt wasmade to exit the application while the instrument was performing a
critical operation. This operationmust be completed before the application can be
exited.

Action: Wait a short time and attempt to exit the application again.

2459 An instrument is busy. A delay in restarting this application could result in loss
of new data. Continue with program Exit?

Cause: An attempt wasmade to exit the application while an analysis was in progress.While
this is possible, the data collected when the application is inactive will not be
permanently recorded until the application is re-started. A power failure to the
instrument could cause some data to be lost.

Action: If not concerned with the potential for loss of data should a power failure occur, click
Yes to continue; otherwise, clickNo.

2460 Fatal Communications error on [n].
Cause: There was a fatal error in communication between the application and the software in

the instrument. All displays for that instrument will be closed.

Action: Ensure that the analyzer is connected to the computer on the communications port
configured in theSetup program. Stop and restart the analyzer software. Contact
your Micromeritics service representative.
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2461 No instruments are in operation. This application will unconditionally terminate.
Cause: At least one instrument must be active for the application to operate. The initialization

of all of the instruments configured with the Setup program has failed. The application
stops.

Action A: Usually thismessage is preceded by another message giving the reason for the instru-
ment’s failure to initialize. Refer to the instructions for that message.

Action B: Ensure that the instrument is attached to the computer on the communications port
configured with theSetup program. Verify that the instrument's power switch is in the
ON position and that the light on the front panel is illuminated. Contact aMicromeritics
service representative if this error message continues.

2477 [n] did not properly initialize.
Cause: The software was unable to initialize this instrument. This is usually caused by one of

the conditions listed in the previous error messages.

Action A: Run theSetup program and ensure that a valid port is specified; if not, specify a valid
one when prompted.

Action B: Reinstall the software, then restart application.

Action C: Contact aMicromeritics service representative if this error message continues.

2478 Error copying sequential data segment.
Cause: An internal processing and/or hardware error occurred while accessing a portion of a

sample file.

Action: Confirm that themedia being accessed does not contain errors. Contact your Micro-
meritics service representative.

2480 File [n] cannot be analyzed. It is currently being edited.
Cause: An attempt wasmade to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it, then start the analysis.

2481 Error accessing the sample information file [n].
Cause: An unexplained error prevented access to this file.

Action: The hard disk drivemay be corrupt. Run diagnostics.

2482 File cannot be opened for writing.

B Error Messages for the 1340 AccuPyc
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B Error Messages for the 1340 AccuPyc

Cause: An attempt wasmade to open a file currently being used.

Action: Locate the application using the file (in theMicromeritics application, use theWin-
dowsmenu item to get a list of all open windows, one of whichmay contain this file).

2483 An analysis cannot be performed on [n]. It is open for editing and contains
errors.

Cause: An attempt wasmade to use a sample file containing errors that is currently open.

Action: Go to the window containing the file, correct the errors, then save it.

2484 The edit session for [n] must be saved before the analysis. Save changes and
continue with the analysis?

Cause: An attempt wasmade to start an analysis using a file that contains unsaved changes
and is open for editing.

Action: ClickYes to save the changes, then proceed with the analysis. ClickNo to cancel the
analysis, then continue editing the sample file.

2485 The sample file [n] has an invalid status and cannot be used for this operation.
2485 The service test file has an invalid status and cannot be used for this analysis.

Cause: The selected file has a status other thanNoAnalysis.

Action: Select a different sample file, or create a new one and clickReplace All to copy para-
meters from the file originally selected.

2486 Could not construct [n] report type. Program will terminate.
2487 Could not start report generator. Error code [n]. Program will terminate.

Cause A: Full rights to the application’s folders and files is required.

Action A: Contact a system administrator to have full rights granted.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your Micromeritics service representative.

2488 File [n] cannot be opened. It is already in use.
2488 File [n] cannot be opened for editing.

Cause: The specified file is being used in another edit operation.

Action: Check theWindows list to locate the other edit session.

B - 6 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



2489 File [n] cannot be opened for writing.
Cause: The specified file in aSave As operation is already open for edit.

Action: Select a different file for theSave As operation.

2490 No ‘.INI’ file present. Application will terminate.
Cause: The ASCII .INI file containing initialization information and system options information

used during program startup does not exist.

Action: Restore the .INI file from back-up, or re-install the software.

2491 Highlighted fields contain errors. Please correct the errors before closing.
Cause: The fields highlighted in red contain invalid entries. The window cannot be closed until

all errors are corrected.

Action: Check the entries, correct the errors, then close the window.

2492 This field’s entry is invalid.
2493 An entry is required for this field.

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

2494 Value is out of the valid range.
2495 Enter a value between [n] and [n].

Cause: The entered value in the highlighted field is outside the valid range of values.

Action: Check the entry, then either enter or select an appropriate value.

2496 Invalid number.
2497 This field contains an invalid character.

Cause: An invalid number (or character) was entered in the highlighted field.

Action: Check the entry, then either enter or select a valid number (or character).

2498 The requested change to the Sample’s status is invalid at this time.
Cause: A request to change the file’s status, for example, from automatically collected to

manually entered could not be done.

Action: Contact your Micromeritics service representative. Record the name of the sample

B Error Messages for the 1340 AccuPyc
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file in which the problem occurred.

2499 Sequence number must contain at least 3 digits.
Cause: An attempt wasmade to enter a sequence number that did not contain at least three

digits.

Action: Enter a sequence number that contains at least three digits.

2500 All sample file names that can be created using the sequence number pattern
already exist. You may want to modify the next sequence number.

Cause: Nomore sample files can be created using the currently entered file name sequence
number.

Action: Go toOptions > Default Method, then enter another sequence number.

2501 System resources have reached a dangerously low level. Please close some win-
dows to avoid the loss of data.

Cause: A large number of windows are open and consuming the system resources available
to all applications.

Action: Close one or more windows. Contact your Micromeritics service representative.

2502 Error writing to file [n] during print. Error code [n].
Cause: An error occurred in the file being written to during a print operation.

Action: Ensure there is sufficient space on the drive containing the file.

2503 Error converting file [n]. Cannot create DIO intermediate file.
Cause: An error occurred while printing a report to file.

Action: An attempt wasmade to replace a file that is read only or the computer login does not
have permission to do so. Contact your IT Department.

2504 Cannot create output file for sample [n].
Cause: Theremay be insufficient disk space.

Action: Ensure that sufficient space is available. Contact aMicromeritics service rep-
resentative if this error message continues.

2505 Error logger cannot be initialized. Error code [n]. Program will exit.
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Cause: An internal processing error has occurred.

Action: Contact your Micromeritics service representative.

2506 Output device [n] is not installed. Printing cannot be accomplished.
Cause: An internal processing error has occurred.

Action: Contact your Micromeritics service representative.

2508 Overlay [n] was not found. It will not be included in the reports.
Cause: The specified overlay file could not be found.

Action: Ensure the file specified as an overlay exists.

2509 Error opening file [n]. Reports cannot be produced.
Cause: An error occurred while the programwas opening a file necessary to the report oper-

ation.

Action: Use the name given in the error message to investigate. Contact your Micromeritics
service representative.

2510 Error parsing reports from file [n]. Reports cannot be produced.
Cause A: One or more data entry fields in the sample file may contain an invalid character (such

as a single quote or double quotes).

Action A: Review the data entry fields (for example, theSample field), then remove the invalid
character.

Cause B: The systemwas unable to create the usual temporary files during the report, possibly
due to insufficient disk space.

Action B: Check the space available on the hard disk.

Cause C: An internal processing error occurred.

Action C: Contact your Micromeritics service representative.

2511 Print job [n] has been canceled due to insufficient disk space. Delete unne-
cessary files and restart the report.

Cause: Themedia drive does not have required space for the temporary file.

Action: Delete unnecessary files from the disk. At least fivemegabytes of free space is
required for normal operation.

B Error Messages for the 1340 AccuPyc
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2512 Print job [n] canceled.
Cause: The print job was canceled by the operator.

Action: None required.

2513 Unable to read the calibration file [n].
Cause: An invalid calibration file was selected or cannot be read.

Action: Ensure themedia containing the calibration file has no problems.

2514 Unable to write the calibration file [n].
Cause: An attempt to save calibration data has failed due to possible media problems.

Action A: Ensure the destination location has no problems.

Action B: Choose an alternatemedia to save the calibration data.

2515
Warning: Changing the calibration information will affect the performance of the
instrument. Only qualified service personnel should do this. Do you wish to pro-
ceed?

Cause: The process of performing a calibration operation was started.

Action: Calibration operations should only be done by or under the direction of qualified ser-
vice personnel.

2516 Warning: Keeping a backup copy of the calibration data is recommended by
Micromeritics. Would you like to do so now?

Cause: A calibration operation was performed and a backup copy is recommended.

Action: Go toUnit [n] > Calibration > Save to File to perform a calibration save operation.

2517 Canceling this dialog will reset the calibration state to what it was when this dia-
log was first opened. Are you sure you want to cancel?

Cause: The calibration has not been accepted.

Action: If the calibration operation was successful, clickAccept.

2520 No data points available for reporting.
Cause: The selected sample file does not have collected data and cannot be used for report-

ing.

Action: Select a different sample file.
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2521 Unable to program controller.
Cause: A hardwaremalfunction has occurred.

Action: Contact your Micromeritics service representative.

2522 Invalid controller application file.
Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

2523 Programming controller failed.
2524 CRC check failed on programming controller.
2525 Unknown error programming controller.
2526 Controller download was not successful.
2527 Controller CRC error on boot block.
2528 Controller DRAM error.
2529 Controller Com 1: error.
2530 Controller Com 2: error.
2531 Controller debug port error.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

2532 The instrument contains a different software version. Do you want to reset it?
Cause: The application has discovered a different version of software operating in the ana-

lyzer.

Action: If there are no analyzers other than the one connected to the computer, clickYes,
then allow the updated software to load.

2533 Analyzer initialization failed.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative.

2534 Error opening file[n] for printing. Error Code [n].
Cause: An error occurred in the selected file for print output.
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Action: Ensure that sufficient disk space is available.

2548 System status [n].
Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the ana-
lyzer connection and the computer connection. Contact your Micromeritics service
representative.

2549 Error accessing online manual file [n].
Cause: The operator’smanual file could not be located.

Action A: Reinstall the application.

Action B: Copy the contents of themanual folder from the setupmedia to the application dir-
ectory.

2550 Attempts to acquire the instrument’s status timed out.
Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the ana-
lyzer connection and the computer connection. Contact your Micromeritics service
representative.

2551 Cannot access web page [n].
Cause: TheMicromeritics web page for DFTmodels cannot be accessed. This could be

caused by an ISP problem of high internet traffic.

Action: Try the operation later.

6000 An error occurred while loading the application control information. Data entry
cannot be performed. (Code [n]).

Cause: An error occurred accessing the control information disk file required by this applic-
ation.

Action: The disk drivemay have failed or be corrupt. Run diagnostics on the disk drive.

6001 Unable to establish the TCP connection with the instrument.
Cause: A communications problem between the computer and the analyzer has occurred.

Action A Check the cable connection between the computer and the analyzer
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Action B: Go toUnit [n] > Unit Configuration and verify that the TCP/IP configuration for the
computer and the analyzer are correct.

Action C: Exit the application, and turn off the analyzer. Then turn on the analyzer and restart
the application. Contact aMicromeritics service representative if this error message
continues.

6002 Configured serial number does not match instrument.
Cause: An incorrect serial number was entered when installing the software.

Action: Exit the application. Access theSetup program and remove the incorrect analyzer.
Then use theAdd an Analyzer option in theSetup program to add the correct serial
number for the controlling unit. Contact aMicromeritics service representative if this
error message continues.

6003 The instrument [n] is not calibrated.
Cause: Calibration data for the selected unit was not found

Action: Go toUnit > Calibration. Select the appropriate Calibrationmenu item or load a
saved calibration.

6110 Error accessing the sample information file [n].
Cause: There was an error opening a file.

Action: Code 5: There is a problemwith the computer login permissions. Consult your IT
department.
Code 2: File not found. Select a different file name.

6111 File [n] cannot be analyzed. It is currently being edited.
Cause: An open file was selected. Thismessage is informational-only.

Action: ClickOK to close the error message window. Then continue editing the file, save and
close it; or clickBrowse and choose a different file.

6112 File [n] cannot be opened. It is currently being setup for analysis.
Cause: An open file was selected that is currently being used for analysis.

Action: Select a different file.

6113 An analysis cannot be performed on [n]. It is open for editing and contains
errors.
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Cause: The selected analysis file contains errors and is open for editing.

Action: Finish editing the file, save, and close it, or choose a different file. Then restart the ana-
lysis.

6114 The edit session for [n] must be saved before the analysis. Save changes and
proceed with the analysis?

Cause: An attempt wasmade to start an analysis using a file that contains unsaved changes
and is still open.

Action: ClickYes to save the changes and proceed with the analysis. ClickNo to cancel the
analysis and continue editing the file, save and close it; or clickBrowse and choose a
different file.

6120 Unable to read the calibration file [n].
Cause: The selected calibration file is not valid or cannot be read.

Action: Ensure themedia containing the calibration file has no problems.

6121 Unable to write the calibration file [n].
Cause: An attempt to save calibration data has failed due to possible media problems.

Action A: Confirm themedia containing the calibration file has no problems.

Action B: Choose an alternatemedia to save the calibration data.

6122 File contains calibration data for a different unit [n].
Cause: A calibration file from a different unit was loaded.

Action: Load a file for the current unit or go toUnit > Calibration and select the appropriate
menu item.

6123 The device has no calibration data for the selected insert.
Cause: A calibration report was produced for an insert that has not been calibrated.

Action: Perform a volume calibration for the insert or produce a report for a different insert.

6126 The cell and expansion volumes must be positive. Enter positive values and
recalibrate.

Cause: According to the calibration data, the cell volume or expansion volume for the selec-
ted insert is zero or a negative value
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Action: Perform these steps:

1. SelectSetup > Calibration Data.
2. In theCell volume field, enter the volume of the sample cell (or insert).
3. In theExpansion volume field, enter half of the sample cell volume.
4. Perform a volume calibration.

6127 The entered calibration volume is < 10% of the cell volume. The resulting cal-
ibration may be inaccurate.

Cause A: An incorrect volumewas entered for the calibration standard.

Action A: Correct the volume entry.

Cause B: The calibration standard is too small for the cell.

Action B: Use a larger calibration standard.

6160 Device in recognizable state. Analysis canceled.
Cause: The application was closed during an analysis. When the application was restarted,

the analysis had been canceled.

Action: None required. The data collected up to the point of cancellation is saved in the
sample file.

6161 The sample file [n] is already present in the sequence.
Cause: An attempt wasmade to insert an existing file into the Sample File list.

Action: None required. The same file cannot be inserted into the list multiple times.

6162 The sequence list is full.
Cause: An attempt wasmade to add another file to the Sample File list for sequenced ana-

lyseswhen the list already contains eight entries.

Action A: Run the sequence analysis with the current list and include the preferred file in the
next sequence analysis.

Action B: Remove one of the files from the list, then add the preferred file.

6163 The sample file has an invalid status and cannot be used for analysis.
Cause: A sample file with a status other thanNoAnalysiswas selected.

Action: Select a sample file that has not been used in an analysis.
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6164 FoamPyc analyses cannot be done on a 1 cm3 unit.
Cause: An attempt wasmade to perform a FoamPyc analysis on a unit that does not support

it. FoamPyc analyses cannot be performed on a unit with a 1 cm3 or 2L sample cell.

Action A: Start the analysis on a different unit.

Action B: Close the analysis window, open the sample file, and selectStandard Method. Then
restart the analysis.

6165 Failure to fill sample cup.
Cause: There was insufficient pressure to allow filling within fiveminutes during an analysis.

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain a
new tank of helium.

6166 Pressure overrange.
Cause A: A pressure overrange occurred during an analysis because the regulator pressure is

set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified in
the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressuremeasurement electronics.

Action B: Contact your Micromeritics service representative.

6167 Pressure underrange.
Cause: A pressure underrange occurred during an analysis because an error occurred in the

pressuremeasurement electronics.

Action: Contact your Micromeritics service representative.

6168 Pressure failed to equilibrate.
Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A: Check the system carefully for leaks following the instructions in the instrument oper-
ator manual. Ensure the sample is properly prepared before performing an analysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B: Set the equilibration rate to progressively higher values until reasonable equilibration
times (15 sec to 120 sec) are achieved.
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6169 The instrument lost power during analysis.
Cause: A power failure occurred and when power resumed, the automatic operation was can-

celed.

Action: Restart the automatic operation.

6170 The measured volume is < 10% of the cell volume. Results may be inaccurate.
Cause: Not enough sample was placed in the sample cup to give an accurate reading.

Action: Rerun the sample using enoughmaterial to occupy themaximumamount of the nom-
inal cell chamber volume

6171 Valve failed to respond.
Cause: The instrument valves failed to operate.

Action: Contact your Micromeritics service representative.

6200 At least one report item must be selected. Press Cancel if you do not want a
report.

Cause: No reports were selected in theSelected Reports list. No output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the sample for
reporting, or clickCancel.

6201 No data available in [n] for reporting.
Cause: The requested report file does not contain collected data.

Action: Use the file in an analysis before requesting reports.

6202 Total solids concentration is invalid; liquid density is greater than or equal to
solids density.

Cause: A report was requested on a file containing invalid densities for Total Solids Con-
centration.

Action A: Specify appropriate densities for liquid and solids.

Action B: Do not request that total solids concentration be reported.
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ERROR MESSAGES FOR THE 1340 ACCUPYC KEYPAD ONLY

PressCHOICE to cycle through themessages and data. To delete themessage, pressCLEAR.
Messages that are not cleared will remain in the queue until the next analysis or calibration is
performed; at that time, any remainingmessageswill be cleared automatically.

l NN = Number of cycles completed
l ZZ = Number of cycles requested

Add Unit

Cause A: A new analysismodule has been attached to the instrument where previously a dif-
ferent module had been attached.

Action A: PressChoice and selectYes to add the new analysismodule.

Cause B: An incorrect serial number was read by the analysismodule.

Action B: PressChoice and selectNo to use the serial number and calibration information
stored in the commandmodule. Contact aMicromeritics service representative if this
error message continues.

ANLSERR: Eq failure — NN/ZZ cycles completed

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A: Check the system carefully for leaks following the instructions in the instrument oper-
ator manual. Ensure the sample is properly prepared before performing an analysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B: Set the equilibration rate to progressively higher values until reasonable equilibration
times (15 sec to 120 sec) are achieved.

ANLSERR: Fill failure — NN/ZZ cycles complete

Cause: There was insufficient pressure to allow filling within fiveminutes during an analysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain a
new tank of helium.

ANLSERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during an analysis because the regulator pressure is
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set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified in
the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressuremeasurement electronics.

Action B: Contact your Micromeritics service representative.

ANLSERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during an analysis because an error occurred in the
pressuremeasurement electronics.

Action: Contact your Micromeritics service representative.

Automatic operation has been canceled

Cause: The automatic operation has been canceled.

Action: Wait for the termination process to complete or end the termination process by press-
ingAlt + CLEAR twomore times.

CAL_ERR: Reset Pressure Cal. ?

Cause: The calibration information could not be read from the command or analysismodule.

Action A: SelectYes and pressEnter to reset the pressure and temperature calibration to nom-
inal values. Resetting to nominal may restore normal readings but a proper calibration
should be performed by a service technician.

Action B: SelectNo to avoid resetting the calibration. The instrument will be unresponsive.

CAL_ERR: Temperature Calibration Failed

Cause: The temperature calibration was unsuccessful.

Action: Contact your Micromeritics service representative.

CAL1ERR: Eq failure — NN/ZZ cycles complete

Cause: The empty cell chamber failed to equilibrate in 1000 seconds during the first pass of
calibration.

Action: Check the system for leaks.

Error Messages for the 1340 AccuPyc KeypadOnly
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CAL1ERR: Fill failure NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within fiveminutes during the first pass
of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insufficient
helium in the tank, obtain a new tank of helium. Tank pressure should be at least 200
psi above regulator pressure.

CAL1ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the first pass of calibration because the reg-
ulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified in
the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during the first pass of calibration because an error
occurred in the pressuremeasurement electronics.

Action B: Contact your Micromeritics service representative.

CAL1ERR: Underrange — NN/ZZ cycles complete

Cause: A pressure underrange occurred during the first pass of calibration because an error
occurred in the pressuremeasurement electronics.

Action: Contact your Micromeritics service representative.

CAL2ERR: Eq failure — NN/ZZ cycles completed

Cause: The calibration standard failed to equilibrate in 1000 seconds during the second pass
of calibration.

Action: Check the system for leaks.

CAL2ERR: Fill failure — NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within fiveminutes during the second
pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insufficient
helium in the tank, obtain a new tank of helium. (Tank pressure should be at least 200
psi above regulator pressure.)
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CAL2ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the second pass of calibration because the reg-
ulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified in
the analysis parameters plus 2.0 psig.

Cause B: Adjust the pressure so that it is equal to the higher of the two fill pressures specified in
the analysis parameters plus 2.0 psig.

Action B: Contact your Micromeritics service representative.

CAL2ERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during the second pass of calibration because an
error occurred in the pressuremeasurement electronics.

Action: Contact your Micromeritics service representative.

DATA_ERR: Chamber volumes must be > 0

Cause: According to the calibration data, the cell volume or expansion volume for the selec-
ted insert is zero or a negative value

Action: Perform these steps:

1. SelectSetup > Calibration Data.
2. In theCell volume field, enter the volume of the sample cell (or insert).
3. In theExpansion volume field, enter half of the sample cell volume.
4. Perform a volume calibration.

DATA_ERR: No data to compute

Cause A: An automatic operation was canceled before a complete cycle could be completed.

Action A: Restart the automatic operation.

Cause B: All the cycles have been excluded in review mode.

Action B: Return to review mode and include some cycles.

DTA_WRN: Cal std — 10% of full-scale
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Cause A: You entered a value for the calibration standard that was less than 10% of the nom-
inal cell chamber volume. Resulting datamay be inaccurate.

Action A: Be sure you enter the value recorded on the Calibration Standard case.

Cause B: You used an inappropriate calibration standard for the nominal cell chamber.

Action B: Use a calibration standard of sufficient size (calibration standards are available from
Micromeritics). The calibration standard should occupy at least 10% of the nominal
cell chamber volume and themore nearly filled the cell is, the better the calibration.

DTA_WRN: Volume — 10% of full-scale

Cause: There was not enough sample placed in the sample cup to give an accurate reading.

Action: Rerun the sample using enoughmaterial to occupy themaximumamount of the nom-
inal cell chamber volume.

HW_ERR: Calibration could not be read

Cause: The calibration information could not be read from the command or analysismodule.

Action: Close the application and cycle power on the instrument. Contact aMicromeritics ser-
vice representative if this error message continues.

MAN_ERR: Pressure overrange

Cause: The fill valve was left open until themaximum system pressure was exceeded.

Action: Close the fill valve and open the vent and expansion valves. Allow the pressure to sta-
bilize.

No A.C. Found

Cause: The control module cannot detect an analysismodule.

Action: Contact your Micromeritics service representative.

No collected data to report, or all cycles excluded

Cause: You requested a report in which there is either no data available or data have been
excluded via review mode.

Action: Initiate an automatic operation or return to review mode and include at least one
cycle.
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Printer port not responding

Cause: Printer port not responding

Action: Check tomake sure the printer is properly connected to the pycnometer, is turned on,
and is online.

Queuing print job [ESCAPE] to cancel

Cause: Statusmessage displayed when a report is being printed.

Action: None; this is a statusmessage only.

Reset to factory defaults

Cause: The . (period) keywas pressed at startup and the instrument was reset. Data files and
HTML reports have been erased. Setup options have been returned to default val-
ues.

Action: Review setup options.

Sending line (line number) [ESCAPE] to cancel

Cause: Statusmessage displayed when data are being transmitted.

Action: None; this is a statusmessage only.

SYS_ERR: Power Fail — NN/ZZ Cycles Completed

Cause: A power failure occurred and when power resumed, the automatic operation was can-
celed.

Action: Restart the automatic operation if desired.

Transmission port not responding

Cause: The receiving device took longer than five seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232 port
and is turned on. Verify that the serial I/O parameters controlling the receiving device
correspond with the data transmission parameters in the set upmode.
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Transmission port waiting for Xon

Cause: The receiving device stopped transmission by sending an Xoff, and hasn’t resumed
the transmission by sending an Xon.

Action: None; when the receiving device is ready for more data, it should send the pycno-
meter an Xon.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS-232 port
and is turned on. Verify that the serial I/O parameters controlling the receiving device
correspond with the data transmission parameters in the set upmode.

Updating Unit [n] failed: Press [CLEAR]

Cause: One of the analysismodules hasmalfunctioned.

Action: PressCLEAR and follow the instructions displayed in the keypad window. After dis-
connecting the faulty unit (as instructed), youmay reconnect the control module with
the remaining analysismodule(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nominal
full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.

Action: Abandon request.

USR_ERR: Number of cycles must be ≥ 5
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Cause: You tried to enable run precision without increasing the number of runs to at least five.

Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.

Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.

Action: Return tomanual mode and vent the system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nominal
full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.

Action: Abandon request.

USR_ERR: Number of cycles must be ≥ 5

Cause: You tried to enable run precision without increasing the number of runs to at least five.

Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.

Action: Enter a value in the specified range.

USR_ERR: Pressure overrange
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Cause: A pressure overrange occurred but was left uncorrected.

Action: Return tomanual mode and vent the system.
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C MULTIGAS OPTION

TheMultigas option enables the AccuPyc to use up to four different gases. TheMultigas assembly
consists of:

l Valve assembly and two retaining screws
l Gas entrance tubing for connection from the analyzer to the valve assembly
l Gas supply tubing for four gases

INSTALL THE MULTIGAS ASSEMBLY

If a gas is attached to the gas inlet on the rear panel of the analyzer, close the gas cyl-
inder valve and remove the inlet tubing from the analyzer before installing themultigas
assembly. The gas can then be attached to one of the inlet valves on the assembly.

1. Remove the two retaining screws on the rear panel of the AccuPyc.
2. Position the valve assembly against the rear panel so that the retaining screw holes on the

valve assembly align with those on the rear panel of the analyzer.
3. Attach the valve assembly to the rear panel using the two screws included in themultigas kit.
4. Carefully cut and remove the cable ties holding the gas entrance tubing in position and remove

the ties.
5. Remove the protective caps from the ends of the gas entrance tubing, then remove the fer-

rules from the upper end of the tubing.
6. Remove the nut from the center port and slide it onto the end of the gas entrance tubing, then

replace the front and rear ferrules.
7. Insert the tubing into the center port of themultigas assembly. Use the nut to secure the tubing

to the assembly.
8. Insert the other end of the tubing into the gas inlet. Use the self contained swage nut to secure

the tubing to the inlet.
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CONNECT GASES

1. Connect one end of the gas supply tubing to the gas supply. See Instrument Components
on page 1 - 5.

2. Insert the other end of the tubing into one of the valve inlets on themultigas assembly.
3. The faceplate of the valve assembly contains four sections; one for each gas inlet on the

assembly. Write the name of the gas in the applicable section.

SELECT GASES

After installing the gases, use the knob to select the gas. Purge the gas lineswhen changing gases.
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D MULTIVOLUME INSERT OPTION

TheMultiVolume Insert option provides analysis of samples using smaller-sized sample chambers.

Wear latex gloveswhen handling inserts and sample cups. Oils from skinmay con-
taminate the surface and affect analysis results. SeeHandling System Components
on page J - 1.

Equipment Description

AccuPyc 1 cm3 Includes a 0.1 cm3 insert/sample cup combination.

AccuPyc 10 cm3 Includes 1 and 3.5 cm3 inserts with corresponding sample cups and
appropriate calibration standards. Fritted filter lids are included for both
inserts.

AccuPyc 100 cm3 Includes 10 and 35 cm3 inserts with corresponding sample cups and
appropriate calibration standards. A fritted filter lid, which prevents the
escape of sample particles under rapid gas flow, is included for the 10
cm3 insert.

AccuPyc 2000 cm3 Includes 650 and 1300 cm3 cups, supporting inserts and calibration
standards. A tool is also included to allow removal of the supporting
inserts.

An insert changes the size of the sample chamber and requires its own sample cup. All inserts are
shipped with appropriate cups, with the exception of the 0.1 cm3 insert for the 1 cm3 unit. Because of
its size, the sample cup for the 0.1 cm3 insert is built-in. The appearance of the inserts and cups
varies.

l The fritted filter caps for the 1 cm3 and 3.5 cm3 inserts fit on top of the insert.
l The cap for the 10 cm3 insert (shown in image) fits on the sample cup.
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This example shows a 10 cm3 cup and insert.

The inserts for the 2000 cm3 systems are installed and removed with a special tool.
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INSTALL AND REMOVE INSERTS AND SAMPLE CUPS

0.1 CM3 INSERT

TheMultiVolume kit contains a special tool required to install the 0.1 cm3 inserts. The sample cup is
built into the 0.1 cm3 insert.

1 CM3 INSERT

TheMultiVolume kit contains a special tool required to install the 1 cm3 inserts.

To Install the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

Contamination from airborne particles can occur rapidly. The chamber cap should be
left off the sample chamber for as little time as possible.

2. Place the insert into the sample chamber.
3. Use the handling tool to grasp the cup for placement in the insert. After placing the sample into

the sample cup, insert the tip of the tool into the cup and press down firmly. The handling tool
features anO-ring to grip the inside surface of the sample cup.

4. Place the cup into the insert, then tilt the tool to one side and remove it from the sample cup.

D MultiVolume Insert Option
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5. If using a fritted filter cap, place it onto the top of the insert.
6. Replace the sample chamber cap.

To Remove the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

2. Remove the fritted filter cap (if used).
3. Insert the handling tool into the sample cup until the sample cup is gripped by theO-ring.
4. Lift the sample cup out of the insert.
5. Pull the insert from the sample chamber.
6. Replace the sample chamber cap.

10, 3.5, AND 35 CM3 INSERTS

Remove the chamber cap and place the insert into the sample chamber. The insert should fit snugly
in the chamber. Place the appropriate sample cup into the well of the insert.

Do not force the insert or cup into the openings. Thismay damage the instrument, insert,
or sample cup.

Install the fritted filter cap (if used) before closing the sample chamber. A fritted filter cap is used to
constrict gas flow and is included with some inserts. The fritted filter cap for the 10 cm3 insert fits on
the top of the sample cup. The fritted filter caps for the 1 and 3.5 cm3 inserts fit on the top of the
insert. Fritted filter caps are not available for the 0.1 and 35 cm3 inserts.
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CALIBRATE INSERT
An insert must be calibrated and its operation verified. Appropriate calibration standards are
included in theMultiVolume kits. For example, a 100 cm3 capacity AccuPycwith a 10 cm3 insert
must be calibrated with the 10 cm3 insert, cup, and calibration standards.

0.1 CM3 INSERT
Because of the size of the 0.1 cm3 insert, its calibration is performed in a different manner from that
of other inserts.

If the 1 cm3 pycnometer has not been calibrated recently, perform a calibration before
calibrating the 0.1 cm3 insert.

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

2. Place the insert into the sample chamber (the sample cup is built into the insert). Replace the
chamber cap.

3. PressAlt + 4 to access theAnalyze function. PressENTER until theChamber Insert prompt
is displayed. Ensure thatNone is displayed.

4. Press ENTER to display theAnalyze prompt. PressENTER to begin the calibration.
5. After the calibration is complete, theReload prompt is displayed.
6. PressCHOICE until the averagemeasured volume is displayed. Record this value.
7. PressAlt + 2 to accessSetup.
8. PressCHOICE untilCalibration Data is displayed.
9. PressENTER to display theChamber Insert prompt.
10. Ensure thatNone is selected, then pressENTER to display theCell Volume prompt.
11. Subtract the average volume of the 0.1 cm3 insert/cup (recorded in Step 6) from the cell

volume displayed in the prompt. Record this value.
12. PressENTER to display theExpansion Volume prompt.
13. Record the value displayed for the expansion volume, then pressENTER to return to theCal-

ibration Data prompt.
14. PressENTER. TheChamber Insert prompt is displayed.
15. PressCHOICE until 0.1 cm3 is displayed, then pressENTER to display theCell Volume

prompt. Enter the value recorded in Step 11.
16. PressENTER to display theExpansion Volume prompt. Enter the value recorded in Step 12.
17. PressSAVE to save the information and return to theReload prompt.

The pycnometer is now ready for analyses using the 0.1 cm3 insert/cup.

D MultiVolume Insert Option
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DMultiVolume Insert Option

1, 10, 3.5, 35, 650, AND 1300 CM3 INSERTS
1. Remove the sample chamber cap and place on a clean work surface with the greased side

facing upward.
2. Place the insert and sample cup into the sample chamber. Replace the chamber cap.
3. Calibrate the insert. SeeAbout Calibration on page 10 - 1.
4. SeeVerify Operation on page 10 - 10.

OPERATING PARAMETERS USING THE KEYPAD
To operate using inserts, access theChamber Insert prompt to select the appropriateMultiVolume
insert.

1. PressAlt + 2 to access theSetup function.
2. PressCHOICE untilReport Options is displayed, then pressENTER.
3. Continue pressingENTER until theRequest Insert prompt is displayed.
4. PressCHOICE untilYes is displayed, then pressENTER.

5. PressSAVE to save the changes and return to theReload prompt.
A Chamber Insert prompt will display during all normal operating procedures. For example, a
Chamber Insert prompt will display when starting a calibration or analysis.
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E RS-232 PIN ASSIGNMENT
The AccuPyc is a standard DTE device. The RS-232 port can be used to connect an analytical
balance for transfer of sample weight, or for transmitting data to a computer. The receiving device
must be configured to interface with the RS-232 pin assignments. Any signals that are not listed in
theRS-232 Pin Assignment table are ignored.

Pins Signal Description Data Direction

2 RXD Receive Data Into AccuPyc

3 TXD Transmit Data FromAccuPyc

4 DTR Data Terminal Ready FromAccuPyc

5 GND Ground N/A

6 DSR Data Set Ready Into AccuPyc

RS-232 Pin Assignments

The AccuPyc uses the DTR andDSR signals for hardware flow control. Ensure that the serial
device provides these signals. For example, if attaching to a computer (also a DTE device), use a
null modem cable which includes the designated signals. If transmission problems occur, ensure that
the signals are set up properly. If the signals are correctly configured, contact the receiving device
manufacturer for assistance.

E RS-232 Pin Assignment
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F SAMPLE VOLUME EQUATION DERIVATION

10, 100, AND 350 CM3 UNITS
The AccuPyc II is a gas displacement pycnometer whichmeasures the volume of solid objects of
irregular or regular shape whether powdered or in one piece. A greatly simplified diagram of the
instrument is shown below.

Sample volume is determined from the known cell and expansion volumes and frommeasured
pressures.

The cell and expansion chamber are initially at ambient pressure and the valve is closed. The cell is
then charged to an elevated pressure.

The ideal gas law gives:

P (V − V ) = n RT1 c s c (1)

where

nc = moles of gas in the sample cell
R = the gas constant
T = temperature
Vc = cell volume
Vs = sample volume
Vx = expansion volume
P1 = initial cell pressure

Expansion volume:

P V = n RTa x x (2)

F Sample Volume Equation Derivation
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F Sample Volume Equation Derivation

where

Pa = ambient pressure
nx = moles of gas in the expansion volume

When the valve is opened, the pressure falls to an intermediate value,P2, andmass balance yields:

P (V − V + V ) = n RT + n RT2 c s x c x (3)

Substituting from equations (1) and (2) into (3):

P (V − V + V ) = P (V − V ) + P V2 c s x 1 c s a x (4)

or

(P − P )(V − V ) = (P − P )V2 1 c s a 2 x (5)

then

V − V = Vc s

P − P

P − P
x

a 2

2 1

(6)

Adding and subtractingPa in the denominator and rearranging gives

−V = −V + Vs c

P − P

P − P − P +P
x

a 2

2 a 1 a

(7)

Dividing by (Pa - P2) in both the numerator and denominator











V = V −s c

V

−1 −

x

P1− Pa

Pa− P2

(8)

or











V = V −s c

V

− 1

x

P1− Pa

P2− Pa

(9)
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Using gauge pressure defined as:

P = P − Pig i a (10)

equation (9) is rewritten as:

V = V −s c
V

− 1

x

P1g

P2g

(11)

1 CM3 AND 2000 CM3 UNITS
The 1 cm3 and 2000 cm3 pycnometers operate by filling the expansion chamber while the sample
cell remains at ambient pressure. After P1 is equilibrated, the expansion valve opens to allow gas to
expand into the sample chamber andP2 is equilibrated.

For the 1 cm3 and 2000 cm3 pycnometers, equation (1) becomes

P V = n RT1 x x

and equation (2) becomes

P (V − V ) = n RTa c s c

A derivation similar to that above yields the working equation for the 1 cm3 and 2000 cm3

pycnometers









V = V − V − 1s c x

P

P

1g

2g

F Sample Volume Equation Derivation
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G TEC MODULE

This AccuPyc system has beenmodified to provide temperature control from 15 to 36 °C. The
system uses a thermoelectric control (TEC) system to heat or cool the AccuPyc. The temperature is
controlled using a digital temperature controller and a separate power system from the AccuPyc.

It is suggested that the TEC system be installed first, to allow time for temperature to stabilize at the
desired temperature, while the AccuPyc is being installed. SeeAdd Analysis Module to Control
Module on page 11 - 1.

SET THE TEC TEMPERATURE
1. Power on the TEC module. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current
temperature and amessage such asErAt displays, press theP (Program) key on the front
panel of the controller. TheErAtmessage should stop and only the current temperature will
display.

2. PressP. SP 1 displays followed by the current setpoint (SP 1). Use theUp orDown key to
set the temperature.

3. PressP to accept the temperature. The controller will now start heating or cooling to achieve
the setpoint

The TEC module uses a fan to remove heat. The fan is located on the underside of the
instrument. The fan pulls air into the instrument and the air is exhausted through
ventilation slots on the rear panel. The exhaust slotsmust remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC systemwill be unable to control temperature, andmay
become damaged.

GTEC Module
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GTEC Module

OPERATE THE TEC MODULE

When the TEC controller shows the correct temperature, theremay be a small difference between
the temperature on the TEC unit and the AccuPyc display because two different sensors are being
used. The AccuPyc sensor and electronics are calibrated together to compensate for any
component differences between the sensor and the circuit board components. Micromeritics
considers the AccuPyc temperature display to be amore accurate reflection of the sample
temperature than the reading from the controller. The controller and the sensor used with the
controller cannot be calibrated.

The TEC controller may be adjusted to compensate for the small difference. If the AccuPyc
temperature is a little high, then reduce the setpoint of the TEC controller by the difference.Wait for
stabilization. Readjustment may need to be repeated until the correct AccuPyc temperature is
achieved.

The AccuPyc volumemust be calibrated at the analysis temperature. Perform the volume calibration
in the normal way until it is time to insert the reference volume (sphere or spheres). After installing
the reference volume, wait at least 20minutes to allow the volume to achieve the same temperature
as the AccuPyc. Then continue as normal.

When it is necessary to performAccuPyc tests at a different temperature, re-calibrate the system
volume at the new temperature.

VOLUME CHANGE WITH TEMPERATURE FOR THE 10 CM3 ACCUPYC

The reference spheres supplied with the 10 cm3 AccuPyc aremade from tungsten carbide. They
weremeasured at 20 °C. The sphereswill change volumewith temperature. The change is very
small and is shown in the following table. Every sphere is a slightly different size, and so the table
provides the factor to be used if the value used during calibration needs to be adjusted. Multiply the
volume provided with the reference spheres by the value in the right column.

Temperature (°C) Typical Volume (cm3), two balls Factor

15 6.37125 0.99991

20 6.37182 1.00000

25 6.37238 1.00009

30 6.37295 1.00018

35 6.37351 1.00027

For example, if the ball is 6.37182 cm3 at 20 °C but run at 50 °C, multiply the Volume × the Factor in
the table.

6.37182 x 1.00053 = 6.37520
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VOLUME CHANGE WITH TEMPERATURE FOR THE 100 CM3 ACCUPYC

The stainless steel calibration standard (ball) supplied with the 100 cm3 AccuPyc ismade from 440
grade stainless steel. It wasmeasured at 20 °C. Its volumewill be higher when heated above 20 °C.
The following table uses the coefficient of thermal expansion of 440 grade stainless steel (0.0000101
m/m/degree C change) to provide the volume of the sphere at various temperatures.

Every ball is a slightly different size therefore the table provides the factor to be used if the value used
during calibration needs to be adjusted. Multiply the volume provided with the reference sphere by
the value in the right column.

Temperature (°C) Typical Volume (cm3) Factor

15 51.089712 0.99995

20 51.092292 1.000000

25 51.094872 1.000051

30 51.097452 1.000101

35 51.100032 1.000152

For example, if the ball is 51.092292 cm3 at 20 °C but run at 50 °C, multiply the Volume × the Factor
in the table.

51.092292 × 1.000303 = 51.107773

GTEC Module
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GTEC Module

ASPHALT DENSITY MEASUREMENT

Samples can be analyzed in disposable cups. Any difference in themass of the cups used for
calibration and analysis will be corrected for in the reported quantities. Performing an asphalt density
measurement requires the AccuPyc II Asphalt software and disposable sample cups.

Steps 1-9 do not need to be repeated for subsequent analyses.

1. Set the instrument temperature and allow 12 hours for equilibration.
2. Go toOptions > Option Presentation. SelectShow Cup Properties. Verify that a check-

mark displays to the left.
3. Label each disposable cup with a permanent marker and record itsmass.
4. Place a disposable cup in the 3.3 cm3 insert and position the insert in the sample chamber.
5. Go toUnit [n] > Calibration > Calibrate Volume.

a. Enter themass of the cup in theCupmass field.
b. Enter the volume of the reference sphere in theVolume of calibration standard field.
c. Select the correct chamber insert.
d. SelectMeasured.
e. ClickStart.

6. Insert the reference sphere when prompted and resume the calibration.
7. When the calibration is complete, remove the cup and reference sphere .
8. Prepare a sample in a different disposable cup and place it in the sample chamber.
9. Create a sample file for the analysis.
10. Go toUnit [n] > Sample Analysis and select the sample file created in the previous step.
11. Enter themass of the cup in theCupmass field.
12. Select the chamber insert that was used for calibration.
13. ClickStart.
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H TEMPERATURE CONTROLLED ACCUPYC
A temperature controlled AccuPycmust be connected to a circulating bath (not provided by
Micromeritics). Refer to themanufacturer operator manual for circulating bath operating instructions.

ATTACH A CIRCULATING BATH
The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.

1. Power off the controlling unit.
2. Remove the plugs from the In port and theOut port.

3. Insert the provided hose fittings into each connector.
4. Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.
5. Install the tubing on the In andOut connectors.
6. Install the other end of theOut tubing to the Inlet connection of the bath circulator.
7. Install the other end of the In tubing to theOutlet connection of the bath circulator.
8. Set the temperature using the appropriate controls on the bath circulator.

H Temperature Controlled AccuPyc
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H Temperature Controlled AccuPyc

ADD ANALYSIS MODULES TO A TEMPERATURE CONTROLLED MODULE

If using theWindows version of the AccuPyc II, exit the application before powering off
the analyzer.

1. Power OFF the controlling unit.
2. Connect the circulating bath. SeeAttach a Circulating Bath on page J - 5.
3. Connect one end of themodule connector cable (provided in the analysismodule accessories

kit) to the connector labeledModule Connection on the rear panel of the control module.
4. Connect the other end of themodule connector cable to the lower connector labeledModule

Connector on the rear panel of the analysismodule.

5. Power ON the analyzer. If using theWindows version of the AccuPyc II, start the application .
6. Calibrate the analysismodule using the calibration kit shipped with the system. SeeAbout

Calibration on page 10 - 1.
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I TRANSMITTED DATA

Keypad Function

Analysis and calibration data can be transmitted in a single column or spreadsheet with data in
ASCII delimited format. Units are displayed as:

Type Measurement

Date DD/MM/YY

Time HH:MM:SS

Pressure psig

Temperature °C

Elapsed Time seconds

Data Units

ANALYSIS REPORT

Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = analysis 8 characters

4 Start (reported on one line as ASCII comma delimited
data)

l 4a. Date
l 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited
data)

l 5a. Date
l 5b. Time

8 characters (each)

6 Temperature 1 floating point

7 Description line 1 20 characters

8 Description line 2 20 characters

Analysis Report - Spreadsheet

I Transmitted Data
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I Transmitted Data

Record
Number

Description Form

9 Sample IDs 20 characters

10 Samplemass 1 floating point

11 Number of purges 1 integer

12 Equilibration rate 1 floating point

13 Chamber Insert:

l 0 = None
l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

14 Cell volume 1 floating point

15 Expansion volume 1 floating point

16 Average volume 1 floating point

17 Volume standard deviation 1 floating point

18 Average density 1 floating point

19 Density standard deviation 1 floating point

20 Number of runs 1 integer

21 Run precision

l 0 = Disabled
l 1 - Enabled

1 floating point

22 Percent full scale 1 floating point

23 Carriage return / Line feed

24 Carriage return / Line feed

25 Carriage return / Line feed

26 Run number and pressure (reported on one line as ASCII
comma delimited data)

Analysis Report - Spreadsheet (continued)
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Record
Number

Description Form

26a Run number 1 integer

26b P1 1 floating point

26c P2 1 floating point

26d Include in average calculation

l 0 = Excluded
l 1 = Included

1 integer

26e Elapsed time 1 unsigned integer

26f Volume 1 floating point

26g Volume deviation 1 floating point

26h Density 1 floating point

26i Density deviation 1 floating point

27 Temperature (all temperature data) 1 floating point

Analysis Report - Spreadsheet (continued)

CALIBRATION REPORT

Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = calibration 11 characters

4 Start (reported on one line as ASCII comma delimited
data)

l 4a. Date
l 4b. Time

8 characters (each)

Calibration Report - Single Column

I Transmitted Data
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I Transmitted Data

Record
Number

Description Form

5 Stop (reported on one line as ASCII comma delimited
data)

l 5a. Date
l 5b. Time

8 characters (each)

6 Temperature 1 floating point

7 Calibration standard size 1 floating point

8 Number of purges 1 integer

9 Equilibration rates 1 floating point

10 Chamber Insert:

l 0 = None
l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point

12 Cell volume standard deviation 1 floating point

13 Average expansion volume 1 floating point

14 Expansion volume standard deviation 1 floating point

15 Number of runs 1 integer

16 P1 (all P1 data) 1 floating point

17 P2 (all P2 data) 1 floating point

18 P1* (all P1* data) 1 floating point

19 P2* (all P2* data) 1 floating point

20 Include in average calculation

l 0 = Excluded
l 1 = Included

1 integer

Calibration Report - Single Column (continued)

I - 4 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = calibration 11 characters

4 Start (reported on one line as ASCII comma delimited
data)

l 4a. Date
l 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited
data)

l 5a. Date
l 5b. Time

8 characters (each)

6 Temperature 1 floating point

7 Calibration standard size 1 floating point

8 Number of purges 1 integer

9 Equilibration rates 1 floating point

10 Chamber Insert:

l 0 = None
l 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

l 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point

12 Cell volume standard deviation 1 floating point

13 Average expansion volume 1 floating point

14 Expansion volume standard deviation 1 floating point

15 Number of runs 1 integer

Calibration Report - Spreadsheet

I Transmitted Data

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 I - 5



I Transmitted Data

Record
Number

Description Form

16 Carriage return / Line feed

17 Carriage return / Line feed

18 Carriage return / Line feed

19 Run number and pressure (reported on one line as ASCII
comma delimited data)

19a Run number 1 integer

19b P1 1 floating point

19c P2 1 floating point

19d P1* 1 floating point

19e P2* 1 floating point

19f Include in average calculation

l 0 = Excluded
l 1 = Included

1 integer

19g Cell volume 1 floating point

19h Cell volume deviation 1 floating point

19i Expansion volume 1 floating point

19j Expansion volume deviation 1 floating point

Calibration Report - Spreadsheet (continued)
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J INSTALLATION INSTRUCTIONS
These instructions assume that the shipping cartons have been opened and their contents checked
and verified .

HANDLING SYSTEM COMPONENTS

CALIBRATION STANDARD

l Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.
l Do not drop the standard into the sample cup. Roll the standard into the cup to prevent damage.
l Always return the standards to the case. Standards are unit specific.

SAMPLE CHAMBER CAP

l Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.
l Keep the cap on the sample chamber except when inserting or removing the sample cup .

When left uncapped, the sample chamber temperaturemay become unstable and/or
water vapor will adsorb on the inner surface of the chamber. Either of these conditions
can affect analysis results.

l Avoid laying the chamber cap on a work surface. Debrismay collect on the greased surface of the
O-ring which can also affect analysis results.

l Whenmultiple analysismodules are connected, never interchange sample chamber caps. Caps
are unit specific.

J Installation Instructions
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J Installation Instructions

GAS REQUIREMENTS
The pycnometer uses helium or nitrogen (99.995% pure or better) to provide rapid, accurate
analyses. The cylinder containing heliummust be fitted with a gas regulator set for 19-23 psig (131-
159 kPag). The pressure input to the pycnometer should never be greater than 25 psig (172 kPag).
Excessive pressureswaste gas due to a protection device contained in the pycnometer that vents
the pycnometer to atmospheric pressure if pressure exceeds 35 psig (241 kPag).

This protection device is not installed on 2000 cm3 units.

Tank pressure should be at least 200 psi above regulator pressure.
The High Pressure sample chamber configuration inlet pressure should never be
greater than 520 psig (3580 kPag); there is no pressure relief.

Other inert, dry gases can also be used andmay bemore applicable for some applications.

PYCNOMETER SET UP

PYCNOMETER CONFIGURATION

Single Module Configuration
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Control Module and Analysis Module Configuration

TEC Module Configuration

Component Description

A Separate power cord for external power supply. Connect cable to wall outlet.

B External power supply

C Hardwired 8-pin mini-DIN power cable for external power supply.

D 8 pinmini DIN cable.

E Power adapter DIN port.

Diagram Components

Pycnometer Configuration

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 J - 3



J Installation Instructions

Component Description

F Power adapter.

G Module Connection - 8-pin mini-DIN OUT port to connect next analysismodule.

H Module Connection - 8-pin mini-DIN IN port to connect the control module or pre-
viously connected analysismodule (not shown).

I Hardwired power mini-DIN cable for power adapter.

Diagram Components (continued)

Set Up Procedure

1. Unpack and inventory all boxed parts. Contact your Micromeritics Service Representative if
parts aremissing or broken.

2. Placemodule(s) on work surface.
3. Connect separate power cable(s) to external power supply(s).
4. Connect external power supply(s) to power outlet on themodule(s).
5. Connect power cable to wall outlet.
6. Toggle themodule power switch to the ON position.
7. Check the power indicator on the front panel of the analyzer. The indicator will blink green to

indicate that power is applied to the analyzer. Once the application is running, the indicator will
stop blinking and remain illuminated.

8. On the keypad, pressAlt + CHOICE + 2.Unit [n] appears in the upper left corner of the dis-
play.

9. Adjust the display brightness control using theBrightness Control button on the rear of the
analyzer.
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SET THE TEC TEMPERATURE

See TEC Module on page G - 1

TEMPERATURE CONTROLLED MODULE HARDWARE SETUP

Setup a Single Temperature Controlled Module

SeePycnometer Configuration on page J - 2 for setup instructions.When complete, connect
the circulating bath.

Attach a Circulating Bath

The rear panel of the temperature controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two (2) hose fittings and a four (4) foot length of tubing.

1. Power off the controlling unit.
2. Remove the plugs from the In port and theOut port.

3. Insert the provided hose fittings into each connector.
4. Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.
5. Install the tubing on the In andOut connectors.
6. Install the other end of theOut tubing to the Inlet connection of the bath circulator.
7. Install the other end of the In tubing to theOutlet connection of the bath circulator.
8. Set the temperature using the appropriate controls on the bath circulator.

CONNECT KEYBOARD

An optional USB keyboard can be connected to a USB port on the rear panel of the analysismodule.
The keyboard is not provided byMicromeritics.

Set the TEC Temperature
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J Installation Instructions

GAS CONNECTION

These instructions are for connecting inert gases only. Follow the safety procedures
used by your laboratory for connecting hazardous gases.

ReviewGas Requirements on page J - 2 prior to installing gas.

1. Attach an appropriate regulator to the gas cylinder or gas line, then tighten with a wrench.
Leave the gas bottle shutoff valve closed until instructed otherwise.

2. Attach the gas inlet line to the regulator, reducer fitting, or regulator expansion:

It is important to use the inlet tubing supplied with the analyzer. Gas linesmade of mater-
ials other than copper or stainless steel can cause operational problems aswell as inac-
curate data.

If Regulator has... Then...

1/4 in. outlet Attach the reducer fitting to the outlet of the regulator shutoff / isolation
valve
Tighten the nut finger-tight, then 1-1/4 turnswith a wrench.
Continue with the steps given for the 1/8 in. outlet
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If Regulator has... Then...

1/8 in. outlet Insert the gas tubing into the fitting.
Enure the tubing is seated fully inside the fitting.
Tighten the nut finger-tight
While holding the fitting body steady, tighten the nut with a wrench 3/4
turn.

Do not overtighten the fittings. Doing so can collapse the brass fitting and cause a leak.

3. Purge the regulator and inlet tubing to prevent contamination of the analysis gas.
a. Turn the regular shutoff valve clockwise to close.
b. Turn the pressure regulator control knob counter-clockwise to open.
c. Slowly turn the gas cylinder shutoff valve counter-clockwise to open, then quickly close it.
d. Observe the high-pressure gauge.

If the pressure decreases, tighten the nut connecting the regulator to the gas cylinder. If
the pressure is stable, proceed to the next step.

Ensure the gas supply equipment is adequately vented before performing the next step.

e. Turn the pressure regulator control knob clockwise until the low-pressure gauge indicates
19.500 psig (134.445 kPag).

f. Turn the regulator shutoff valve counter-clockwise to open.
g. Turn the gas cylinder shutoff valve counter-clockwise to open. Flow gas for 10 to 30

seconds, then close the valve.
h. Turn the gas regulator shutoff valve clockwise to close
i. Attach the other end of the copper tubing to the gas inlet on the rear panel of the pycno-
meter. Remove the inlet plug that shipped with the pycnometer.

GasConnection
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J Installation Instructions

4. Turn the nut on the tubing clockwise until it is finger-tight. Then use a 7/16 in.(1 mm) wrench to
tighten the nut an additional 1/4 turn.

5. Open the gas cylinder and regulator shutoff valves.
6. Turn the regulator control knob until the low pressure gauge indicates 21.5 psig (148 kPag).

For a High Pressure sample chamber configuration, set regulator pressure 20 psi above cycle
and fill pressure.

CONNECT THE ANALYZER TO THE COMPUTER

If using the analyzer with the keypad or keyboard only, skip this section.

An Ethernet switch is required if connecting a different type of analyzer to the same computer as the
AccuPyc. If configuringmultiple AccuPycmodules. they are connected together with only the
Control Module connected to the Ethernet switch. SeeConnect an Ethernet Switch on page J -
18.

J - 8 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



CONFIGURE THE PYCNOMETER USING THE KEYPAD

If using the keypad to control analyses, follow these instructions for configuring themod-
ule. If using theWindows application, skip this section.

Complete the installation process by configuring themodule:

l Unit Types on page J - 13
l System Setup below
l Calibrate Volume on page 10 - 13
l Setup Reports on page J - 14
l Transmit on page 2 - 7
l Communications on the next page

SYSTEM SETUP
PressAlt + 2 to access the set-up function.

Display Description
Setup. Choose or enter parameters for analysis,
calibration, reporting, and data transmission.

Choices: Analysis Parameters, Report Options,
Calibration Data, Communications, Unit Types

PressCHOICE to display the set up type, then press
ENTER.

The parameters for each set up type are stored and used
to control the pycnometer until new ones are specified.

At the completion of each set up, the display returns to theSetup type? prompt.

l PressSAVE to save the information and return to theReload prompt.
l Choose another set up type. Do not pressSAVE until all parameters have been entered. The dis-
play will return to theReload prompt.

l PressAlt + CLEAR to discard the information entered and return to theReload prompt.

Configure the Pycnometer using the Keypad
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J Installation Instructions

PRINTER SETUP
Printers are connected to the AccuPyc II via a USB port. SeeSpecifications for AccuPyc II  on
page 1 - 11 for a list of supported printers. Using the keypad:

1. On the display, selectSetup > Report Options.
2. PressENTER until thePrinter? prompt is displayed.
3. PressCHOICE until the appropriate printer driver is displayed.

COMMUNICATIONS

Use these instructions for keypad installations only. If a computer will be attached to the
module, skip this section. All setup functionswill be done in the analysis software applic-
ation.

Communications enables specification of communications criteria, such as baud rate, parity, etc.

Display Text Description

Setup Type?
Communications

PressCHOICE until Communications is displayed.

Communications
IP Address?
[choice]

Enables selection of themanner in which the IP address is assigned.
With an IP address, analysis results can be access via a web browser.
Typically, after an analysis (or calibration) is started, results from the
previous operation cannot be reviewed. However, results from five
analyses are stored in the controller. A web browser enables review of
these results. An IP addressmust exist for this operation. An IP
address can be detected and assigned automatically, or one can be
specified.

Ensure the Ethernet cable is plugged into the Ethernet port on the
analyzer and to the network. ChooseDHCP to have an IP address
assigned automatically, or Specify to specify an address. Press
CHOICE until the option is displayed.

If usingDHCP, an IP Address should be assigned within aminute.
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Display Text Description

Communications
Requesting Address *
[ENTER] to continue

Displays the first-time selection ofDHCP.

PressENTER. The system automatically attempts to assign an IP
address. If the system is able to determine an address, the assigned
address is displayed.

Communications
Requesting Address
[ESCAPE] to cancel

If an address cannot be determined, this prompt is displayed:

PressAlt + CLEAR to cancel the operation and return to theReload
prompt. Contact your IT department, or choose theSpecify option and
enter the appropriate information.

Communications
IP Address *
(user entered)

Displayswhen theSpecify option is selected. Enables entry of an
appropriate IP address. This is a numerical field in the following format:
nnn.nnn.nnn.nnn. Enter the address.

Communications
Subnet Mask *
(user entered)

Enables entry of the subnet mask number. Enter the subnet mask
number.

Communications
Gateway *
(user entered)

TheGateway address is used for communicating outside the local
network. TheGateway address is often the same as the IP address,
with a “1” after the last dot instead of the last three characters
(nnn.nnn.nnn.1). Contact your IT department with any questions.

Communications
E-mail Address:

When connected to a network, analysis or calibration results can be e-
mailed automatically upon their completion. This prompt enables entry
of the e-mail addresswhere results are to be sent.

If not usingDHCP and the e-mail address is outside the local network,
specify a gateway address (see previous prompt). A keyboard is
required to type in the e-mail address.

Configure the Pycnometer using the Keypad
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J Installation Instructions

Display Text Description

Communications
E-mail Server:

Enables entry of the numerical address of the SMTP server. If this
address is unknown, contact your IT department.

IT may need to
configure the server to
accept email from the
AccuPyc. The following
information may be
required:

l IP address for the
AccuPyc

l Sender line: Micro-
meritics-1340

IT may need to configure the server to accept e-mail from the AccuPyc.
The following informationmay be required:

l IP address for the AccuPyc
l Sender line: Micromeritics-1340

Communications
Baud Rate?

PressCHOICE to select proper baud rate.

Communications
Data Bits?

PressCHOICE to select 8 or 7.

Communications
Stop Bits?

PressCHOICE to select 1 or 2.

Communications
Parity?

PressCHOICE until the required option (None, Even, orOdd) is dis-
played.

Communications
Xon / Xoff Protocol?

Transmits data through theXon/Xoff protocol. PressCHOICE to select
Disabled or Enabled.

* Does not display for DHCP.
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UNIT TYPES
If not using the analyzer software, these keypad prompts enable selection or entry of:

l units of measurement
l operating language
l current date and time

Display Text Description

Set-up Type?
Unit Types

PressCHOICE untilUnit Types is displayed, then pressENTER.

Unit Types
Pressure units?

Enables selection of unit type for reports. Press CHOICE to select the
desired unit.

Options are:

l psig (pounds per square inch gauge)
l kPag (kilopascal gauge)

Unit Types
Language?

Enables selection of operating language. PressingSAVE is not
required.

Error messages that may be in themessage queue will remain in
English (or the current selected language). Error messages that occur
after selecting the language will display in that language.

Keypad overlays containing translations for the alternate functions are
available for each language. Choose the language.

Unit Types
Date (DD/MM/YY)?

The date is entered in a two digit format for the day, month, and year.
For example; to set the date for September 1, 2014, enter 01/09/14
(day/month/year). Use the . (decimal) key to enter a slash (/).

Unit Types
Time (HH:MM:SS)?

The time (in 24 hour format) at which an analysis begins and ends is
shown on all reports. The time shown on the displaymay not match the
current time.

The time is entered in a two digit format for the hour, minutes, and
seconds. For example; to set the time to 1:05 pm, enter 13:05:00
(hour:minutes:seconds). Use the . (decimal) key to enter a colon (:).

Configure the Pycnometer using the Keypad
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J Installation Instructions

SET DATE, TIME , AND LANGUAGE
1. On the keypad, pressAlt + 2 to enter Setupmode.
2. PressChoice untilDate displays, then pressEnter and enter the current date.
3. PressChoice until Time displays, then pressEnter and enter the current time.
4. PressChoice until Language displays, then pressEnter and select the correct language.

SETUP REPORTS
TheReport Options command enables the report mode (density or volume for analysis) and
specification of the report destination. After analysis or calibration, the display returns to theReload
prompt. An asterisk (*) in the third line of the display indicates an error message exists.

A report is generated automatically to the destination selected at theSetup > Report Options as
follows:

l Printer. Report is automatically sent to the printer.
l Transmission line. Report is automatically sent through the serial line to an attached device for
this purpose.

l E-mail. Report is e-mailed to the address specified (when connected to a network).

To view report data by points, use theReview function. SeeReview Data on page 2 - 10.

Field or Button Description

Setup Type?
Report Options

PressCHOICE untilReport Options is displayed.
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Field or Button Description

Report Options
Anls Display Mode?
Density

PressCHOICE to selectDensity, Volume or Specific Gravity, the
mode in which the analysis report will be displayed.WhenDensity is
selected, aSampleMass? prompt displays during theAnalysis
function. Enter a value for the samplemass. For accurate data, the
samplemassmust be entered when choosingDensity.

Report Options
Request Sample ID?

A sample ID (identification) is a unique identifier of the sample. Using
sample IDs can help keep track of data frommultiple analyses and
can be used as a date and time stamp. A Sample ID prompt displays
during the analysis operation, allowing entry of the identification when
after selectingYes to this prompt. PressCHOICE to selectYes or
No.

Report Options
Request Description?

Provides entry of additional descriptive information. This prompt
typically is used when a computer keyboard is attached. All system
commands can be executed on the keyboard. PressCHOICE to
selectYes orNo.

Report Options
Print Report?

Provides automatic generating of a report after an analysis or cal-
ibration. The type of printer is selected at thePrinter? prompt. Press
CHOICE to selectYes orNo.

Report Options
Transmit Report?

Provides transmission of analysis or calibration data automatically
after the operation. PressCHOICE to selectYes orNo. See Trans-
mitted Data on page I - 1.

Report Options
E-mail Report?

SelectYes at this prompt to automatically send an e-mail at the con-
clusion of an analysis or calibration operation. An e-mail address and
server must be specified in order to selectYes. PressCHOICE to
selectYes orNo.

Report Options
Printer?
[printer name]

Provides selection of the report printer. This is a system option and
does not have to be specified for each analysis (or calibration). It also
applies for all units whenmultiple analysismodules are attached.
PressCHOICE to select the appropriate printer. SeePrinter Setup
on page J - 10.

Report Options
Transmission Format?

Select the format of data to be used when transmitting reports. Press
CHOICE to select either theSingle Column format or theSpread-
sheet format. See Transmitted Data on page I - 1.

Report Options
Request Insert?

Prompts for aMultiVolume insert during analysis or calibration
operations. An insert is a device that can be placed in a sample
chamber, allowing use of a smaller sample cup for analysis of smaller
sample quantities. Inserts are available in MultiVolume Kits for the
1.0, 10, and 100 cm3 pycnometers. PressCHOICE to selectYes or
No.

If MultiVolume inserts are not used, selectNo.

Configure the Pycnometer using the Keypad
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Field or Button Description

Report Options
Request Cup
Mass?

If Yes is selected, prompts user to enter themass of the sample cup
at start of analysis.

Request CupMass? is only necessary if different size cups are used for cal-
ibration and analysis.
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CALIBRATION
SeeCalibrate Volume on page 10 - 13.

ANALYTICAL BALANCE

The analytical balance tested byMicromeritics is Scientec®model #ZSA120.

An analytical balance can be connected to a serial port on the computer and used to transfer the
sample’smass via a third-party software directly to the AccuPyc II application. Refer to the balance
manufacturer’s operator’smanual for transmission instructions.

1. Connect the analytical balance to the RS-232 port on the rear panel of the analyzer.
2. Go toOptions > Configure Balance to connect and set up an RS-232 balance to the ana-

lyzer.

Field or Button Description

Enable / Disable Select to enable or disable the attached balance.

Serial Parameter Used to set the baud rate, parity, data bits, and stop bits. This field
should not requiremodification from the default values.

Serial Port Select which serial port is used to connect the balance to the analyzer.

Configure Balance Fields and Buttons Table

Analytical Balance
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J Installation Instructions

CONNECT AN ETHERNET SWITCH

An Ethernet switch is required to connect one or more analyzers and one computer.

BRIGHTNESS CONTROL

To adjust the display brightness:

1. Insert a small flat head screwdriver into the opening.
2. Rotate the screwdriver until it engages in the slot, then turn clockwise to darken and coun-

terclockwise to lighten.
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SOFTWARE INSTALLATION
The following prerequisitesmust be completed prior to installing the software:

l Operating System.Windows 7 Professional or higher operating system is recommended for the
best user experience, however WindowsXP can be used.

l Desktop Installation Required. The application should not be installed on a network drive with
shared access. Multiple users cannot operate the application at the same time.

l 10 Base T Ethernet Port. If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet based unit is connected to the same computer, an Eth-
ernet switch will also be required.

l Read/Write Permissions. All users of the application will need Read /Write permission to all dir-
ectories and subdirectories where the application is installed.

l Drives.CD-ROMdrive and thumb drive.

1. Configure an Ethernet port on the computer to communicate with the analyzer. The IP
addressmust be 192.168.77.100. Reference the computer operator manual for instructions
on changing the IP address.

2. Insert the installationmedia into themedia drive. The program automatically starts the install-
ation. If the installation does not immediately start, navigate to themedia drive, then locate and
double click the setup.exe file.

3. On theEthernet Introductionwindow, verify that all prerequisites have beenmet.

a. If not, clickCancel and complete the steps, then restart the installation program. Do not
proceed with installation until these tasks have been completed.

b. If the prerequisites have beenmet, clickOK.

4. On theNew Installationwindow, verify that sufficient disk space is available to continue the
installation. If not, clickExitand free up theminimum required disk space. If the disk space is
OK, clickNext to accept the default installation directory, or clickBrowse to change the install-
ation location.

Software Installation
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J Installation Instructions

a. To add a shortcut to the desktop, select theAdd the application icon to the Desktop.....
checkbox.

b. To allow all computer users access to the software application , select Install this applic-
ation for All Users.all users of the computer.

c. ClickNext.

4. On theAnalyzer Configurationwindow, select 1 for the number of analyzers to be installed
and enter the analyzer serial number in the text box.

10. On theEthernet Portswindow, select one option from the following table:
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If... Then...

the configured port is listed Select the port, then clickNext.

the configured port is not listed ClickSpecify and enter the remaining portion of the
IP Address, then clickNext.

The IP Addressmust be 192.168.77.100

11. If prompted to configure a balance, select either 0 or 1. The balance should be connected to
ComPort 1. The default parameters should beOK. If not prompted for a balance, skip this
step.

Software Installation
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J Installation Instructions

12. On the Installation Complete window, clickFinish.

START THE APPLICATION

To start the application, click the application shortcut on the desktop or select the application from the
Windows program list.
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SPECIFY UNIT SELECTIONS

Options > Units
Use to specify how data should appear on the application windows and reports. Thismenu option is
not available if usingRestricted option presentation.

REINSTALL OR MODIFY THE SOFTWARE

If the computer is to be connected to a network, a second Ethernet port on the computer
must be used for that purpose.

TheSetup program is located on the installationmedia. After initial software installation, if changes
need to bemade to the analyzer setup, reinsert theSetupmedia and follow the prompts.

l Reinstall the software version [n]
l Add an analyzer
l Move an analyzer
l Remove an analyzer
l Change analyzer setup
l Reinstall calibration files for an analyzer
l Uninstall
l Reset security to default

To access theSetup program:

1. Insert theSetupmedia into themedia drive.
2. Locate and double click theSetup.EXE file.

If the IP address needs to be changed on the computer connected to the analyzer, refer
to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP addressmust be 192.168.77.100.

Specify Unit Selections

AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016 J - 23



J Installation Instructions

INSTALL ANALYZER SOFTWARE UPGRADE USING A MEDIA DEVICE

Keypad Function

To install software upgrade on the AccuPyc II module:

1. Turn theON/OFF switch on the rear panel in theOff ( O ) position.

2. Insert the USB stick containing the software update into one of the USB connectors on the
rear panel.

3. Place thePower switch in theOn ( | ) position.
4. After approximately 1-2minutes of initialization, the software starts to load. The following

prompt is displayed:

5. Once the software is successfully installed, the display will read:

6. Remove the USB stick and store in a secure location.

J - 24 AccuPyc II SeriesOperator Manual
134-42800-01 (RevC)— Apr 2016



UNINSTALL THE SOFTWARE

When the software is uninstalled, only the files required to run the application are removed.
Parameter files, sample files, reports, calibration files, and data files are not removed.

1. Insert theSetupmedia into themedia drive.
2. Select theUninstall option.
3. Follow the prompts.

Uninstall the Software
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